<table>
<thead>
<tr>
<th>TABLE OF CONTENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CHAPTER 1 INTRODUCTION</strong></td>
</tr>
<tr>
<td>1.1 ABOUT THIS MANUAL</td>
</tr>
<tr>
<td>1.2 TYPOGRAPHIC CONVENTIONS</td>
</tr>
<tr>
<td>1.3 QUICK START</td>
</tr>
<tr>
<td>1.4 GETTING HELP</td>
</tr>
<tr>
<td>1.5 SYSTEM OVERVIEW</td>
</tr>
<tr>
<td>Features of the SymphoniePRO Data Logger System</td>
</tr>
<tr>
<td>1.6 PRECAUTIONS</td>
</tr>
<tr>
<td>Grounding and ESD</td>
</tr>
<tr>
<td>Environmental Considerations</td>
</tr>
<tr>
<td><strong>CHAPTER 2 SYSTEM OVERVIEW</strong></td>
</tr>
<tr>
<td>2.1 HARDWARE OVERVIEW</td>
</tr>
<tr>
<td>2.1.1 Unpacking Your SymphoniePRO</td>
</tr>
<tr>
<td>2.1.2 Components Map</td>
</tr>
<tr>
<td>2.1.3 Channels</td>
</tr>
<tr>
<td>2.1.4 Grounding</td>
</tr>
<tr>
<td>2.1.5 Installing D-Cell Batteries</td>
</tr>
<tr>
<td>2.1.6 Installing P-SCMs</td>
</tr>
<tr>
<td>2.1.7 iPack</td>
</tr>
<tr>
<td>2.1.8 Related Hardware Accessories</td>
</tr>
<tr>
<td>2.2 SYMPHONIEPRO DESKTOP APPLICATION OVERVIEW</td>
</tr>
<tr>
<td>2.2.1 SymphoniePRO Desktop Application</td>
</tr>
<tr>
<td>2.2.2 Network Considerations</td>
</tr>
<tr>
<td><strong>CHAPTER 3 PRE-INSTALLATION PREPARATION</strong></td>
</tr>
<tr>
<td>3.1 CONFIGURING THE LOGGER</td>
</tr>
<tr>
<td>3.1.1 Memory</td>
</tr>
<tr>
<td>3.1.2 Data Retrieval</td>
</tr>
<tr>
<td>3.1.3 Site</td>
</tr>
<tr>
<td>3.1.4 Location</td>
</tr>
<tr>
<td>3.1.5 Configuration</td>
</tr>
<tr>
<td>3.1.6 Security</td>
</tr>
<tr>
<td>3.2 CONFIGURING LOGGER CHANNELS</td>
</tr>
<tr>
<td>3.2.1 Live Data</td>
</tr>
<tr>
<td>3.2.2 Wiring Panel, Data Logging Mode and Channel Type</td>
</tr>
<tr>
<td>3.2.3 Sensor Description</td>
</tr>
<tr>
<td>3.2.4 Signal Type or Excitation</td>
</tr>
<tr>
<td>3.3 SCHEDULES</td>
</tr>
<tr>
<td>3.3.1 MetLink Logger Initiated Schedule</td>
</tr>
<tr>
<td>3.3.2 MetLink Logger Listening Schedule</td>
</tr>
<tr>
<td>3.3.3 Time Service</td>
</tr>
<tr>
<td>3.3.4 Email Schedule</td>
</tr>
<tr>
<td>3.4 IPACK</td>
</tr>
<tr>
<td>3.4.1 Modem Status (iPackGPS only)</td>
</tr>
</tbody>
</table>
5.1.5 Options Menu.................................................................................................................. 92
5.1.6 Help .................................................................................................................................. 93
5.1.7 Site ....................................................................................................................................... 95
5.1.8 Logger .................................................................................................................................. 97
5.2 SITE UTILITIES ......................................................................................................................... 99
5.2.1 Data Export .......................................................................................................................... 100
5.2.2 Site ....................................................................................................................................... 100
5.2.3 Data Import .......................................................................................................................... 100
5.2.4 Location ............................................................................................................................... 100
5.2.5 Data Encryption Password .................................................................................................. 101
5.3 AUTOMATION ......................................................................................................................... 101
5.4 TIMELINE ............................................................................................................................... 102

5.5 REPORTS .................................................................................................................................. 105

5.6 LOGGER ..................................................................................................................................... 107

5.7 CHANNELS ............................................................................................................................... 109

5.8 SCHEDULES ............................................................................................................................... 110

5.9 IPACK ...................................................................................................................................... 110

5.10 QUICKVIEW ........................................................................................................................... 110

5.10.1 File .................................................................................................................................... 111
5.10.2 View ................................................................................................................................... 112
5.10.3 Help .................................................................................................................................... 114

APPENDIX A | GLOSSARY .............................................................................................................. 115

APPENDIX B | TROUBLESHOOTING GUIDE ................................................................................. 120

LOGS ............................................................................................................................................ 120
EXPORTS .................................................................................................................................... 121
EVENT AND ERROR CODES ........................................................................................................ 124

APPENDIX C | COMMUNICATIONS OPTIONS ........................................................................... 130

C.1 SYMPHONIE IPACK OPTIONS ............................................................................................. 130
C.2 CONFIGURING SYMPHONIEPRO - METLINK LOGGER INITIATED ................................... 132
C.3 CONFIGURING SYMPHONIEPRO FOR METLINK LOGGER LISTENING ......................... 135
C.4 LOGGER INITIATED EMAIL CONNECTIONS ..................................................................... 138

APPENDIX D | INSTALLING A SIM CARD IN IPACKGPS ............................................................... 140

IPACKGPS GSM ........................................................................................................................... 140

APPENDIX E | USING THE BGAN M2M SATELLITE TERMINAL WITH SYMPHONIEPRO ................. 143

INTRODUCTION .......................................................................................................................... 143

APPENDIX F | USING IPACKACCESS WITH MODBUS PROTOCOL ........................................... 154

THEORY OF OPERATION ............................................................................................................. 154
Modbus Data Flow Diagram ....................................................................................................... 155
Examples of Network Configurations ......................................................................................... 156
Networking Considerations ....................................................................................................... 159
**APPENDIX G | GROUNDING & LIGHTNING PROTECTION** ................................................................. 166

**APPENDIX H | POWER BUDGET** ......................................................................................... 169

**APPENDIX I | WARRANTY** ............................................................................................... 171

**APPENDIX J | TECHNICAL SPECIFICATIONS** ................................................................. 173

**APPENDIX K | REFERENCES** ......................................................................................... 181

**APPENDIX L | DECLARATION OF CONFORMITY** ............................................................. 183

**APPENDIX M | SYMPHONIEPRO TEXT FILE FORMATS** ................................................. 184

**APPENDIX N | SYMPHONIEPRO DESKTOP SCRIPTING AND** ....................................... 201

**APPENDIX O | SYMPHONIEPRO DESKTOP UTILITIES** ................................................... 205

**APPENDIX P | NRG EXPORT CONFIGURATION (NEC)** .................................................. 210

**INDEX** ......................................................................................................................... 213

---

Connect to Network ................................................................................................................. 159
Verifying Network Connection ............................................................................................... 159
NRG Modbus Demo Client ..................................................................................................... 160
Checking iPack status ............................................................................................................ 161
Modbus Protocol ..................................................................................................................... 161
Input Register Data and Addressing ....................................................................................... 162
Modbus Registers .................................................................................................................. 162

**APPENDIX G | GROUNDING & LIGHTNING PROTECTION** ................................................................. 166

**APPENDIX H | POWER BUDGET** ......................................................................................... 169

**APPENDIX I | WARRANTY** ............................................................................................... 171

**APPENDIX J | TECHNICAL SPECIFICATIONS** ................................................................. 173

**APPENDIX K | REFERENCES** ......................................................................................... 181

**APPENDIX L | DECLARATION OF CONFORMITY** ............................................................. 183

**APPENDIX M | SYMPHONIEPRO TEXT FILE FORMATS** ................................................. 184

**APPENDIX N | SYMPHONIEPRO DESKTOP SCRIPTING AND** ....................................... 201

**APPENDIX O | SYMPHONIEPRO DESKTOP UTILITIES** ................................................... 205

**APPENDIX P | NRG EXPORT CONFIGURATION (NEC)** .................................................. 210

**INDEX** ......................................................................................................................... 213

---

NRG Modbus Demo Client ..................................................................................................... 160
Checking iPack status ............................................................................................................ 161
CHAPTER 1  INTRODUCTION

1.1 About This Manual
Welcome to the SymphoniePRO® User’s Manual! This manual is organized to provide a system overview followed by more detailed configuration and installation instructions. Users already familiar with previous generation Symphonie loggers and iPacks will notice similar menus and terminology in the SymphoniePRO system. Throughout this manual, the term “iPack” refers to either iPackGPS or iPackACCESS. We recommend reading the whole manual to take advantage of all of the features and get the most out of your SymphoniePRO system.

1.2 Typographic Conventions
This type style is used for the general body of this manual.

Instructions in **Bold Type** refer to software commands and require you to perform an operation on screen, such as select the **Sites** tab, or press the **Download** button.

Instructions in [Brackets] refer to the logger keypad functions. For example, pressing the [HOME] key will always return the display to the main menu.

This style is used to show actual prompts and messages that appear on the SymphoniePRO logger display.

**Caution**

*This style is used to warn users of a potential danger, either to themselves or to the equipment or data.*

**Note** - *This style is used to indicate a tip or an important note, such as a significant difference from Symphonie/PLUS/PLUS3 systems.*

This symbol is used to represent tool tips in the SymphoniePRO Desktop Application. Putting your cursor over the symbol will reveal additional information relevant to a term or feature.

1.3 Quick Start
The basic steps necessary to start receiving data from your SymphoniePRO system are as follows:

1. Update iPackGPS firmware to SymphoniePRO compatible version if necessary (see Appendix C).
2. Establish wireless service for the iPack (Appendix D for iPackGPS or Appendix E for BGAN M2M Satellite).
3. Install SymphoniePRO Desktop Application software on PC (section 2.2.1).
4. Configure network firewall to allow for remote connections: logger to PC, and PC to logger (Appendix C for configuration options).
5. Configure logger and iPack and set up site information and communication schedule using SymphoniePRO Desktop Application software and USB cable; save a copy of the Instrument Configuration File (*.LGR) (sections 3.1, 3.2, 3.3, and 3.4).
6. Get familiar with navigation of logger and iPack using the logger’s keypad and display (section 3.5).
7. Perform communication tests such as successfully transmitting a data file via email, making a direct connection, remotely changing the logger configuration, etc. (section 3.6).
8. Install hanging bracket on the back of the iPack or logger (section 4.3.1).
9. Install the shelter box and PV panel on the tower (sections 4.3.2 and 4.4).
10. Connect earth grounding and mount the wiring panel in the shelter box (section 4.5).
11. Connect sensors to the wiring panel (section 4.5.2).
12. Mount the logger and iPack in the shelter box, and connect the wiring panel (sections 4.5.3 and 4.5.4).
13. Scroll through all channels on logger’s display (or review using connected laptop running SymphoniePRO Desktop Application) to verify correct sensor connection and configuration (sections 4.6 and 4.7).
14. Perform test call or connection and confirm receipt of data file (section 4.7).
15. Use SymphoniePRO Desktop Application to download and import a raw (*.RLD) file.
16. Double-click on a few *.RLD files and use QuickView to review data.

1.4 Getting Help
NRG Systems offers a variety of support options to help you get the most from your NRG product. If you have questions about your NRG product, first look in the product documentation or the Knowledge Base or Technical Forum in the Technical Services section of the NRG Systems website (www.nrgsystems.com/technical-support). If you cannot find the answer, contact your salesperson or NRG Systems Technical Support for assistance using the information below. Customer support is available 8:30 AM to 5:00 PM ET, Monday through Friday.

Telephone: +1 802-482-2255 ext. 3
Fax: +1 802-482-2272
Email: support@nrgsystems.com

When you call or email, please have the appropriate product documentation at hand and be prepared to give the following information:

- Customer name
- Who purchased equipment
- Item number or description
- Serial numbers of loggers and iPack equipment
- When equipment was purchased
- Where equipment is installed - terrain conditions
- Description of the problem with some detail
- What events took place leading up to the problem
- What you have tried while attempting to solve the problem

SymphoniePRO and the SymphoniePRO Desktop Application produce several types of diagnostic data related to the equipment operation and the software (see Appendix B: Troubleshooting for details). You may be asked to provide data files or logs to help us investigate an issue. All information and data provided are kept strictly confidential.
NRG Systems maintains an extensive website which includes an in-depth customer support area. If you need assistance at times other than our regular business hours, we suggest visiting our website, www.nrgsystems.com.

All instruments, sensors, software and towers manufactured by NRG Systems are designed to be reliable and easy to use. We welcome your comments and appreciate your help in making our products the best available.

1.5 System Overview

The NRG SymphoniePRO Data Logger is an advanced, internet-ready, low-power, microprocessor-controlled data logging system specifically designed for conducting resource assessments for the renewable energy industry. Each of the 16 or 26 standard channels’ averages, standard deviations, and other statistical values are calculated from continuous 1 second data samples.

The SymphoniePRO logger has selectable statistical averaging intervals (1, 2, 5, 10, 15, 30, 60 minutes). One second samples can be recorded by the logger allowing review of the sample-by-sample data for complex scientific studies. Data intervals are time-stamped with the beginning time of each interval and are written to the internal Flash memory. If an SD card is installed, the data will also be stored on the SD card.

Addition of an iPack allows flexible options for data transfer through remote MetLink connections or standard email services. MetLink is a proprietary protocol optimized for NRG loggers and transfers data over multiple types of communication interfaces. MetLink allows connections to be initiated from either direction (from the logger or from SymphoniePRO Desktop Application), and the MetLink Monitor utility can be used to view the status of active connections.

Various communications options are available to fit your application and location anywhere in the world. Cellular iPackGPS units can be easily connected to the back of the SymphoniePRO logger to enable remote communications via a cellular network. iPackACCESS can be used in conjunction with a BGAN M2M Satellite module for satellite communications capability where cellular service is either unavailable or unreliable. iPackACCESS can also be used to connect the SymphoniePRO logger directly to a SCADA system or local area network (LAN), where real-time (i.e., 1 Hz) data can be polled via Modbus TCP.
The SymphoniePRO Desktop Application is used to process raw data files as well as configure and communicate with the SymphoniePRO logger and iPack. On-site configuration requires a laptop and USB adapter cable, while remote communication requires internet service.

Sensor scale factors and offsets configured in the SymphoniePRO logger can be edited with the SymphoniePRO Desktop Application after data has been collected. Raw data is stored in the Site database file and can be exported to a tab-delimited text file (ASCII). The potential to edit scale factors and offsets in the Timeline view at any time provides the opportunity to change how raw files will be processed before generating ASCII data files.

**Features of the SymphoniePRO Data Logger System**

The SymphoniePRO logger is a 26-channel or 16-channel data logger optimized for renewable energy resource assessment. SymphoniePRO and its accompanying iPack are designed to be easy to install and reliable in any climate.

**Data**

- The SymphoniePRO Data Logger complies with industry standards such as IEC61400-12-1 with features for wind or solar energy assessment built in. SymphoniePRO requires no complex programming for data collection.
- Statistical data stored include Average, Standard Deviation, Maximum and Minimum values for each channel, Maximum 3-second Gust, and Direction of Maximum Gust. Note that available statistics depend on measurement type (e.g., min and max do not apply to direction, temperature, or barometric pressure channels).
- 1 Hz sample data can also be stored on a channel-by-channel basis.
- Wide range of signal conditioning options to support all commonly used sensors
• Internal Flash memory stores up to 175 days of statistical data (no SD card installed). A 512 MB SD card (sold separately) provides 10+ years of statistical data storage. A 2 GB SD card is available and should be used if also storing 1 Hz sample data.
• High-resolution analog-to-digital conversion
• Convenient access to complete sensor history information in the Timeline screen
• SymphoniePRO Desktop Application is included. The software is used to configure loggers and iPacks, keep track of site data, and produce versatile tab-delimited text files (ASCII) compatible with leading industry software. Additionally, the software allows the user to view real-time data and apply firmware updates to loggers and iPacks. International numeric formats are supported.
• Integrated Bing map and Google Earth
• POPAuto software utility included with SymphoniePRO Desktop Application to automate extraction of emailed data

Communications
• iPacGPS kits for cellular (2G GSM, 3G GSM, CDMA, DoCoMo) communications provide remote data collection via e-mail and/or MetLink (TCP/IP).
• iPacACCESS kits for Ethernet and BGAN M2M satellite communications provide remote data collection via Modbus as well as e-mail and/or MetLink.
• Loggers with any Symphonie iPack kit allow remote changes to sensor configuration and communication parameters via MetLink.
• SymphoniePRO Desktop Application allows pre-installation programming of iPacGPS or iPacACCESS and SymphoniePRO loggers through USB. The configuration file contains all the parameters for both the iPack and the logger.
• Communication and antenna signal test features allow on-site testing of iPack.
• Firmware for the iPack (and SymphoniePRO logger) can be upgraded remotely or on site using SymphoniePRO Desktop Application.
• Integrated Global Positioning System (GPS) in iPacGPS and iPacACCESS

Channels
• 12 counter channels available for measuring wind speed or other pulsed frequency signals such as rain gauges or other totalizer type sensors.
• All counter inputs are universal and can accommodate NRG Class 1, NRG 40C, WindSensor P2546A-OPR /P2546C-OPR, Thies First Class Advanced or other pulse output anemometers and do not require P-SCMs. Channels 8 and 9 optimized for high frequency sine wave signals.
• Provides 14 analog channels used for measuring wind direction or a range of other parameters including temperature, barometric pressure, relative humidity and solar energy (7 channels are configurable with P-SCM cards, while 7 channels are reserved for use with vanes, temperature probes, NRG BP20 & NRG RH sensors).
• Differential inputs available on P-SCM analog channels
**Power**

- Symphonie iPacks provide remote, autonomous power to the data logger system via either one or two 12 V, 2200 mAh batteries, which are continuously recharged via PV in the field and can be recharged after office testing using a convenient wall charger (available from NRG).
- SymphoniePRO should always be used with an iPack to provide long-term, autonomous operation (D-cells are for backup only).
- The iPack has additional input terminals for connecting a large external 12 V battery in case you intend to use sensors with higher power requirements or keep the modem online for extended periods of time.
- Two D-Cell batteries provide emergency backup for maintaining the logger’s core logging functions and are also convenient for office testing when an iPack is not available.
- Logger contains dedicated lithium battery which provides backup power to keep real-time clock running in the event all other power sources go dead. This provides accurate and reliable timestamping when the logger is powered up.

**Physical**

- Wiring panel has large, easy-to-wire connection points.
- Convenient “plug and play” SymphoniePRO Signal Conditioning Modules (P-SCMs) are pre-configured for additional sensors.
- SymphoniePRO uses industrial grade, non-volatile Secure Digital (SD) Cards for data storage.
- The 4 line x 20 character display is easy to read and provides easy to understand real-time data and configuration information.
- Dedicated navigation buttons (up, down, left, right, home) plus a data entry keypad make the full-text, menu driven display easy to use.
- Wiring panel provides electro-static discharge (ESD) protection for each input channel. Tested to IEC 61000-4-5 for surge immunity.

### 1.6 Precautions

**Grounding and ESD**

Failure to ground the logger puts the logger and sensors at risk for electrostatic damage (ESD). Refer to [Appendix G](#) for details regarding proper earth grounding and lightning protection.

**Caution**

*The copper clad ground rod provides an electrical path for static electricity that builds up on the sensors to dissipate to ground. Failure to use proper grounding protection can damage the equipment and will void the warranty.*

**Environmental Considerations**
Sensor cables become less flexible and are more easily damaged at very low temperatures. Make sure that all cables are securely fastened to the tower so they do not flap in the wind. If your site is at high latitude and your logger has many sensors connected, consider using an external power supply.

If the equipment will be exposed to high salinity, use protective grease or other dielectric agent on terminals and ground connections.
CHAPTER 2  SYSTEM OVERVIEW

This section of the manual is designed to provide you with the basic information needed to prepare and install your SymphoniePRO system successfully. Chapter 3, Field Installation, provides detailed descriptions of each installation step and wiring instructions.

2.1 Hardware Overview

While SymphoniePRO is easy to set up, it is a good idea to get familiar with the system before going to the installation site. The following sections describe the things you should do prior to installation.

2.1.1 Unpacking Your SymphoniePRO

Confirm that you have received all components by comparing your order to the packing list included with your shipment. Immediately contact NRG Systems if any of the components are missing.

Caution

Do not remove the SymphoniePRO logger's brown desiccant pack from the clear plastic package at this time. During the field installation procedure, you will remove the clear wrapper and place the desiccant pack inside the SymphoniePRO’s logger enclosure to keep it dry.

2.1.2 Components Map
Keypad
The alphanumeric keys are used to enter the Logger Access PIN to gain access to the logger’s display and to access logger menus. SymphoniePRO offers simplified programming through a USB connection to SymphoniePRO Desktop Application software.

Navigation Keys
The navigation keys are used to move up and down lists, and to page forward and backward through items displayed on the logger’s screen. Note that list items are also numbered and can also be selected by pressing the keypad number of the item.

Display
SymphoniePRO has a 20 character, 4 line display designed for reliable operation in extreme cold conditions. Display contrast can be adjusted for optimal viewing under different lighting conditions.

D-Cell Batteries
The logger’s basic functions run on standard D-cell batteries which are protected by a battery cover. Batteries should be changed one at a time so that logging operations are not disrupted during the battery change. With an iPack installed, the D-cell batteries primarily function as backup batteries for all logging functions in the event that the iPack is removed or loses power.

Caution
An iPack should be used even in the case where communications are not required. The “Power Only” iPack is recommended for this application. It is recommended that high quality alkaline batteries are used such as Energizer or Duracell, and they should be changed at least once per year to avoid leakage and equipment damage.

Wiring Panel Connector
The 62 pin connector should be securely screwed down using the thumb screws. Protect the pins by aligning the connector well before inserting, and avoid plugging in the connector at an angle.

USB Port
The USB port is the primary programming access port used for configuration of the logger and iPack settings.

USB Cable
The SymphoniePRO system uses a standard USB Type B to USB Type A connection (standard laptop USB connection). *Cable sold separately.*

Clock Battery
A lithium battery powers the logger clock even if D-cell batteries are not present. This allows the logger to retain date and time in the event of a reboot. Clock batteries will last 5+ years under normal use.

Clock Battery Warning LED
This LED illuminates if the clock battery has been installed backwards.
**Reset Button**

- A reset button is located between the clock battery and the first P-SCM slot on the main circuit board (partly hidden under the D-cell battery case).
- Should it become necessary to reset the SymphoniePRO logger, carefully place the NRG screwdriver (provided) or other long, thin tool in the upper corner just to the left of the “Channel 20” P-SCM slot, and slide down to press the button. Hold until it beeps.
- When the reset button is pushed, the logger will beep and reset the logger’s microprocessor, record a reset event, and resume sampling data for the current file.
- Resetting the logger may cause the data from the current statistical interval to be lost (depending on how long since data was last written to memory). The logger logs a reset event into the event log and continues adding data to the same file that was in progress before the reset.
- Collected data already written to memory and all logger configuration settings will be retained.

Note that a reset can also be initiated by the built-in watchdog in response to an ESD (electrostatic discharge) event. When an iPack is connected to a logger with no D-cells, this will also initiate a reset. The iPack provides auxiliary power to the logger and therefore powers it up in the absence of D-cells.

**SD Card Slot**

The SD card is inserted vertically in the SD card slot with the beveled front corner down. Care should be taken when inserting and removing the SD card – do not force the SD into the slot. Qualified, industrial-rated SD cards (512 MB or 2 GB) are available from NRG Systems.

**Caution**

*Problems with SD cards not supplied by NRG Systems are not covered by warranty.*

**Wiring Panel Options (16-Channel & 26-Channel)**

SymphoniePRO supports two different wiring panels: A 16-channel version and a 26-channel version. The table below shows which logger channels are available for each wiring panel, and the SymphoniePRO software has a drop-down selector for choosing a wiring panel which makes configuration easy.

<table>
<thead>
<tr>
<th>Logger Channel</th>
<th>Channel Type</th>
<th>SymphoniePRO</th>
<th>26-Channel Wiring Panel</th>
<th>SymphoniePRO</th>
<th>16-Channel Wiring Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>2</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>3</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>4</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>5</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>6</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td>✓</td>
</tr>
<tr>
<td>Logger Channel</td>
<td>Channel Type</td>
<td>SymphoniePRO</td>
<td>SymphoniePRO</td>
<td></td>
<td></td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------</td>
<td>--------------</td>
<td>--------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>26-Channel</td>
<td>16-Channel</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Counter</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Counter</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Counter</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Counter</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Counter</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Analog 2.5V or 5V EXC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>Analog 2.5V or 5V EXC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15</td>
<td>Analog 2.5V or 5V EXC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16</td>
<td>Analog 5V or 12V EXC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17</td>
<td>Analog 5V or 12V EXC</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18</td>
<td>Analog 5V or 12V EXC</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>19</td>
<td>Analog 5V or 12V EXC</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>21</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>✓</td>
<td></td>
<td></td>
</tr>
<tr>
<td>23</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>24</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>25</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>26</td>
<td>Analog P-SCM</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM-A</td>
<td>RS-485</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
<tr>
<td>COM-B</td>
<td>RS-485</td>
<td>✓</td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**SymphoniePRO | 16-Channel Wiring Panel**

The 16-Channel Wiring Panel (item 11178) connects directly to the right side of the logger in the same way previous versions of Symphonie loggers did.

*Note - SymphoniePRO loggers produced prior to June of 2017, are not compatible with the 16-Channel Wiring Panel. Please check your logger serial number and manufacture date prior to ordering a 16-Channel Wiring Panel.*

**Caution**

*Wiring Panels for Symphonie, SymphoniePLUS, and SymphoniePLUS3 loggers are NOT compatible with the SymphoniePRO logger - do not connect these older generation wiring panels to a SymphoniePRO logger!*

**SymphoniePRO | 26-Channel Wiring Panel**

The 26-Channel Wiring Panel (item 8150) connects to the logger using an NRG cable assembly (item 8385). Installing the 26-Channel Wiring Panel in the shelter box prior to installing the SymphoniePRO logger and iPack may make it easier to wire the sensors.
**Hanging Bracket**

The hanging bracket connects to the back of the iPack and allows the assembled logger and iPack to easily be installed in or removed from the shelter box using the keyed slots. The hanging bracket is included with the shelter box.

**iPack Connector**

On the back of the SymphoniePRO logger you'll find the 25-pin (male) connector for the iPack, which comes with a sticker over it to keep dust and moisture out until it's mated with the iPack. When ready to install the iPack to the logger, remove the protective water resistant sticker from the back of the logger.

**2.1.3 Channels**

SymphoniePRO has (12) counters channels, (7) built-in analog channels, (7) P-SCM analog channels, and (2) RS-485 (full or half duplex) channels. Each channel will configure itself based on pull-down list selections made in the software.

**Counter Channels 1 - 12**

The twelve built-in counter channels are compatible with industry standard anemometers and tipping rain buckets. A 12 V excitation is available for each channel. Signal type can be pulse or coil, and an internal pull-up resistor can be turned on for reed switch signals. Channels 8 and 9 can be configured to accept high frequency sine wave signals.

**Analog 2.5 V or 5 V Excitation Channels 13 - 15**

Channels 13 through 15 accept input signals from 0 to 5 V and are ideal for wind direction vanes and NRG temperature probes. A user-selectable excitation voltage of 2.5 V or 5 V is available per channel. 2.5 V is a reference voltage intended for use with potentiometer type wind vanes like the NRG 200P.

**Analog 5 V or 12 V Excitation Channels 16 - 19**

Channels 16 through 19 accept input signals from 0 to 5 V and are intended for use with NRG barometric pressure, relative humidity, and temperature sensors. Each channel has a user-selectable excitation voltage of 5 V or 12 V.

**Analog (P-SCM) Channels 20 - 26**

Channels 20 through 26 accept SymphoniePRO Signal Conditioning Modules (P-SCMs) for adding analog sensors such as high quality pyranometers and other meteorological sensors. Please check the P-SCM list below for sensor compatibility. Signal (+) and Signal (−) are available for differential inputs on each of the seven channels.
**SymphoniePRO P-SCMs**

The following table contains a list of available SymphoniePRO P-SCMs organized by the categories of sensor signal range and excitation requirements. If you have an application not covered by these options, please let us know as we can develop new SymphoniePRO P-SCMs if needed.

<table>
<thead>
<tr>
<th>Item number</th>
<th>SymphoniePRO P-SCM Name</th>
<th>Input Signal Type</th>
<th>Excitation Output To Sensor</th>
<th>Sensor Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>9128</td>
<td>P-SCM #9128 -6 to 58mV Input No EXC</td>
<td>Bipolar Differential Voltage</td>
<td>None</td>
<td>Hukseflux LP02, SR11, SR12, SR20, DR02-FR; Kipp and Zonen CMP3, CMP6, CMP10, CMP11, Campbell NR-Lite2</td>
</tr>
<tr>
<td>9129</td>
<td>P-SCM #9129 0 to 160µA Input No EXC</td>
<td>Current</td>
<td>None</td>
<td>Li-Cor 200SZ</td>
</tr>
<tr>
<td>9130</td>
<td>P-SCM #9130 0 to 5V Input Pulsed 5V EXC</td>
<td>Single Ended Voltage</td>
<td>5 V Pulsed</td>
<td>NRG 110S</td>
</tr>
<tr>
<td>9131</td>
<td>P-SCM #9131 0 to 5V Input Pulsed 12V EXC</td>
<td>Single Ended Voltage</td>
<td>12 V Pulsed</td>
<td>NRG BP20</td>
</tr>
<tr>
<td>9132</td>
<td>P-SCM #9132 0 to 5V Input Constant 12V EXC</td>
<td>Single Ended Voltage</td>
<td>12 V Constant</td>
<td>NRG RH5X, SPN1 GHI, SPN1 DIF</td>
</tr>
<tr>
<td>9133</td>
<td>P-SCM #9133 0 to 5V Input Pulsed 2.5V EXC</td>
<td>Single Ended Voltage</td>
<td>2.5 V Pulsed</td>
<td>NRG 200P, Vector W200P, Thies 10k, Thies 2k</td>
</tr>
<tr>
<td>9134</td>
<td>P-SCM #9134 -2.5 to 2.5V Input No EXC</td>
<td>Bipolar Voltage</td>
<td>None</td>
<td>RMY Vertical Propeller Anemometer</td>
</tr>
<tr>
<td>9135</td>
<td>P-SCM #9135 0 to 30V Input Constant 12V EXC</td>
<td>Single Ended Voltage</td>
<td>12 V Constant</td>
<td>battery bank monitoring</td>
</tr>
</tbody>
</table>
2.1.4 Grounding

Whenever coming in contact with the SymphoniePRO logger, either in the field or indoors, it is recommended to first grasp a piece of grounded (earthed) metal before touching the logger to avoid a potentially damaging electrostatic discharge (ESD) to the logger.

2.1.5 Installing D-Cell Batteries

- Open the logger enclosure and remove the battery cover by loosening the three thumbscrews. *Tip*: Write the installation date of the D-Cell on each battery.

- Insert two fresh D-cell batteries, one at a time, into the battery holders with the positive terminals of the batteries (the end with the bump) oriented towards the sides of the enclosure. When the batteries are first inserted, the display will read:

  ```
  renewableNRGsystems
  SymphoniePRO Logger
  Site: 000000
  ```
- Install any P-SCMs you will need according to the instructions in section 2.1.6.
- Replace the battery cover and tighten the three thumbscrews.
- As a power saving function, the display will always shut off after three minutes without any key inputs.
- The logger continues to collect data while the display is off.

2.1.6 Installing P-SCMs

If your site configuration requires more connections than those provided by the built-in channels, or if you’re using pyranometers, it will be necessary to install appropriate SymphoniePRO Signal Conditioning Modules (P-SCMs) for each additional sensor in one of the seven configurable Analog P-SCM channels (Channels 20 through 26). Each P-SCM provides the necessary signal conditioning (filtering, gain, buffering, and protection) electronics for the specific sensor type to be connected to the channel. The correct P-SCM then needs to be selected from the drop-down list for that channel in SymphoniePRO Desktop Application’s Channels screen.

Caution

Older SCMs used with Symphonie, SymphoniePLUS, and SymphoniePLUS®3 loggers are NOT compatible with SymphoniePRO, nor are SymphoniePRO P-SCMs compatible with Symphonie, SymphoniePLUS, or SymphoniePLUS3 loggers.

Note - Before inserting a P-SCM in the appropriate slot, be sure to grasp the grounding post on the wiring panel to prevent a potentially harmful electrostatic discharge. The P-SCM has a metal strip on the top edge to facilitate grounding while being handled.

- In order to install a P-SCM, it is necessary to remove the battery cover by loosening the three thumbscrews.
- Touch the grounding post on the wiring panel just before inserting the P-SCM.
- Install the P-SCM into the appropriate slot with the pins facing downward and the circuit components facing to the right.
- Do not force the P-SCM.
- Once the P-SCMs have been installed, the channels can be configured using SymphoniePRO Desktop Application software.
- Allow 4 seconds between inserting and removing P-SCMs as they take a few seconds to be recognized by the logger.

2.1.7 iPack

SymphoniePRO data loggers require an iPack to be attached to the back of the logger to allow it to operate autonomously in the field. The iPack provides 12 V DC excitation voltage to the logger and connected sensors. It is also a communications module used to establish remote MetLink connections and to email data files.
**Battery & PV Panel**

iPacks contain a 12 V DC rechargeable battery system that allows the logger and iPack to run autonomously. iPacks are sold with a PV panel for battery charging. The PV panel is wired into the iPack’s “PV” terminal on the side of the iPack and the PV panel is installed on the southern face of the tower.

The PV input on the side of the iPack can handle between 15 to 28 V DC.

The second input on the side of the iPack (labeled “12 V Ext. Bat”) can be used to connect an external battery system to the iPack. Note that this terminal does not charge the internal iPack battery and can only handle 14 V DC max. Apply higher voltage batteries or PV panels to this terminal may result in damage to the iPack. It is recommended to use a voltage controller when connecting external batteries to the iPack.

**GPS**

All iPacks (and the iPackACCESS) have an internal GPS module and an external terminal for a GPS antenna to be attached.

The GPS is enabled if it has been more than one day since it last successfully acquired lock with satellites. If the communication schedule is set to an interval of longer than one day, the GPS will be activated according to that schedule.

If the current location reported by the GPS is more than 200 meters from the last stored position, the logger updates the location information and creates an entry in the event log. The GPS is also used to sync the logger clock, if it is selected as a Time Service in the logger configuration.

**iPack Types**

The following iPacks models can be used with the SymphoniePRO data logger:

- **iPackGPS GSM/GPRS**
  This iPacks unit allows the sending of data files and MetLink connections through 2G/GPRS service. The modem inside the iPack operates on the 850/900/1800/1900 MHz GSM bands.

- **iPackGPS 3G**
  This iPacks unit allows the sending of data files and MetLink connections through HSPA+ and 2G/GPRS service. The modem inside the iPack operates on HSPA+ 850/900/1700/1900/2100 MHz and 2G/GPRS 850/900/1800/1900 MHz bands.

- **iPackGPS CDMA**
  This iPacks unit allows the sending of data files and MetLink connections through Verizon’s CDMA network within the United States.

- **iPackACCESS**
  This iPacks unit allows the SymphoniePRO data logger to be connected to a SCADA network and make real time data available via Modbus TCP. It does not have an internal modem but has an Ethernet port for a LAN connection. The Modbus registers are pre-defined allowing the device to be easily configured. See Appendix F for details on configuring the iPackACCESS.
iPackACCESS + BGAN M2M Satellite
Connecting a BGAN M2M Satellite modem to an iPackACCESS allows the SymphoniePRO data logger to send data from anywhere in the world using the Inmarsat Seattleite Network. See Appendix E for details on configuring the iPackACCESS and BGAN M2M modem.

iPack Power Only
This iPack provides a “standalone” power solution to SymphoniePRO data loggers that don’t need any communications. It contains the same 12 V rechargeable gel cell battery pack and a PV charging circuit as the other iPacks but does not include a modem or any communication ports.

2.18 Related Hardware Accessories
A USB Type B to USB Type A (standard laptop USB connection) cable is used to configure the logger and iPack with SymphoniePRO Desktop Application software; router and other network infrastructure may be required to support some communication protocols.

2.2 SymphoniePRO Desktop Application Overview

2.2.1 SymphoniePRO Desktop Application
SymphoniePRO Desktop Application is used to configure the SymphoniePRO logger and iPack, communicate remotely and upgrade instrument firmware in the field, view live data, process and store incoming data, export data, and provide data summary reports.

SymphoniePRO Desktop Application is a 32-bit application that runs on Windows 7, Windows 8, or Windows 10 operating systems. The installer typically installs all files needed to run the software. In some Windows 8 and Windows 10 installations, the target machine may need a Windows Update, so be sure that your network policies allow for some external components to be installed by the desktop installer. Other operating systems are not supported. The minimum computer hardware requirements are:

- 1.6 gigahertz (GHz) or faster 32-bit (x86) or 64-bit (x64) processor
- 2 gigabyte (GB) RAM minimum required
- 4 GB RAM recommended

The latest version of SymphoniePRO Desktop Application can be downloaded for free from our website: http://www.nrgsystems.com/technical-support/software

Software installation must be performed by an administrative user. It also requires Microsoft .NET Framework, which is distributed by Microsoft through updates (your Windows PC may already have it). If the installer software detects that Microsoft .NET Framework is not installed, you will be prompted during the installation process. In order to communicate with the logger, a remote MetLink connection or a MetLink USB port/USB cable connection is required.

The software installs to the Program Files (“Program Files (x86)” for 64-bit computers) folder within the NRG Systems folder. Site files are stored in the default folder C:\Users...\Documents\Renewable NRG Systems. This
folder location can be changed after installation under File>Settings. The locations of exported files and log files are also assigned in the Settings screen.

The **Home Screen** provides a fleet view of existing sites listed in rows, sortable by column. Right-clicking on any Project site in the **Fleet View** list provides the option to edit remote connection settings, view site information, delete the site, refresh the site list, hide the map, or display times using the PC’s local time zone (instead of the site’s local time zone).

The **File**, **Options**, and **Help** menus appear in the upper right corner of the Home screen along with buttons to view sites in Google Earth or in a browser (using Bing Maps). These are described in more detail in **Chapter 5**.
Selecting an existing site by double-clicking opens the **Site Utilities** screen. The **File**, **Site**, **Logger**, and **Help** menus appear in the upper right corner of the screen. These are described in more detail in **Chapter 5**.

The left pane is divided into three functional parts, **Fleet View**, **Site**, and **Instruments**.

Clicking on the **Fleet View** icon will return you to the home screen with all sites and connected loggers.

The **Site** section contains buttons to access the **Site Utilities**, **Automation**, **Timeline**, and **Reports** screens:

- The **Site Utilities** screen handles database related functions such as editing site information, exporting data, and storing the data encryption password.
- The **Automation** screen allows you to configure automated actions to be performed during the next MetLink connection such as upgrading firmware, retrieving files, and importing retrieved files into the database.
- The **Timeline** screen is used for tracking and editing sensor histories, viewing logger events and communication logs.
- The **Reports** screen allows generation of exportable and printable reports based on the site data.

The **Instruments** section contains buttons to access the **Logger**, **Channels**, **Schedules**, and **iPack** screens, and to **Connect** remotely to a logger in the field:

- The **Logger** screen controls logger configuration and security settings.
- The **Channels** screen allows individual channel configurations.
- The **Schedules** screen is used to set the connection schedules for different types of remote connections.
- The **iPack** screen provides connection status information and upgrades firmware for the iPack. Some advanced settings such as frequency band or mobile carrier selection are also available from the iPack screen.
Edited fields are highlighted or un-highlighted when changes are saved or discarded. When navigating between the different tabs on left pane of the screen, unsaved changes are noted in the left navigation bar on the relevant screen icon as well as noted in the upper right corner of the page. A Save All button saves all changes made within the Instruments tabs. To discard changes made in the Instruments tabs, click the Discard All button.

2.2.2 Network Considerations

You may need to consult with your organization’s IT staff regarding network requirements and firewalls. The user must have administrative privileges in order to perform the software installation. However, the data folder can be written to without administrative privileges. For more information on firewall requirements, refer to Appendix C.
CHAPTER 3 PRE-INSTALLATION PREPARATION

This chapter provides an overview of the hardware and software you will use to prepare your SymphoniePRO system for installation in the field. Relevant operational details are provided to help you optimize the system and its communications for your site and project.

Updating iPackGPS for SymphoniePRO use

Version 60

SymphoniePRO Desktop

Upgrade NN.NN.NN.ifw

SymphoniePRO

iPack

Version 59 or lower

SDR

Upgrade NN.NN.NN.ifw

AT Modem Cable

DB9(female) → DB25(male)

iPack
In preparation for configuring the logger, make sure that any iPack that you will be using with the SymphoniePRO logger has been upgraded to SymphoniePRO iPack firmware. For any iPackGPS with SymphoniePLUS3 firmware version 60 or higher, or any iPackACCESS with SymphoniePLUS3 firmware version 06 or higher, the firmware can be upgraded using SymphoniePRO Desktop Application (described in section 3.4.4). The latest SymphoniePRO logger and iPackGPS firmware files are included in the SymphoniePRO Desktop Application download and can also be downloaded from NRG’s website. See Appendix C for more details on upgrading pre-version 60 iPackGPS or pre-version 06 iPackACCESS firmware.

Once connected with SymphoniePRO Desktop Application, iPack firmware can be updated to the latest version compatible with the SymphoniePRO logger. SymphoniePRO iPack firmware will have a version number in the format NN.NN.NN.ifw.

3.1 Configuring the Logger

Logger settings are configured in the Logger and Channels screens found in the Instruments section of the Site screen in SymphoniePRO Desktop Application. All SymphoniePRO logger settings are configured through the software via MetLink connection (USB or remote) rather than through the logger’s keypad. To initially configure your logger, install the D-cell batteries or connect the iPack to power it up, connect the logger to your PC using the USB cable, and start SymphoniePRO Desktop Application.

**SymphoniePRO Initial Configuration via USB**

*User PC to SymphoniePRO*
The logger will appear in the site list. Double click on the list entry and the Logger screen will open automatically. If the site file already exists and you’ve made a MetLink connection, you will be taken to the Logger screen where you can view current settings.

3.1.1 Memory

The Logger screen’s Memory section allows monitoring and management of memory usage.

The SymphoniePRO logger can record data to an SD card in addition to recording data to its internal memory. If no card is present, the Memory section of the Logger screen will indicate “Internal” instead of “SD Card”. The logger will record data to its internal memory (7.8 MB capacity) until it is full; then it will overwrite the oldest internally stored data first (circular buffer). The time it takes to fill the internal memory varies depending on the number of installed sensors, the selected averaging interval, and whether or not raw data files are being recorded.

*Note* - An SD card installed in the SymphoniePRO logger can provide redundant data backup. Industrial-rated 512 MB and 2GB SD cards are sold separately.

*Note* - When data files are transmitted by email or through a MetLink connection, they are sent from the logger’s internal memory, not from the SD card.

The logger writes data to the SD card from the internal memory whenever a file closes; *.RLD* files close every day at midnight. A file will also close whenever a configuration change is made to the logger (changing a sensor type or an averaging interval, for example). When an SD card is inserted, any files saved to the internal memory that had previously not copied to the SD card will be copied.
The amount of time to fill the SD card will vary according to sensor configuration and logger settings. A factory-formatted 512 MB card can hold over 10 years of data files for a typical wind resource assessment (WRA) installation collecting 10-minute statistical data. For example, a meteorological tower outfitted with 7 anemometers, 3 wind vanes, 2 temperature sensors, 1 barometric pressure sensor and 1 relative humidity sensor, set to collect 10-minute statistics and connect once per day using a remote connection to the user's PC will transfer around 45 KB per day.

*Note - Because a MetLink connection uses very little bandwidth overhead, the transmitted byte usage will closely follow the data file size.*

Turning on the 1 Hz sample data collection will use about 250 KB of data per day per enabled channel, and a 2 GB SD card is strongly recommended.

For example, if 1 Hz sample data were collected for two of the anemometers and one of the vanes, the sample data size for the same one day period would be 750 KB. Under this scenario, the daily file size would be 795 KB (45 KB + 750 KB), and a 2 GB SD card can hold over 6 years of data.

If all channels are enabled, and 1 Hz sample data are collected for all channels, the internal memory will be filled in about 18 hours, and a 2 GB SD card will be filled after approximately 220 days.

**Caution**

*When collecting 1 Hz sample data, the logger will be creating and transferring very large files relative to those from previous model NRG data loggers. Please be sure to budget for any 1 Hz sample data collection in your wireless plan.*

*Note - With 1 Hz sample data enabled, a 2 GB SD card is strongly recommended. The 1 Hz sample data will use about 250 KB of data per day per enabled channel. If the SD card is removed, the SymphoniePRO logger will continue to record data to its internal memory. With 6 channels recording sample data in addition to statistical data, there will be approximately 4 days of internal data storage. Collecting 1 Hz sample data uses a lot of memory!*

### 3.1.2 Data Retrieval

The **Retrieve By Date Range** button in the Data Retrieval section retrieves files via remote or direct (USB) MetLink connection from the internal memory and saves them to the Raw file folder on your PC. Double-clicking on files in the Raw file folder will open a QuickView window (see section 5.9) that shows a snapshot of recorded statistical data for each logger channel. The date range of available data is shown; leave dates blank to retrieve all available data files. More detailed information on retrieving and importing data can be found in Chapter 5.
3.1.3 Site

**Number**
The Site Number field defaults to the last 5 digits of the logger’s serial number but can be reset to any six digit number. In the event the logger is replaced, the new logger should be programmed with the same site number to provide data continuity for that location.

*Note - The site number is used throughout the system as the main identity of the site and the "home" for that logger and all of its data and therefore must be unique across the fleet. Don’t use duplicate site numbers.*

**Description**
A site description of up to 20 characters can be entered. This is used to provide a brief description of the site, such as “Mtn Ridge-West Tower” and may include the site number. The description is typically a location within a project.

**Project**
A project description of up to 20 characters can be entered. Project is usually a broader term that describes multiple sites. This is used to provide a brief description of the overall project, such as “Windy Solar Farms”.

**Units**
SI (metric) units of measure can be selected for displaying measurements on the logger’s screen.

3.1.4 Location

**Description**
A site location description of up to 20 characters can be entered. This is used to provide a brief description of the site location, such as “Springfield, VT, USA”.

**Latitude**
Enter latitude in decimal degrees (rather than degrees, minutes, seconds). Format will look like: 44.3286110. Use positive numbers for northern latitudes; use negative (-) numbers for southern latitudes. If an iPackGPS with adequate GPS signal is connected to the logger, this setting will be updated automatically at the end of a successful call.

**Longitude**
Enter longitude in decimal degrees (rather than degrees, minutes, seconds). Format will look like: -73.1100000. Use positive numbers for eastern longitudes; use negative (-) numbers for western longitudes. If an iPackGPS with adequate GPS signal is connected to the logger, this setting will be updated automatically at the end of a successful call.

**Elevation (m)**
Elevations are always provided in meters regardless of the logger’s “Units” setting. If an iPackGPS with adequate GPS signal is connected to the logger, this setting will be updated automatically at the end of a successful call.
**Time Zone**
Select the logger’s local time zone from the drop-down list. The SymphoniePRO logger defaults to time zone UTC+0:00.

*Note - Remember to use logger local standard time (not daylight saving time). The logger clock will not adjust for daylight saving time.*

**3.1.5 Configuration**
Logger **Configuration** details are automatically detected by SymphoniePRO Desktop Application. During initial configuration, the logger clock can be set to the PC time by selecting the **Set Clock** button. The logger’s firmware can be upgraded to the latest version by clicking the **Upgrade Firmware** button. Instructions for upgrading the firmware can be found in Chapter 5. When new firmware is available, an orange flag will appear on the menu bar of SymphoniePRO Desktop Application. Current versions of firmware are always available for download from the NRG Systems website (http://www.nrgsystems.com/services-support/documentation-and-downloads/software-downloads.)

**Serial Number**
The SymphoniePRO logger has a unique 9-digit serial number that is embedded in its microprocessor.

**Model**
The model number of the SymphoniePRO logger is 8206.

**Ref Time**
Ref Time is the PC clock’s current time, displayed in the logger’s local time zone (selected in the **Location** box). Pressing the **Set Clock** button will update the logger’s clock to the reference time.

**Logger Time**
The logger clock’s current time is displayed. Verify that this is the current time in the local time zone in standard time (not “daylight savings” time).

**Firmware Version**
Firmware version on this screen refers to the version of the SymphoniePRO logger’s operating system. See Chapter 5 for more details on updating the logger’s firmware.

Pressing the **Upgrade Logger Firmware** button will open the Upgrade Logger Firmware window and allow a firmware version to be selected and the upgrade initiated with the **Start Upgrade** button. The firmware upgrade process is described in more detail in Chapter 5.

**Hardware Version**
SymphoniePRO’s hardware version refers to the version of the assembled circuit board and its electronic components.
**Manufacture Date**
The date when the logger was manufactured is displayed.

### 3.1.6 Security

#### Data Encryption Password

As a security measure, SymphoniePRO can encrypt data as it’s written to the file before it’s transferred to the user. A Data Encryption Password of up to 20 alphanumeric characters (and at least 1 character in length) can be enabled by setting a Data Encryption Password in SymphoniePRO Desktop Application’s **Logger** screen.

To decrypt imported data, the same Data Encryption Password must be set in the site file (from the Site Utilities screen). It must also be entered to view the data in QuickView.

![Data Encryption Password](image)
Note - This is an optional feature intended only for those for whom data theft is a risk. If the data files are stored in an encrypted format on the SD card, the encryption password will also be needed for the software to decrypt the data. Encryption password status is indicated by SymphoniePRO Desktop Application. Loggers are shipped from NRG Systems with data encryption disabled.

Caution

Do not lose the Data Encryption password! Keep it in a safe place.

Logger Access PIN

As a security measure, a numeric access/system lockout code of up to 6 digits can be set using SymphoniePRO Desktop Application and USB connection. Note that this is an optional feature intended only for use by those for whom logger theft is a serious risk. Once access to the site via SymphoniePRO Desktop Application has been obtained through use of the existing logger access PIN, the logger access PIN can be changed using the Set and Disable buttons; however a USB connection between the logger and SymphoniePRO Desktop Application is required.

With a logger access PIN set, when a logger key is pressed, the first screen displayed will be:

Enter PIN:
Attempts Left: 8
Site: 000000
SN: 000000000

Failure to enter the correct logger access PIN followed by the [SET] button will result in a message:

Enter PIN:
Attempts Left: 7
Site: 000000
SN: 000000000

If the correct PIN isn’t entered during one of the remaining attempts, access (via the keypad or communication interfaces) to the logger will be disabled for approximately 2 days. Logger access PIN status is indicated by SymphoniePRO Desktop Application.

Security

<table>
<thead>
<tr>
<th>Feature</th>
<th>Status</th>
<th>Set</th>
<th>Disable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Encryption Password</td>
<td>Disabled</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Logger Access PIN</td>
<td>Disabled</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Loggers are shipped from NRG Systems with the logger access PIN disabled. If a logger has the logger access PIN enabled and a matching PIN does not already exist in the site file, this screen will be displayed when MetLink communication with the logger is attempted:

![Logger PIN Access](image)

**Caution**

*Failure to enter the correct Logger Access PIN within 8 attempts will lock access to SymphoniePRO for approximately 2 days, and there is no way to defeat the lockout – use caution!*

**MetLink Authentication**

In addition to the user-selected security features described above, each MetLink connection utilizes authentication to verify both the logger and desktop application.
3.2 Configuring Logger Channels

Logger configuration can be completed before connecting the sensors to the logger. Connect your computer running SymphoniePRO Desktop Application to the logger using the USB cable or remote connection, and double click the site on the Home screen. Under the Instruments section in the left navigation pane, click on the Channels icon. The Channel Configuration screen shows the current settings saved in the logger. Changes in configuration can be saved to the logger’s memory using the Save to Logger button, while the Load from Logger button will revert to the settings saved in the logger. Changes to individual sensor channels and logger settings can also be saved using the Save All button or discarded using the Discard All button (shown only when changes are detected). Clicking the Load from Logger button restores the original settings without saving any changes.

3.2.1 Live Data

Once the logger channels are configured, sensors are connected, and a connection (remote MetLink or USB MetLink) is established, the Live Data button can be used to toggle the live data feature on and off. Live data can be used to verify sensor scale factors or to check sensor condition during or after a severe weather event.

Note - All sensor channel fields must be filled in before live data will be transmitted.

Turning on the live data will display instantaneous sensor measurements in scaled units. Hovering over the live data value for each sensor will display a pop-up graph showing the measurements changing over time. Battery voltage, and estimates of data recorded per day (total, statistical and sampled) are also displayed at the top of the screen.
The Live Data function consumes additional battery power and network air time. Live data will automatically turn off after 5 minutes or if you navigate away from the Channel Configuration screen.

### 3.2.2 Wiring Panel, Data Logging Mode and Channel Type

The SymphoniePRO logger has a selectable **Statistical Reporting Period** of 1, 2, 5, 10, 15, 30, or 60 minutes.

<table>
<thead>
<tr>
<th>Channel Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Statistical Reporting Period</strong></td>
</tr>
<tr>
<td>10 Minutes</td>
</tr>
<tr>
<td>1 Minute</td>
</tr>
<tr>
<td>2 Minutes</td>
</tr>
<tr>
<td>5 Minutes</td>
</tr>
<tr>
<td>10 Minutes</td>
</tr>
<tr>
<td>15 Minutes</td>
</tr>
<tr>
<td>30 Minutes</td>
</tr>
<tr>
<td>60 Minutes</td>
</tr>
</tbody>
</table>

There is also a selection for choosing a 16-channel or 26-channel wiring panel. If you choose the 16-Channel Wiring Panel, the Application will shut off the 10 unused channels and only display the 16 channels.

**Note:** The 16-Channel Wiring Panel selection maintains the same logger channel numbers as the 26-Channel Wiring Panel. In other words, the channels on the 16-channel wiring panel are not all numbered consecutively.
Logger channels are grouped by sensor signal type: counters, analog with 2.5 V or 5 V excitation, analog with 5 V or 12 V excitation, and analog sensors used with P-SCM (SymphoniePRO Signal Conditioning Module) cards. Clicking on the + symbol to the left of the channel number expands the window to show sensor details, and clicking the – symbol hides them.

To configure each channel, you may select a sensor from a drop-down list of commonly-used sensors. The Data Logging Mode offers the options of turning the channel off, recording statistical data only (averages, standard deviations, etc., over the statistical interval selected in Statistical Reporting Period above), or recording both statistical data and sample data (1 Hz). A 2 GB SD card should be installed in the SymphoniePRO logger when raw sample data collection is enabled on any channel.

*Note - The large volume of data associated with recording raw sampled data will significantly increase transmission times and power consumption if you wish to retrieve the data remotely.*

Counter channels are compatible with anemometers and totalizer type sensors, and the type being used is defined in the Channel Type drop-down menu. For example, when selecting “NRG Class1” from the “Load From Defaults” list, the Channel Type is set to “Anemometer”.

The Analog 2.500 V or 5 V Excitation channels are compatible with wind vanes and other analog type sensors. A Channel Type of Wind Vane will record unit vector average direction, standard deviation (Yamartino method), and direction of maximum gust for a corresponding anemometer channel (Channel 13 corresponds to Channel 1, Channel 14 corresponds to Channel 2, etc.).

Other Analog channels will record the statistical average, standard deviation, minimum, and maximum. A selection of Analog Simple records only the statistical average. This setting is useful for reducing the amount of data transmitted for sensors with no need for the additional statistical information or for sensors with low signal variance in the reporting period. For example, a user may choose to use Analog Simple for temperature and barometer readings. The Scale Factor, Offset, and Units will vary according to the sensor model selected in the channel configuration and on the units of measure selected for the logger.
The Analog P-SCM channels are compatible with wind vanes and a variety of analog type sensors and require a corresponding SymphoniePRO Signal Conditioning Module (P-SCM) to be inserted in the logger and the appropriate P-SCM selected from the SymphoniePRO Signal Conditioning Module (P-SCM) drop-down menu.

A link to a locally-saved PDF of the Sensor Wiring Map is available to the left of the Live Data button.

3.2.3 Sensor Description

The Description field can be used to describe the sensor in up to 20 alphanumeric characters.

A serial number of up to 20 characters can be entered in the Serial Number field. When a serial number is entered for an NRG #40C or NRG Class 1 anemometer and the PC you are using is connected to the Internet, the calibration report for the sensor will automatically be downloaded into a Calibration Reports folder. After the calibration report is downloaded, a link to it will appear below the Serial Number field.

The Height of the sensor should be entered in meters above ground level.

The Boom Bearing field indicates the sensor boom orientation in positive degrees relative to north. It is recommended to record this value relative to true north, which requires adding the magnetic declination (http://www.ngdc.noaa.gov/geomag-web/).

In addition to the Boom Bearing field, there is a Vane Mounting Angle field for wind vane channels. Vane Mounting Angle defines the angle of the “North Mark” on the vane relative to the boom. Zero degrees indicates the mark is facing away from the boom and tower; 180 degrees indicates that the mark is directly facing the boom.
boom and the tower. In the rare case of using a vane mounting angle other than 0 or 180, the angle is measured clockwise starting from the 0 degree alignment example.

An explanation of the Boom Bearing and Vane Mounting Angle is available by hovering over the Vane Mounting Angle tooltip in SymphoniePRO Desktop Application.

For wind vanes with dead bands, the number of degrees of dead band to the east and west of north should be indicated in the Dead Band Compensation fields.

Scale Factor and Offset values are entered in SI units.

### 3.2.4 Signal Type or Excitation

Signal Type and Excitation settings are automatically populated when selecting a sensor from the drop-down list. Do not change these settings unless you are certain that you are using a sensor that requires a different setting from the default.

Signal Type choices for counter channels include Coil and Pulsed. When Pulsed is selected, the user can additionally choose to enable a 12K ohm internal pull-up resistor to generate a 3.3 V pulse from the sensor output signal. The pull-up is typically utilized for sensors that use switch closures to create the signal. Notice that when a sensor is selected from the “Load From Defaults” list, the Signal Type is automatically appropriately configured.
The **Excitation Mode** can be set to Off, On, or Pulsed, and the **Voltage** can be set to either 2.5 V, 5 V, or 12 V, depending on the channel.

For Analog P-SCM channels, the appropriate **SymphoniePRO Signal Conditioning Module (P-SCM)** must be selected from the drop-down menu. The P-SCM selection automatically sets the appropriate logging mode for the channel.
3.3 Schedules

Communication schedules are configured on the Schedules screen. SymphoniePRO offers several options for remote (MetLink) connections. Refer to Appendix C to review the different connection types and choose what’s appropriate for your situation.

The Load from Logger button retrieves and displays current settings in the iPack. The Save to Logger button saves all settings on the Schedules screen to the iPack.
The **Display iPack Status** button shows the iPack’s current status:
At the bottom of the iPack Status window are links to view the iPack log file and browse to the log file folder. Log files provide a record of connections and other iPack events and are described in further detail in Appendix M.

3.3.1 MetLink Logger Initiated Schedule

The MetLink Logger Initiated Schedule section controls how the logger initiates a connection and identifies the computer to which connection will be made.

**Frequency**

Connection frequency can be set to 10 minutes, 30 minutes, 1 hour, 2 hours, 4 hours, 6 hours, 12 hours, daily, 2 days, 3 days, 4 days, 5 days, 6 days, or weekly. Setting the connection frequency to Disabled will prevent the logger from attempting a MetLink Logger Initiated connection, and attempts to initiate a connection from the logger’s keypad will be ignored.

**Time (Logger Local)**

The Time field allows the user to select the time of day at which the connection will occur. Time can be edited as needed and does not need to be at the top of the hour.

If unable to connect successfully on the first attempt, the connection will automatically be attempted again every 10 minutes up to 5 times.

MetLink connections will remain active for up to one hour or 20 minutes beyond the programmed MetLink Logger Listening duration, whichever is greater. For example, if the Listening duration is set for 10 minutes, the iPack will automatically disconnect after 60 minutes. If the Listening duration is set for 3 hours, the iPack session

---

![Log File Example](image-url)
will disconnect after 3 hours and 20 minutes. The user can manually end the session sooner or program the logger to disconnect as soon as automated actions are completed. Closing SymphoniePRO Desktop Application closes all MetLink connections.

**Next**
The Next field shows the next date and time at which the logger will attempt a connection based on the current schedule. The date and time are updated any time the Frequency or Time fields are changed, not just upon saving to or loading from the logger. However, the updated settings will only take effect after they have been saved to the logger.

**Primary Host Name**
The logger will first attempt to connect to the primary host, and if that fails, it will attempt to connect to the secondary host (if one is specified). The primary host name will typically be in a format similar to myhost.mycompany.com or it can be an IP address.

**Port**
The port can be configured to any port number between 0 to 65535. The default port is 30406. Consult your network administrator to choose a port not already in use.

**Test**
Clicking the Test button tests the connection between SymphoniePRO Desktop Application and the Primary Host on the designated port number.

**Secondary Host Name**
The secondary host name is optional. The secondary host name will be in a format similar to host.companyABC.com. If left blank, the logger will only attempt connection to the primary host.

**Port**
The port can be configured to any port number between 0 to 65535. The default port is 30406. Consult your network administrator to choose a port not already in use.

**Test**
Clicking the Test button tests the connection between SymphoniePRO Desktop Application and the Secondary Host on the designated port number.

**Enable Diagnostic Check-In**
If the Enable Diagnostic Check-In box is checked, basic connection status information is automatically sent to NRG Systems Technical Support. This information can be useful in diagnosing communication problems.

**Test**
Clicking the Test button tests the connection between the logger and NRG Systems servers. Please contact NRG Technical Services (support@nrgsystems.com) to confirm successful receipt of diagnostic information.
3.3.2 MetLink Logger Listening Schedule

**Frequency**
Connection frequency can be set to 10 minutes, 30 minutes, 1 hour, 2 hours, 4 hours, 6 hours, 12 hours, daily, 2 days, 3 days, 4 days, 5 days, 6 days, or weekly. Setting the connection frequency to Disabled will prevent the desktop application from allowing an inbound connection, and attempts to initiate a connection from the logger’s keypad will be ignored.

**Time (Logger Local)**
The Time field allows the user to select the time of day at which connection will occur. Time can be edited as needed and does not need to be at the top of the hour.

**Duration**
Duration is the length of time the logger remains powered up and listening for a connection. The duration can be set to 1 minute, 10 minutes, 30 minutes, 1 hour, 2 hours, 4 hours, 6 hours, 12 hours, or continuous. Longer listening modes consume additional battery power, so the duration should be set as short as possible but long enough to establish a successful connection.

MetLink connections will remain active for up to one hour or 20 minutes beyond the programmed MetLink Logger Listening duration, whichever is greater. MetLink Logger Listening connections can be initiated any time within the scheduled Listening period, and the connection will continue until manually disconnected or after the duration described above. For example, if you connect 1 minute before the listening period ends, the connection will be maintained until you disconnect or the session times out as described above. Closing SymphoniePRO Desktop Application closes all MetLink connections.

**Next**
The Next field shows the next date and time at which SymphoniePRO Desktop Application will be able to attempt a connection to the logger based on the current schedule. The date and time are updated any time the Frequency or Time fields are changed, not just upon saving to or loading from the logger. However, the updated settings will only take effect after they have been saved to the logger.

**End Time**
The End Time defines the specific time at which the MetLink Logger Listening period will end.

**Listen Now**
The Listen Now button initiates a logger listening session separate from the regularly scheduled connection and allows SymphoniePRO Desktop Application’s connection to the logger to be tested.

3.3.3 Time Service
The logger’s internal clock is synchronized to UTC time through the internet using an SNTP server or through the iPack’s GPS. Both of these time synchronization methods are run independently during iPack communication operations with the SNTP server providing backup if no GPS signal is available.
Use SNTP
If Use SNTP is selected, the logger will attempt to connect to the SNTP server found in the Time Server field. If SNTP-based time synchronization has been selected, the logger will attempt to connect to the configured SNTP server if it has been more than one day since it last successfully communicated with an SNTP server.

Use GPS
If Use GPS is selected, the logger’s internal clock is updated with UTC time provided by the GPS. If the time adjustment is larger than 60 seconds, an entry is made in the event log.

If both boxes are checked, a GPS time sync will be attempted first, and SNTP will be used if the GPS time sync fails.

3.3.4 Email Schedule

Frequency
Email frequency can be set to 10 minutes, 30 minutes, 1 hour, 2 hours, 4 hours, 6 hours, 12 hours, daily, 2 days, 3 days, 4 days, 5 days, 6 days, or weekly. Setting the email frequency to Disabled will prevent the logger from attempting to email data files, and attempts to initiate an email from the logger’s keypad will be ignored.

Time
The Time field allows the user to select the time of day at which emails will be sent. Time can be edited as needed and does not need to be at the top of the hour.

If unable to connect successfully on the first attempt, the connection will automatically be attempted again every 10 minutes up to 5 times.

SMTP Server
SMTP servers are used to send email from the logger. The SMTP server cannot use SSL or TLS encryption.

Packet-mail users will enter an SMTP server name of smtp.packet-mail.net.

SMTP Port
The SMTP Port is typically port 587 or sometimes port 25. Consult your email service provider to confirm the correct port to use.

User Name
The User Name is the SMTP user name provided for the iPack’s email account, typically something like “Person” or “person@companyABC.com.”

Password
The Password is the password associated with this email account.
**Sender’s Email**
The Sender’s Email is typically the SMTP user name as a full email address and is the unique email address assigned to the logger. A valid email address must be entered if email is enabled. This email address will appear in the “From” field of emails from the logger.

**Sender’s Name**
The Sender’s Name is typically a descriptive name assigned to the logger. It may contain a site number and/or geographic location. It will also appear in the “From” field of emails from the logger.

**Recipient’s Email**
The Recipient’s Email address is the email address to which the logger will send data files.

**Recipient’s Name**
The Recipient’s Name is the name of the person to whom the logger will email data files.

**CC Email**
The CC Email address is another email address to which the logger will send data files. This field can be left blank.

**CC Email 2**
The CC Email 2 address is another email address to which the logger will send data files. This field can be left blank.

**Subject Line**
The Subject Line is the subject line of the email that you receive from the logger and may contain letters, numbers and other symbols. It should be descriptive of the email contents, such as “Windy Hills Site 12345 SymphoniePRO Data”.

**Email Now**
The Email Now button initiates a connection to the internet (if not already connected) and prompts the logger to email any unsent data files. This button is disabled if an iPack isn’t connected.

*Note - If there are many unsent data files, it will consume battery power to send them all.*

**Test Email Settings**
The Test Email Settings button attempts a connection to the designated SMTP server, using the settings entered, to confirm that a connection can be made, but it does not send a data file.

### 3.4 iPack
To program an iPackGPS or iPackACCESS, the iPack must be attached to a SymphoniePRO that is connected to a PC running SymphoniePRO Desktop Application.
The image below shows the iPack screen when the SymphoniePRO is connected to an iPackGPS (2G GSM, 3G GSM, CDMA, or DoCoMo).

The **Load from iPack** button retrieves and displays current settings in the iPack. Some types of iPacks do not require entries in all fields, and therefore some fields will be left blank. The **Save to iPack** button saves all settings on the iPack screen to the iPack. The **Display iPack Status** button shows the iPack’s connection type and current status. Note that it may take up to 15 seconds to establish communication with the modem. Note that Modem Status and Network settings cannot be edited via a remote MetLink connection.
The image below shows the iPack screen when the SymphoniePRO is connected to an iPackACCESS.

3.4.1 Modem Status (iPackGPS only)

State
The State field indicates the current state of the modem.
**Signal Strength**
The Signal Strength field indicates the signal strength of the modem from 0% to 100%.

**Registration**
The Registration field indicates the network registration status of the modem. Possible values are: None, Home, Registered, Searching, Denied, Roaming, Direct, and Unknown.

**Cellular Band**
The Cellular Band field identifies the frequency band currently in use or assigned as the only band permitted to be used by the modem. This field is hidden for types of iPacks for which the frequency band can’t be set to variable values.

**Set**
Pressing the **Set** button brings up a list of frequency bands permitted to be used by the modem, including the value “Automatic”, which causes the modem to pick the best band available in the region. This function is only available through a direct (USB) connection between the logger and SymphoniePRO Desktop Application software.

*Note – the iPack status must be “Disconnect” in order to make changes to the cellular band.*

**Carrier**
The Carrier field identifies the wireless carrier currently in use or assigned as the only carrier permitted to be used by the modem. This field is hidden for types of iPacks for which the carrier can’t be set to alternative carriers.

**Set**
Pressing the **Set** button brings up a list of available wireless carriers in the area permitted to be used by the modem, including the value “Automatic”, which causes the modem to automatically pick a carrier available in the region. After pressing the button, it may take around 30 seconds for the modem to finish searching for available carriers. This function is only available through a direct (USB) connection between the logger and SymphoniePRO Desktop Application software.

*Note – the iPack status must be “Disconnect” in order to make changes to the carrier.*

### 3.4.2 Network Status (iPackACCESS only)

**State**
The State field indicates the current state of the network connection.

**MAC Address**
The MAC Address field indicates the Media Access Control (MAC) address of the Ethernet modem.

**Network Speed**
The Network Speed field indicates the modem speed of the Ethernet modem in milibytes per second.
**Duplex Mode**
The Duplex Mode field indicates the Duplex Mode of the Ethernet modem. The possible values are Half-Duplex or Full-Duplex.

**Crossover**
The Crossover field indicated whether or not the Ethernet modem is connected via a crossover Ethernet cable. The possible values are Yes or No.

### 3.4.3 Network

**ISP Username (iPackGPS only)**
The ISP Username field is for the username assigned by your wireless carrier for the iPack’s data account. It may be a 10 digit account number or phone number (CDMA), or it may be left blank (GSM).

- WindLinx Username: web

**ISP Password (iPackGPS only)**
The ISP Password field is for the password assigned by your wireless carrier for the iPack’s data account.

- WindLinx ISP Password: web

**APN (iPackGPS GSM & iPackGPS 3G only)**
The Access Point Name (APN) is required by GSM iPacks.

- Windlinx APN: nrg.windlinx.com

**SIM PIN (iPackGPS GSM & iPackGPS 3G only)**
Security PINs are sometimes required by service providers. This option is only available for GSM iPacks.

**Dial String (iPackGPS only)**
The Dial String field is automatically populated based on the type of iPack being used. GSM iPacks require a dial string of *99***1#, and CDMA iPacks require a dial string of #777. Do not change these values.

**BGAN M2M Satellite Module Connected (iPackACCESS only)**
Check this box when using the iPackACCESS with a BGAN M2M Satellite module. This enables the smart switching of 12 V output power from iPackACCESS to the BGAN M2M modem for reliable remote operation and adjusts the iPack’s activity timing to work well with the BGAN M2M device.

*Note - Be sure the Modbus Server checkbox is disabled when using iPackACCESS with a BGAN M2M Satellite module. Enabling Modbus over a satellite connection can result in excessive communications costs!*

**Enable DHCP (iPackACCESS only)**
By default, this box is checked. Leave it checked to use DHCP to automatically assign an IP address to the iPackACCESS.
When this box is not checked, you must fill in the fields for iPack Static IP Address, Subnet Mask, and Gateway.

![Network settings](image)

**Note** - *If DHCP is enabled, the IP address assigned to the iPackACCESS may change, which could prevent the ability establish a MetLink Listening or Modbus connection. If using DHCP, it is recommended to create a rule for the router to apply a consistent IP address to the iPackACCESS.*

**Primary DNS Server**
By default, the Primary DNS Server is left open. Do not change this field, unless your ISP requires a specific DNS server.

**Secondary DNS Server**
By default, the Secondary DNS Server is left open. Do not change this field, unless your ISP requires a specific DNS server.

### 3.4.4 Configuration

**Serial Number**
The serial number shown in the Configuration section of the iPack screen is the serial number of the iPack.

**Model**
The model of iPack (e.g., 2G GSM, 3G GSM, CDMA, DoCoMo, ACCESS) is indicated here.

**Firmware Version**
The firmware version indicated on this screen refers to the iPack’s firmware. An iPack firmware version of 0.60.0 or higher is required for communication with the SymphoniePRO Desktop Application software. An iPack firmware version of 01.00.00.ifw or later is required for compatibility with the SymphoniePRO logger.

**Upgrade iPack Firmware**
Opens the Upgrade iPack Firmware window and allows a firmware file (*.ifw) that has been saved on the PC to be selected and the upgrade initiated with the Start Upgrade button.
**Hardware Version**
The hardware version describes the version of the iPack’s assembled main circuit board with electronic components.

**Manufacture Date**
Date of manufacture of the iPack.

**Modem ID (iPackGPS only)**
The Modem ID is the unique identifying number for the modem. This number is what is recognized by a wireless carrier’s network and is sometimes referred to as an ESN or IMEI number.

**3.4.5 GPS**

**Status**
Indicates status of GPS signal.

**Latitude**
Latitude is shown in decimal degrees (rather than degrees, minutes, seconds). Format will look like: 44.3286110. Positive numbers are used for northern latitudes; negative (-) numbers are used for southern latitudes.

**Longitude**
Longitude is shown in decimal degrees (rather than degrees, minutes, seconds). Format will look like: -73.1100000. Positive numbers are used for eastern longitudes; negative (-) numbers are used for western longitudes.

**Elevation**
Elevation of the site above sea level in meters.

**Satellites**
This field displays the number of acquired satellites.

**Start**
The **Start** button enables the GPS to acquire satellites and then update the latitude, longitude, and elevation.

**3.4.6 Modbus Server (iPackACCESS only)**

**Enable Modbus Server**
Check this box to enable Modbus functionality on the iPackACCESS. Note that when Modbus is enabled, the iPack will remain active continuously and it should be connected to a continuously available power source.
**State**
The State field shows the current status of the Modbus server when it is enabled.

**Clients**
The Clients field shows the number of Modbus clients currently connected.

**Port**
Enter the port for the Modbus server to use. By default, the port is 502.

**Use Secure IP Addresses**
Check this box to limit Modbus connections to a list of up to 10 allowed IP addresses. When this box is checked, a Modbus Security section will appear, where you may enter permitted IP addresses.

### 3.5 SymphoniePRO Logger

Once the SymphoniePRO logger and iPack are programmed, settings can be reviewed on the logger’s display using the Measurements, Functions, and Configuration menus and their sub-menus as described below.

Shown along the bottom of the logger’s display are the date, time, 12 V analog sensor current, and icons indicating iPack communication activity, communications to or from the logger, SD card status, and battery levels. SD card status icons are animated while the SD card is being accessed by the iPack.

*Note - Wait until the SD card icon is no longer active before removing the SD card from the logger.*
3.5.1 SymphoniePRO Logger Measurements Menu

Once the SymphoniePRO logger is programmed, sensor information can be reviewed on the logger’s display using the Measurements menu [Home][1] by scrolling through each channel using the [Up] and [Down] arrow keys on the logger’s key pad or by entering the channel number on the key pad. The screen will show the sensor description, real-time measurement, height, and boom orientation for each channel. Pressing the [Right] arrow key provides additional channel information such as sensor type, serial number, transfer function.

3.5.2 SymphoniePRO Logger Functions Menu

The SymphoniePRO logger’s Functions menu [Home][2] provides access to several SymphoniePRO logger and iPack functions through the logger’s keypad. Functions include viewing the logger and iPack status, diagnostics, GPS connections, initiating a test data transmission (“Connection Test”), and reviewing recent logger and iPack events.

| [Home][2] | 1 Logger Functions  
| [Home][2][1] | 2 iPack Functions  
| [Home][2][1][1] | 3 iPack Setup Mode  
| [Home][2][1][1][1] | 4 Recent Events

**Logger Functions**

| [Home][2][1] | 1 Logger Status  
| [Home][2][1][1] | 2 Diagnostics  
| [Home][2][1][1][1] | 3 Utilities

Logger functions [Home][2][1] include **Logger Status** (viewing the Site number, number of saved files, firmware version, and SD card capacity), **Diagnostics** (voltage, current, and power supply information), and **Utilities** (formatting the SD card, adjusting the display contrast, turning the display off, and resetting the logger).
**Logger Utilities**

[Home][2][1][3] →
1 Format SD Card
2 Set Contrast
3 Display Off
4 Reset Logger

Formatting the SD card [Home][2][1][3][1] after connecting sensors will begin saving valid files from that point forward and help avoid cluttering the database with empty or test data files.

SymphoniePRO’s display contrast is pre-set at the factory but can be adjusted through the Utilities screen [Home][2][1][3][2] if necessary. Please note that changes in contrast are temporary. When the display is powered up again, the default contrast setting will appear. This is to avoid the screen being accidentally set so that it can’t be read (completely black or completely white). If the display can’t be read, reset the contrast as follows: If no keypad security PIN is present, press [Home][2][1][3][2], then press the up or down arrow until you can see the screen correctly. If a keypad security PIN is present, press [Home], enter the PIN, and then press [2][1][3][2] followed by the up or down arrow until you can see the screen correctly.

Pressing [Home][2][1][3][3] will turn the logger’s display off.

Pressing [Home][2][1][3][4] will reboot the logger.

**iPack**

If no iPack is connected, or if a connected iPack has a dead battery, no “i” icon will be displayed, and “iPack unavailable” will be shown on the logger’s screen. If an iPack is connected and powered up, the iPack activity icon will show on the logger’s display to indicate the iPack is on.

If the iPack is idle or powered off, going to the iPack menu [Home][2][2] will initialize the iPack. It may take up to a minute for the iPack to initialize and warm up. The screen will display the iPack’s current status throughout this process.

[Home][2][2] →
1 Connection Test
2 Connection Status
3 Shutdown iPack
4 Reset iPack
5 Disconnect
6 GPS Status

iPack functions [Home][2][2] include **Connection Test** (Initiate Primary, Initiate Backup, MetLink Listen, MetLink Diagnostic, Send via eMail, and SNTP Time Update), **Connection Status** (shows status information for detected connection type, including modem status, network status, and MetLink status), **Shutdown iPack** (closes all open connections, disconnects from internet, and turns off the iPack), **Reset iPack** (reboots the iPack), **Disconnect**
(ends any current connection, e.g. MetLink, email, Modbus), **GPS Status** (shows GPS signal status, latitude, longitude, altitude, and number of acquired satellites), and **Modbus Status** (Modbus server status and number of clients connected).

### iPack Communications Testing

**Caution**

*Test calls/data connections should always be performed both before and after installing an iPack in the field.*

The **Connection Test** function **[Home][2][2][1]** allows pre-installation or on-site verification of iPack communications. Note that communication tests may also be initiated from SymphoniePRO Desktop, as described in section 3.3.

1. **Initiate Primary**
2. **Initiate Backup**
3. **MetLink Listen**
4. **MetLink Diagnosis**
5. **Email No File**
6. **Email One File**
7. **Email All Files**
8. **SNTP Time Update**

To test the MetLink Initiated Connection from the logger, go to **Initiate Primary [Home][2][2][1][1]**. The logger will force a connection to the Primary Host, as programmed in the MetLink Logger Initiated Schedule. **Initiate Backup [Home][2][2][1][2]** will force a connection to the Secondary Host. To successfully establish a connection with either host, the host PC must be powered on and have SymphoniePRO Desktop Application running. It may take a few minutes to establish a connection. The logger screen will update with the status of the connection. End the test by shutting down the iPack **[Home][2][2][3]**.

To test the MetLink Listening Connection from the logger, go to **MetLink Listen [Home][2][2][1][3]**. The logger will enter MetLink Listening mode and will accept connections from a PC. Information on initiating a MetLink Listening connection in SymphoniePRO Desktop is in section 5.1.5.

Selecting **MetLink Diagnosis [Home][2][2][1][4]** will initiate a diagnostic check-in to the NRG Technical Services server. This feature may be helpful if you are unable to successfully complete a MetLink Initiated connection.

There are three options for forcing an email from SymphoniePRO. Selecting **Email No File [Home][2][2][1][5]** will send a test email with no data attached using the programmed SMTP settings. Selecting **Email One File [Home][2][2][1][6]** will send the most recent data file by email. Selecting **Email All Files [Home][2][2][1][7]** will force any unsent *.RLD files saved in the SymphoniePRO’s internal memory to be sent to the email address(es) programmed in the **Schedules** section of SymphoniePRO Desktop Application.
If no antenna is attached, or the data transmission can’t be completed, the iPack will attempt to connect another 5 times. If none of those attempts are successful, no further attempts to connect will be made until the next scheduled time configured in the logger or another Connection Test is initiated. The logger will also ignore attempts to establish a MetLink connection or test connections if the MetLink (Logger Initiated or Logger Listening) schedule is set to Disabled in the Schedules screen. If the email frequency schedule is set to Disabled in the Schedules screen, the logger will not attempt to email.

If an SNTP server was programmed for the SymphoniePRO’s Time Service, the logger time can be updated using SNTP Time Update [Home][2][2][1][6].

**Connection Status**

Connection Status [Home][2][2][2] provides information about the iPack status, the modem or Ethernet status, network status, and MetLink status. The iPack Status screen appears first, and you can view the other screens by pressing the right arrow on the logger keypad.

On the iPackGPS, the Modem Status screen includes information about the type of cellular network (e.g. 3G or CDMA), the current modem activity, the antenna signal strength, the cellular band, and the carrier.

On the iPackACCESS, the Ethernet Status screen displays the connection status and connection type (e.g. Full Duplex or Half Duplex).

The Network Status screen displays the IP address assigned to the iPack (whether a static or dynamic IP) and the DNS server.

The MetLink Status screen displays the iPack’s current MetLink activity, amount of data being transmitted and received, and the number of clients connected.

The GPS Status screen [Home][2][2][4] displays the latitude, longitude, altitude and the number of acquired GPS satellites. The latitude and longitude are shown in degrees and decimal minutes (rather than in degrees, minutes, and seconds).

**Caution**

*Failure to connect the GPS antenna will cause the location tracking and/or GPS time sync functions to spend up to 2 minutes searching for a GPS signal, consuming battery power unnecessarily.*

**iPack Setup Mode**

Enabling iPack Setup Mode [Home][2][3] forces constant 12V power from the iPack and disables any scheduled actions (MetLink, email) for 30 minutes or until disabled (if sooner than 30 minutes). This feature is useful when configuring a BGAN satellite antenna with iPackACCESS.

**Recent Events**

The Recent Events screen [Home][2][4] lists the 15 most recently recorded events for the SymphoniePRO logger and iPack including successful calls, remote firmware updates, or clock adjustments. The [Up] and [Down] arrow
keys can be pressed to scroll through numbered logger and iPack events. The most recent events are displayed first. The numeric keypad can be used to enter a number to jump to a particular event. All events are recorded in the data file. A comprehensive list of SymphoniePRO logger events and iPack events and their definitions can be found in the Troubleshooting section (Appendix B) of this manual.

3.5.3 SymphoniePRO Configuration Menu

The SymphoniePRO’s Configuration menu [Home][3] provides a way to view settings programmed in the SymphoniePRO Desktop Application for the SymphoniePRO logger and iPack using the logger’s display and keypad. Reviewing the settings found in the software can be useful if a laptop running SymphoniePRO Desktop Application is not available.

The logger’s Configuration menu is structured like the Instruments section of the Desktop Application software and provides the same settings information found on the Logger, Channels, Schedules, and iPack screens in the software.

Within the Configuration menu, selecting a number on the keypad and then using the arrow keys allows navigation through the corresponding screens and settings in SymphoniePRO Desktop Application. Note that these settings are read-only in the logger interface and can only be changed by connecting the logger to a PC with SymphoniePRO Desktop Application.
The Logger Config [Home][3][1][3] menu contains useful details about the data logger, including the serial number, firmware version, and manufacture date.

The Physical Channels [Home][3][2][2] menu displays a list of which sensor has been configured in each channel and details of each sensor’s configuration, including height, boom orientation, scale, offset, and serial number.

The Schedules [Home][3][3] menu provides configuration details for each communication type (MetLink Initiated, MetLink Listening, Email), including the frequency and the date and time of the next scheduled connection.

The iPack Config [Home][3][4][1] menu contains useful details about the iPack, including the serial number, firmware version, manufacture date, and modem ID.

The Network Config [Home][3][4][2] and Modem Config [Home][3][4][3] menus provide additional details about the cellular settings.

### 3.6 Office Testing

Before heading out to the field, you should verify that all equipment is working as expected. Make sure all equipment has the latest firmware version and that you are using the latest version of SymphoniePRO Desktop Application. Updates can be found on the NRG Systems website in the Technical Services section under Software Downloads: [http://www.nrgsystems.com/technical-support/software](http://www.nrgsystems.com/technical-support/software)

**Why It Is Important**

Office testing your SymphoniePRO system prior to installation in the field will save you time and money. Communication capabilities rely on perfect coordination between device programming and accounts in addition to ISP and network/firewall settings – if these are not set up correctly, the system will not communicate.

In the event you find a problem during office testing, SymphoniePRO Desktop Application’s test buttons, event logs, and communications logs can be helpful in troubleshooting connection issues.

*Note - Any connection test features disabled in SymphoniePRO Desktop Application will not be available from the logger’s menus.*

**What You Will Need**

If you haven’t done so already, read the rest of this manual, paying particular attention to the chapter covering Field Installation. If you are ready to begin office testing your SymphoniePRO system, you should have already completed the pre-installation configuration tasks described previously in this chapter.

You’ll also need a few test sensors with cables, the field wiring panel and related hardware, a USB cable, an SD card, the antenna(es) included with your iPack, any cables or connectors used with your iPack, a Phillips head (+) screwdriver, and a computer running the latest version of SymphoniePRO Desktop Application.
3.6.1 Connecting the Wiring Panel to the Logger

Connect the wiring panel to the SymphoniePRO logger using the 62 pin cable connector. Use the thumbscrews to secure the connection at both ends. Once the wiring panel is connected, you may use the sensor wiring diagram in section 4.5.2 to connect a few test sensors.

3.6.2 Testing Remote Communications

We recommend performing a communications test when using the iPack to ensure that your connections are working as expected before heading to the field. Be sure you are in a location with coverage and that the antenna is connected. Also make sure that the frequency for the connection mode you wish to use (MetLink or Email) is not set to Disabled on the Schedules screen.

Performing a “Connection Test” through the Functions menu ([Home][2][2][1]) allows you to test different aspects of the communications. After the test is completed, verify that the raw data file was received by the intended recipient(s).

A good first test is MetLink Diagnosis [Home][2][2][1][4]. This test verifies that the system can connect to a fixed IP address at NRG Systems. The logger’s display will show a series of status messages followed by the transfer and receipt of bytes of information. The number of clients will go from 0 to 1. The system will then disconnect, and the number of clients will go back to 0.

If the system is set up to send data via email, use Email No File [Home][2][2][1][5] or Email One File [Home][2][2][1][6] to verify that the modem and email functions are working well. Initiate Primary [Home][2][2][1][1] verifies that the logger can connect to the assigned IP address behind your company’s firewall and communicate with SymphoniePRO Desktop Application. MetLink Listen [Home][2][2][1][3] puts the logger in listening mode so that a test connection can be attempted with the SymphoniePRO Desktop Application. When a successful MetLink connection is made, you will see the client count increase.

SymphoniePRO Desktop Application is designed with many features for testing the various types of connections SymphoniePRO can utilize. The Listen Now, Email Now, Test Email Settings, and Test buttons on the Schedules screen can be used to verify and troubleshoot any connection issues. The Display iPack Status button can be found on both the Schedules screen and the iPack screen, and a log of the current iPack’s connection can be obtained by clicking View log file at the bottom of the iPack Status screen.

3.6.3 Reading a Raw File

Read the raw file sent during the test call to confirm that sensor configurations are correct. You can do this by choosing Import Raw Logger Data files (*.RLD) from the File menu and then use Data Export in the Site Utilities screen to export the data in *.txt format for viewing in Excel, Notepad, etc.

**Data File Format**

File name format is as follows: SSSSSS_YYYY-MM-DD_HH.MM_FFFFFF.rld

SSSSSS = 6 digit site number
YYYY-MM-DD = Year, Month, Day that the file was created by the logger.

HH.MM = Hour and minute (24-hour time) that the file was created.

FFFFFF = 6 digit file number

To look at sensor measurements, go to the folder where raw files (*.RLD) are stored, and double click to open up QuickView.

**Data File Size**

Unlike past Symphonie data loggers, the size of a SymphoniePRO data file is variable depending on how much data is being collected.

The maximum file size is 128 kb. If the logger is collecting more than 128 kb of data per day, it will break the day’s data into multiple files. For example, if “Stats & Samples” is selected to collect one-second data on a particular channel, the amount of data being stored will increase greatly, pushing the data recorded over 200 kb. In the case where 200 kb of data were recorded in a day, two files would be sent: one 128 kb file and one 72 kb file.

See [Section 3.1.1](#) for more details on data file size and the data logger’s memory.
CHAPTER 4 FIELD INSTALLATION

This section covers the steps for installing a SymphoniePRO system in the field.

4.1 Tools Required

- diagonal wire cutters to trim sensor wire leads
- wire strippers to strip sensor cables if necessary
- 7/16 inch nut driver or wrench
- 5/16 inch nut driver for hose clamps, mounting screws (PV and logger)
- 1/2 inch open-end wrench to tighten ground rod acorn nut
- 1/4 inch nut driver for sensor terminals
- 3/8 inch nut driver or wrench for grounding post nut
- electrical tape
- small flat blade NRG screwdriver (included with logger) for sensor wires
- Phillips head screw driver for PV terminals
- 5/16 inch open end wrench
- drill to tighten hose clamps - optional
- tin snips to cut excess hose clamp - optional
- plumbers putty or similar product for sealing shelter box wire pass-throughs - optional

4.2 Site Grounding Recommendations

Review the grounding information in Appendix G for information regarding proper earth grounding and lightning protection.

Caution  

The copper clad ground rod provides an electrical path for static electricity that builds up on the sensors to dissipate to ground. Failure to use proper grounding protection can damage the equipment and will void the warranty.
4.3 Installing SymphoniePRO + iPack in Shelter Box

4.3.1 Installing Hanging Bracket

The hanging bracket must be connected to the back of the iPack (or to the back of the SymphoniePRO logger in a stand-alone configuration). Use the long screws included with the iPack and a 5/16 inch nut driver to connect the hanging bracket to the back of the iPack so that the wider parts of the bracket holes are oriented down, and the sides of the bracket extend away from the iPack rather than towards it.

4.3.2 Mounting Shelter Box to Tower

The shelter box is shipped with mounting screws that hold the hanging bracket and wiring panel. Also included are some adhesive metal disks (to stick on the outside of the shelter box for magnetic antenna mounting) and some black plastic grommets (to place in the holes for the wires in the bottom of the shelter box).
If the screws aren’t already installed in the shelter box, install them now before mounting the shelter box on the tower.

Then install the black plastic grommets, and stick the adhesive metal disks on the top of the shelter box where the antennas will be mounted.

SymphoniePRO’s shelter box is designed to be rugged and durable to ensure long-term survival in the elements and to protect the logger from ice falling from the tower above it.

The shelter box should be mounted in a location that is easy to access and at a height above maximum annual snow accumulation. For tilt-up towers, you must also consider its position when the tower is tilted down and when the gin pole is in use. It may be easiest to mount the shelter box after the tower is tilted up and then install the wiring panel. It is recommended that you first install the wiring panel in the shelter box and connect the sensor wires before installing the SymphoniePRO and iPack. It is recommended that you do not install the SymphoniePRO and iPack in the shelter box until the very end of the installation process (after the tower is raised and secured).
Mounting on Tubular Towers

Thread the large (size 164) band clamps through the outer slots of the brackets on the back of the shelter box. Wrap the band clamps around the tower and secure with a 5/16” hex nut driver. A drill with a driver attachment will speed up the band clamp tightening process.

Then hang the wiring panel in the shelter box by inserting the shelter box’s 4 lowest mounting screws through the holes in the wiring panel bracket, sliding it to the left, and then tightening the screws to secure it.
Mounting on Lattice Towers
Thread the two band clamps (size 36) through the inner slots on the brackets on the back of the shelter box. Wrap hose clamps around tower and tighten the band clamps with a 5/16” hex nut driver. A drill with a driver attachment will speed up the band clamp tightening process.

Then hang the wiring panel in the shelter box by inserting the shelter box’s 4 lowest mounting screws through the holes in the wiring panel bracket, sliding it to the left, and then tightening the screws to secure it.

4.4 PV Panel Mounting
SymphoniePRO’s 15 Watt PV panel and mounting bracket (NRG part #9112 for tubular towers; NRG part #9111 for lattice towers) should be mounted facing south in the northern hemisphere, and north in the southern hemisphere, to maximize sun exposure.
Attach the mounting bracket to the back of the PV panel using the 4 small screws:
Put the angle bracket against the tower with the longer edge on top, thread the hose clamps through the outer slots of the angle bracket as shown below, and tighten securely. Use inner slots for lattice tower.

Put a washer on each long bolt. Align the holes in the mounting bracket with the upper holes (closest to the tower) of the angle bracket, and insert one of the long bolts. Add a washer and nut to the other end, and tighten using a 7/16” wrench.

Adjust the PV panel’s mounting bracket angle according to latitude to optimize solar radiation and shedding of snow and ice, and install the second bolt in the holes to set the desired angle. Add a washer and nut to the other end, and tighten using a 7/16” wrench.

When installing the PV panel, select a location that will minimize shading. Even the shade from a cable can greatly reduce the output of a PV panel. Coil and secure extra cables with electrical tape to prevent them from flapping in the wind.
Additional power may be required depending on number and type of sensors. External power terminals are available on the iPack for this purpose.

**Note - Please review the following table to verify correct connections.**

<table>
<thead>
<tr>
<th>Connection Point</th>
<th>Do</th>
<th>Do NOT</th>
<th>Functional Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PV Terminals</td>
<td>Do...connect PV panels, DC power sources between 14 and 28 V DC</td>
<td>Do NOT...connect power sources in excess of 28 V DC, including large PV panels</td>
<td>The PV terminals will charge the iPackGPS’s internal battery; the PV terminals will NOT charge an external battery.</td>
</tr>
<tr>
<td>External Battery Terminals</td>
<td>Do...connect 12 V battery and/or external charge controller up to 14.3 V DC</td>
<td>Do NOT...connect PV panel or power sources in excess of 14.3 V DC</td>
<td>The external battery terminals are an input only, an external battery will NOT be charged from the iPackGPS through these terminals nor will the internal iPackGPS battery.</td>
</tr>
<tr>
<td>Grounding Post</td>
<td>Do...connect to wiring panel grounding post.</td>
<td>Do NOT...leave disconnected or connect other wires such as shields.</td>
<td>This terminal will help provide protection from electrostatic discharge for the iPackGPS and logger.</td>
</tr>
</tbody>
</table>

### 4.5 SENSOR CONNECTIONS

When using the SymphoniePRO-26 wiring panel, it is recommended that you first install the wiring panel in the shelter box and connect the sensor wires before installing the SymphoniePRO and iPack. The wiring panel is mounted to the shelter box by inserting the shelter box’s 4 lowest mounting screws through the holes in the wiring panel bracket, sliding it to the left, and then tightening the screws to secure it.

**Caution**

*Make sure that the wiring panel’s ground wire is connected to the earth ground rod before connecting sensor wires! The earth ground wire should be trimmed to the required length to reach the ground rod, and excess wire should not be rolled up or coiled.*

When using the SymphoniePRO-16 wiring panel, it will be easier to connect the sensor wires to the wiring panel before plugging the wiring panel onto the logger.
4.5.1 Wiring Sequence

Pass sensor wires through the black plastic grommets in the bottom of the shelter box.

All wires coming down the tower and into the shelter box should be secured to the tower below the shelter box and then brought back up, to form a drip-loop, before entering the shelter box.

Sensor wires should be stripped to expose only 5 mm (1/4 inch) of bare wire. Stripping off more insulation could allow the wires to touch and cause an electrical short. If using standard NRG Systems sensor cables, you may need to trim off some of the exposed wire.

Note - Labeling sensor wire ends with either the sensor name or its intended channel number during sensor installation will minimize confusion and speed up the wire connection process. Connecting the bottom row of sensors to the wiring panel first may make installation easier.

Connect sensor wires to the field wiring panel according to the connection diagram (see below) using the following sequence for each sensor:

1. Touch the shield wire to the wiring panel’s grounding post, and connect it to the SHD (shield) terminal.
2. Connect the sensor ground wire (typically black wire) of the sensor to the “GND” terminal of the appropriate channel’s input.
3. Connect the signal (white or clear) wire to the “SIG” (signal input) terminal.
4. For sensors with three terminal ONLY (such as vanes or anemometers requiring 2.5 V, 5 V, or 12 V power), connect the red wire (excitation/power) to the “EXC” terminal.

After all sensors and the logger have been connected to the wiring panel:

- Confirm correct wiring by reviewing each sensor channel on the logger’s display.
- Coat the wiring panel’s terminal screws with an anti-corrosive product (such as PreserveIT P100L from Caig Labs or Vaseline petroleum jelly).
- Once you have completed wiring, use plumber’s putty to seal around wires entering the shelter box.
4.5.2 Connection Diagram

Ch. 1-12 Counters

NRG 40C Anemometer (Ch. 1-12)

Sensor Wire  Logger

Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

NRG Class 1 (Ch. 1-12)

Sensor Wire  Logger

Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

NovaLynx Rain Gauge (Ch. 1-12)

Sensor Wire  Logger

Bk  Gnd  GND  GND  GND
Red  Exc  Exc  EXC  EXC
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

NRG IceFree3 (Ch. 1-12)

Sensor Wire  Logger

Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

Vector A100 (Ch. 1-12)

Sensor Wire  Logger

Red  Exc  Exc  EXC  EXC
Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

WindSensor P2546A or P2546C (Ch. 1-12)

Sensor Wire  Logger

Bk  Gnd  GND  GND  GND
Red  Exc  Exc  EXC  EXC
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

Thies First Class Advanced (Ch. 1-12)

Sensor Wire  Logger

Bk  Power  EXC  EXC  EXC
Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

RM Young 06103 (Ch. 8-9)

Sensor Wire  Logger

W3  REF  EXC  EXC  EXC
W3  SHD  SHD  SHD  SHD
W3  SHC  SHC  SHC  SHC

NRG 40H (Ch. 1-12)

Sensor Wire  Logger

Red  Exc  Exc  EXC  EXC
Bk  Gnd  GND  GND  GND
Wh  Sig  Sig  SIG  SIG
Sh  SHD  SHD  SHD  SHD

Note: Flat head Screwdriver needed for installation
Ch. 13-15
Analog 2.5V or 5V EXC

NRG 200P (Ch. 13-15)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

NRG 200M (Ch. 13-15)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

Thyes 10k or 2k (Ch. 13-15)

Sensor Wire

Logger

GND

GND

Shield

Vector W200P (Ch. 13-15)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

NRG 1105 Temp Sensor (Ch. 13-19)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

NRG BP20 (Ch. 16-19)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

Delta-T SPN 1 (Two outputs: GHI and DIF) (Ch. 16-19)

GHI Output

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

DIF Output

Sensor Wire

Logger

Red

GND

GND

Shield

Generic 0-5V Signal (Ch. 16-19)

Sensor Wire

Logger

Red = Power

GND

GND

Shield

RH-5X Relative Humidity Sensor (Ch. 16-19)

Sensor Wire

Logger

Red = Excitation

GND

GND

Shield

Page 2 of 4
Ch. 20-26 Analog P-SCM
Part 1 of 2

NRG 110S Temp Sensor (Ch. 20-26)

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9130

NRG BP20 (Ch. 20-26)

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9131

Vector W200P (Ch. 20-26)

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
Grn $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9133

Delta-T SPN1 (Two outputs: GHI and DIF) (Ch. 20-26)

GHI Output

Sensor Wire Logger
Red $ Excitation $ EKC
Grn $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9132

DIF Output

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9132

Generic 0-1V Signal (Ch. 20-26)

Sensor Wire Logger
Red $ $ $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9132

NRG 200P (Ch. 20-26)

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9130

NRG 200M (Ch. 20-26)

Sensor Wire Logger
Red $ $ $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9130

Thies 10k or 2k (Ch. 20-26)

Sensor Wire Logger
Grn $ Power $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9133

RH-5X Relative Humidity Sensor
(Ch.20-26)

Sensor Wire Logger
Red $ Excitation $ EKC
Blk $ Ground $ GND
WH $ Signal $ SBS - SBD
Shield $ $ $ 

P-SCM Web Item # 9132

Note: Flathead Screwdriver needed for installation

Page 3 of 4
Ch. 20-26 Analog P-SCM
Part 2 of 2

LI-COR LI-200SZ Pyranometer [Ch. 20-26]

Sensor Wire | Logger
---|---
Bare Wires | EXC
Wht | GND
Blu | SIG
Gnd | SHD

P-SCM Web Item # 9129

LI-COR LI-200R Pyranometer [Ch. 20-26]

Sensor Wire | Logger
---|---
Blu | EXC
Wht | GND
Grn | SIG
Bare (Shielded) | SHD

P-SCM Web Item # 9129

Kipp & Zonen CMP3, CMP10, CMP11 [Ch. 20-26]

Sensor Wire | Logger
---|---
Red | EXC
Blu | GND
Wht | SIG
Grn | SHD

P-SCM Web Item # 9128

RM Young Vert Prop 27106 [Ch. 20-26]

Sensor Wire | Logger
---|---
Terminal B | EXC
Terminal A | GND

P-SCM Web Item # 9134

Generic 0-20mA Signal [Ch. 20-26]

Sensor Wire | Logger
---|---
Blk | EXC
Wht | GND

P-SCM Web Item # 9137

Hukseflux SR11, SR12, and SR20 [Ch. 20-26]

Sensor Wire | Logger
---|---
Wht | EXC
Grn | GND
Blk | SIG

P-SCM Web Item # 9128

Hukseflux LP02 (Two options: Fixed or Detachable Cable) [Ch. 20-26]

Fixed Cable

Sensor Wire | Logger
---|---
Wht | EXC
Grn | GND
Blk | SIG

P-SCM Web Item # 9128

Detachable Cable

Sensor Wire | Logger
---|---
Wht | EXC

P-SCM Web Item # 9128

Note: Flat head Screwdriver needed for installation
4.5.3 Install in Shelter Box
To install the assembled SymphoniePRO logger and iPack to the shelter box, insert the shelter box’s mounting screws through the holes in the hanging bracket and slide down to secure. Tighten the screws before leaving the installation site.

4.5.4 Connecting Wiring Panel to Logger
For the SymphoniePRO-26 wiring panel, connect the 62 pin cable assembly connector to the logger. It should be securely screwed down using the thumb screws. Protect the pins by aligning the connector well before inserting, and avoid plugging in the connector at an angle. Once it is secured to the logger, plug it into the wiring panel.

For the SymphoniePRO-16 wiring panel, no cable assembly is required; directly connect the wiring panel to the DB62 connector on the logger.
4.5.5 Connecting PV Panel to iPacK
Connect the blue PV wire to the iPacK’s ground (-) terminal, and connect the red wire to the iPacK’s (+) terminal.

4.6 LOGGER START UP
If you haven’t already done so, install the logger’s D-cell batteries and verify the logger and iPacK configurations and sensor settings as described below.

4.6.1 Checking Logger Status
Logger Status (viewing the number of saved files, firmware version, and SD card capacity) can be checked through the logger’s Functions menu [Home][2][1][1]. Voltage information and logger internal temperature can be viewed through the Diagnostics menu [Home][2][1][2]. The Utilities menu [Home][2][1][3] can be used to format the SD card, adjust the display contrast, and turn the display off.

The logger may beep if there are sudden changes in current. The 12 V sensor supply current can be seen in the status line of the logger’s display.

4.6.2 Checking Logger Measurements
Once the SymphoniePRO logger is programmed, sensor readings and settings can be reviewed in the logger’s Measurements menu [Home][1] by scrolling through each channel using the [Up] and [Down] arrow keys. Pressing the [Right] arrow key provides additional channel information such as raw instantaneous measurement, measurement height, and angle of installation.

Disabled channels will be skipped over, and channels can be directly accessed with numeric keys.

4.7 CHECKING IPACk STATUS
iPack menu functions [Home][2][2][2] include Connection Test (MetLink Initiate, MetLink Listen, MetLink Diagnostics, Send via eMail, and Send via FTP), Connection Status (Modem Status, Network Status, MetLink Status, and eMail Status), Shut Down, GPS Status (latitude, longitude, and altitude), Provision CDMA, and Modbus Status. Within the Connection Test menu, various connection-related actions can be selected. After selecting an action, pressing the [Right] arrow key provides status information (Modem Status, Network Status, MetLink Status, and Email Status). These same status information screens are also available through the Connection Status menu function [Home][2][2][2].

Caution

Test calls/data connections should always be performed both before and after installing an iPacK in the field.

If no iPacK is connected, or if a connected iPacK has a dead battery, no “i” icon will be displayed, and “iPacK unavailable” will be shown on the logger’s screen. If an iPacK is connected and powered up, the iPacK activity icon will show on the logger’s display to indicate the iPacK is on, and an icon indicating iPacK 12 V battery status
will also be shown in the lower right corner of the logger’s display. Without an iPack connected, the battery icon represents the D-cell batteries.

The **Recent Events** screen ([Home][2][4] lists events for the SymphoniePRO logger and iPack including firmware updates and clock adjustments. The [Up] and [Down] arrow keys can be pressed to scroll through numbered logger and iPack events. The most recent events are displayed first. Using the numeric keypad, the user can enter a number to jump to a particular event. A comprehensive list of SymphoniePRO logger events and iPack events and their definitions can be found in the Troubleshooting section ([Appendix B]) of this manual.

### 4.8 DATA VERIFICATION

SymphoniePRO can be configured to send both statistical data and raw sampled data. *.RLD files contain averages of the raw counts, voltages, and currents (at the specified averaging interval), channel configuration information, logger events, and logger and iPack diagnostic information. If the logger is configured to collect raw sampled data, 1 second sampled channel measurement data will also be included in the *.RLD file. However, 1 second sampled data must be processed separately using **Process Raw Sample Data** in the Site menu.

After performing a test connection, download *.RLD files and browse to the folder where raw (*.RLD) files are stored, and double click to open a few of them using QuickView to make sure data stored on each channel looks normal.
4.9 BEFORE LEAVING SITE CHECKLIST

- Desiccant
- Battery levels
- Sensor connections verified
- Sensor currents verified
- Change SD card
- Grounding
- Access/keypad lockout code and encryption code written down
- Saved configuration file

4.10 SITE VISITS

4.10.1 Recommended Tools and Supplies

- diagonal wire cutters to trim sensor wire leads
- wire strippers to strip sensor cables if necessary
- 7/16 inch nut driver or wrench
- 5/16 inch nut driver for hose clamps, mounting screws (PV and logger)
- ½ inch crescent wrench to tighten ground acorn nut
- ¼ inch nut driver for sensor terminals
3/8 inch nut driver or wrench for ground stud nut
- electrical tape
- small flat blade NRG screwdriver (included with logger) for sensor wires
- Phillips head screw driver for mounting plate, PV terminals, iPack screws
- drill to tighten hose clamps - optional
- tin snips to cut excess hose clamp and ground wire – optional
- extra desiccant pack

4.10.2 Routine Site Visit Checklist
A routine site visit should include the following activities:

1. Check sensor readings to assess sensor condition. Readings that vary widely with expected norms may indicate a sensor malfunction. Press [Home][1], then [Up] or [Down] to scroll through the sensors.

2. Check the logger’s clock (time and date are displayed at the bottom of the home menu screen). Correct the clock, if needed (remember the clock is set to Standard time). Loggers connected to an iPack that is configured for Time Service will be automatically updated via SNTP or GPS; there should be no need to adjust the clock manually.

3. Press [Home][2][1][2] to view internal and iPack battery voltages and 12 V sensor current level. Press the [Right] arrow key to view the D-cell battery voltage and additional internal diagnostic voltage readings. Press the [Right] arrow key again to view analog reference voltages.

4. If D-cell battery status shows low battery voltage, replace D-cell batteries one at a time. Use only alkaline D-cells, IEC type LR20. If the iPack battery is low (i.e. below 11 V) but it is under 2 years old, contact NRG Systems for troubleshooting assistance. Please be prepared to provide all diagnostic voltage and current readings. If the iPack battery is low and the battery is more than 2 years old, it may need to be replaced.

5. If an SD card is installed, pull the SD and label it with the date and site number. The SD card should not be pulled while the SD card is being accessed by the iPack (the SD card icon will be animated).

6. Insert and format a new SD card [Home][2][1][3][1].

7. Check SD card status [Home][2][1][1].

8. If any condensation is noticed inside the enclosure, replace the desiccant pack with a fresh one from a sealed package.

4.10.3 Cleaning
If it should become necessary to clean the SymphoniePRO data logger, use a cloth slightly dampened with water and wipe clean. Do not use solvents. Never submerge the unit.
5.1 Home Screen – Fleet View

5.1.1 Map Pane

The map pane shows all of the sites with valid latitude and longitude information as pinpoints on a map (satellite view). The map may be navigated by using the mouse to pan (click and drag) and zoom (scroll), but custom zoom locations are lost whenever the screen is exited. The pane may be adjusted in height by dragging the intersection of the bottom of the map and the top of the site list. The pane may be hidden entirely by right-clicking anywhere on Home screen and choosing **Hide Map.** **Hide Map** can also be selected from the **Options** menu. The hide map setting is saved and is persistent across sessions.

Double clicking a site pinpoint will bring the user to the site screen for that site. Single clicking on the site causes the corresponding site row to become highlighted, allowing the user to locate a site in the list using the map. Hovering over the pinpoint shows the same information for the site (Site, Location, Last Connection, etc.) as shown below in the site list.

5.1.2 Site List

The site list shows the valid site database files found by the software. When a connection is detected, the logger **Connection Status** icon for the site corresponding to the equipment turns green.

<table>
<thead>
<tr>
<th>Project</th>
<th>Location</th>
<th>Instrumentation</th>
<th>Start</th>
<th>Last Connection</th>
<th>Next Connection</th>
<th>Connection Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SymPro Alpha Testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>SymPro Alpha Testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>Sym Pro testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>SymPro Alpha Testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>Test Support Test 10</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>Test Support Test 10</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>Test Support Test 10</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>Test Support Test 10</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>SymPro Alpha Testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
<tr>
<td>SymPro Alpha Testing</td>
<td>[Location]</td>
<td>[Logger SN]</td>
<td>[Date]</td>
<td>[Time]</td>
<td>[Date]</td>
<td>[Time]</td>
</tr>
</tbody>
</table>
The upper right corner of the logger connection icon may show a small lock to identify the logger as locked or a clock symbol to indicate that automated actions are enabled. If there is no existing site or multiple sites corresponding to the connected equipment, then a new site row is created as a “new instrument row” for accessing the connected equipment.

Each site row contains multiple columns of information relevant to the high level management of the site or equipment. The rows may be sorted by the user by any of the columns, and the order of the columns can be changed by dragging the column header. The tooltip for each row contains the full path and file name for the associated site file (if applicable) as well as the connected logger serial number (if applicable).

This allows the user to always uniquely identify any row in the list. Right-clicking on any Project site in the Fleet View list provides the option to edit the site’s remote connection settings, view site or logger information, delete the site, refresh the site list, hide the map, or display the connection times using the PC’s local time (instead of the site’s local time).
**Project**
This column contains the project name for the site. This is listed as the first column as it is intended to be used in sorting to group related sites together.

**Location**
This column contains the site number, site name, and site location.

**Instrumentation**
The Instrumentation column contains the serial numbers and firmware versions of the site’s logger and iPack.

**Data**
This column contains the start date and end date for the data in the database. The start date represents the earliest timestamp (and the end date represents the most recent timestamp) of any data point for that site.

**Last Connection**
The Last Connection column indicates the last date and time that a connection was made. The iPack battery voltage at the time of the connection is also displayed. By default, the connection time is shown in the logger’s local time.

**Next Connection**
The Next Connection column indicates when the next remote connection opportunity or attempt is expected, along with the connection type and duration (e.g. Connected: USB, Listens Continuously, Listens for [<60] min, Listens for [≤ 12] hours, MetLink Logger Initiated.) By default, the connection time is shown in the logger’s local time. The next connection time and type is based on the communication schedule settings, which are stored in both the site file and logger.

**Connection Status**
The logger connection icons above are shown in the Connection Status column and indicate the status of connections for sites already established in SymphoniePRO Desktop Application. Active connections are displayed in green. Clicking on an inactive connection icon will attempt to establish a connection. Putting the cursor over the green icon will display the connection type, and clicking the icon during an active connection brings up more detail on the connection status and provides a disconnect button to terminate the connection. If automated data file downloads or firmware upgrades are enabled, the icon will show a small clock symbol in the upper right corner. A small padlock symbol will be shown in the lower left corner if the logger is locked.

Double-clicking a site from the site list opens the Site Utilities screen for that site if the logger is not currently connected. If the logger is connected, the Logger screen will open.

**MetLink Monitor**
The MetLink Monitor is a small application which runs in the background and can be viewed from the Windows system tray (notification area at lower right of your computer screen).
The monitor starts when SymphoniePRO Desktop Application is launched and closes when the main application closes. The MetLink Monitor acts as an interface which manages connections between the main application and connected loggers. The MetLink Monitor icon looks like two arrows which symbolize two way communications.

The MetLink monitor can be used to view the status of active logger connections. The monitor contains information similar to what can be found on the **Home Screen - Fleet View** screen (Site Number, 12 V battery voltage) and **Logger** screen (Site Description, Logger Serial Number), and **iPack** screen (iPack Serial Number and Firmware Version) in SymphoniePRO Desktop Application.

### 5.1.3 Application Update Notifications

An orange box with a flag will appear to the left of the **File** menu in the upper right corner of the SymphoniePRO Desktop Application screen if there are any new iPack or logger firmware revisions that have not been downloaded to your PC yet or if there is a software update available.
Clicking on the flag opens the SymphoniePRO Application Updates window, which can also be accessed at any time by clicking Help>Application Updates. This window displays the iPack and logger firmware versions and software updates available to download.

Press the download button next to any of the firmware options, and it will download to the Firmware path on your PC. A link to the firmware folder will appear after the download is complete. It is important to keep firmware up to date on all loggers and iPacks for the best functionality. Descriptions of ways to upgrade the firmware on a logger and iPack are given in sections 3.1.5, 3.4.3, 5.3, and 5.6.

5.1.4 File Menu

The File menu is in the upper right corner of every SymphoniePRO Desktop Application screen. The Create Instrument Configuration File (*.LGR) and Edit Instrument Configuration File (*.LGR) options are only accessible from the Fleet View screen.
Import Raw Logger Data Files (*.RLD)

The Import Raw Logger Data Files (*.RLD) selection [File> Import Raw Logger Data Files (*.RLD)] opens a dialog box and allows selection of one or multiple *.RLD files for import to the database. *.RLD files contain both statistical and raw 1-second data (if utilized).

If files from a site have not been previously imported, a message will appear asking if you want to create a site file.

A progress bar is displayed showing the files as they are imported:
During the import process, other messages may be received such as requests to enter an encryption key or create a new sensor history entry when a change from a prior configuration is detected. When the import is completed, the software will display this screen:

![Import Complete Screen]

**Settings**

The **Settings** selection (from the home screen **File>Settings**) brings up a screen to configure the working directories for Site Files, Exports, Logs, Raw Logger Data Files, Reports, and Firmware Files. These paths are the locations on your computer that the software will point to when saving or opening these different types of files. You will see the working directory path and can either edit the path or browse to a new location by clicking on the box with three dots to the right of the path field. The **Open Folder** button next to each field allows you to open the current directory location.
The **Settings** window also has an option to change the language displayed in the software. The default language is English. Other available languages are Chinese, Spanish, and Portuguese. To change the language, select it from the drop-down list.

**View Application Log**
The File>View Application Log selection opens a text log file which tracks the user’s interactions with SymphoniePRO Desktop Application. The **View Application Log** is a diagnostic tool that can be helpful in troubleshooting software error messages. The log opens in your designated text editor (e.g. Notepad or WordPad) and can be saved as a text file and emailed to NRG Systems Technical Support.

**Create Instrumentation Configuration File (*.LGR)**
The File>Create Instrumentation Configuration File (*.LGR) selection opens the Instrument Configuration File Editor. This feature allows Logger, Channels, Schedules, and iPack settings to be preconfigured and saved into a file without being connected to a logger. Creating configuration files in this way can be useful for sharing similar settings across multiple SymphoniePRO systems.
Press **Save File** to save the configuration as an *.LGR file that can be loaded onto a logger at a later time (see Section 5.1.8).

**Edit Instrumentation Configuration File (*.LGR)**

The File>**Edit Instrumentation Configuration File (*.LGR)** selection allows editing of an existing configuration file in the **Instrument Configuration File Editor** without being connected to the logger.

**5.1.5 Options Menu**

The **Options** menu is in the upper right corner of SymphoniaPRO Desktop Application’s home screen. These options may also be accessed by right-clicking anywhere on the **Fleet View** screen.

**MetLink Initiate**

The **MetLink Initiate** selection (Options>**MetLink Initiate**) allows the user to enter an IP address for a MetLink Logger Listening connection to any site and use the **Connect** button to establish the connection. This connection type requires the iPack have a SIM card with a public static IP address, and for the logger to be scheduled for
MetLink Logger Listening at the time the connection is initiated. The following screen will show when MetLink Initiate is selected:

![Remote Connection](image)

**Refresh Site List**

The Refresh Site List selection (Options>Refresh Site List) reloads all information from site files and detects any changes to a site or addition of a new site.

**Hide Map**

The map pane may be hidden entirely by the user by right-clicking anywhere in the home screen and selecting Hide Map, or by selecting Hide Map from the Options menu (Options>Hide Map). The map will remain shown or hidden each time the software is used until the user changes it.

**Export Site List**

The details for all sites shown on the Fleet View can be exported to .txt file by selecting Export Site List from the Options menu or by right-clicking anywhere on the Fleet View screen and selecting Export Site List. The default location for the exported site list file is the Export folder.

**5.1.6 Help**

The Help menu is in the upper right corner of every SymphoniePRO Desktop Application screen.
**About**

The software version can be found by selecting **About** in the **Help** menu (**Help>**About**). A link to the NRG Systems website (where the latest user’s manual and firmware updates can be found) is on the same screen. The Comm Version refers to the piece of the software that controls communications operations. NRG Systems Technical Support may request this information for troubleshooting purposes. Links are available to copy the **About** window to an image or text, which can be sent to NRG Systems Technical Support if you need any help with the software.

**Save Communication Log**

The **Save Communication Log** selection opens a window to choose a file name and location to save a communication log. The communication log is a diagnostic tool that can be helpful in troubleshooting communications problems between the software and the connected equipment. The communication log is saved as an encrypted text file and can be emailed to NRG Systems Technical Support for troubleshooting purposes.
**Application Updates**

The **Application Updates** selection opens the **SymphoniePRO Application Updates** window, which displays available software upgrades to download and install.

![SymphoniePRO Application Updates](image)

5.1.7 Site

The **Site** menu is in the upper right corner of the Site Utilities, Timeline, Logger, Channels, Schedules, and iPack screens.

**Process Raw Sample Data**

The Process Raw Sample Data selection [Site>Process Raw Sample Data] converts 1 second raw sample data within the *.RLD files to text files. Raw sample data are scaled according to scale factors and offsets in the site database.

![Process Raw Sample Data](image)

*Note - The Process Raw Sample Data function is specific to 1 second data samples. Statistical data are processed separately using Data Import and Data Export (Site Utilities screen).*
After file conversion is complete, the name of the text file appears at the bottom of the window, and clicking it opens it in your default text editor. Clicking **Open folder** shows where the *.txt file is stored.

![Image of Process Raw Sample Data window showing conversion complete message](image)

If the selected files or site contains no raw sample data, the conversion will fail and an error message is displayed:

![Image of Process Raw Sample Data window showing conversion failed message](image)

If the files you are attempting to convert are from a site that does not match the site you are currently working in, this message will be displayed:

![Image of File from wrong site window](image)
5.1.8 Logger

The Logger menu is in the upper right corner of the Site Utilities, Automation, Timeline, Logger, Channels, Schedules, and iPack screens. A logger must be connected to the PC, either by USB or through a remote connection, to access the Logger menu.

Load Instrument Configuration File (*.LGR)

The Load Instrument Configuration File (*.LGR) selection allows the user to browse to and load into SymphoniePRO Desktop Application an existing configuration file that includes logger settings such as site number, location, time zone, reporting period, plus the configuration of each channel.

Save Instrument Configuration File (*.LGR)

The Save Instrument Configuration File (*.LGR) selection allows the user to save a configuration file. The configuration file includes logger settings such as site number, location, time zone, reporting period, plus the configuration of each channel. If changes have been made to the configuration, SymphoniePRO Desktop Application will display that there are unsaved changes to the logger as shown below:

Save All will save changes across all screens; Discard All will discard changes across all screens. Choosing Load From Logger or Cancel will also cause settings to revert to their original state (changes won’t be saved).

After saving changes to the logger, use to save a copy of the configuration file to your PC. It is strongly recommended to save copies of all *.LGR files.
**View Recent Events**

SymphoniePRO generates events that can be helpful in troubleshooting. Recent Events can be viewed by selecting [Logger > View Recent Events] while connected to the logger via USB or MetLink. Events are timestamped and include both an event type and some descriptive text.

![Recent Events Table]

**Mark Files as “Sent”**

Marking files as sent prevents them from being retrieved from internal memory and written to the SD card or sent via iPack. Common uses for this feature include:

- You want to send only new data files after a particular commissioning start time/date (to avoid sending data from before sensors were connected, for example);
- A logger is being installed with a new site number, and you wish to avoid sending existing files with the previous site number from the logger to the SD card or via iPack;
An iPack is installed on a logger that has been operating as a stand-alone system, and you do not want to send all existing files via the iPack.

Marking files as sent will not delete them. However, once the logger’s internal memory is full, it will overwrite the oldest internally stored data first (circular buffer), regardless of whether or not they have been marked.

### 5.2 Site Utilities

The **Site Utilities** screen allows the user to view and edit basic site database properties, save the data encryption password for the site to the site database, and perform standard data export functions.
5.2.1 Data Export

Data export controls exporting of data files from the site file into a common text file format that can be easily processed by third-party data analysis tools or viewed in a text editor. The Export Type defines what type of data (measurements, logger diagnostic information, logger communication history log, or logger events history log) are exported when the Export button is clicked.

The start and end dates define the data to be exported by a time range. By default, these are blank, which provides an easy way to export all data. The start and end dates of exports have a 1 day resolution (rather than hours, minutes, or seconds).

Details related to data export formats can be found in Appendix M.

5.2.2 Site

The Site section of the Site Utilities screen describes details about the site’s location (for example, “West Ridge”, which is a more specific description than the town in which the site is located). The Description field holds up to 20 text characters. The Project field holds up to 20 text characters and can be used for a brief description of the project (for example, “Windy Wind Farm”). The Tower field describes the type of monitoring tower on which the instrumentation and sensors are mounted (“NRG 60 m XHD Tubular”, for example). The Tower field appears only in the SymphoniePRO Desktop Application and does not exist in the logger or in the data set generated by the logger. The Commission Date is the date the site began collecting data. Data imported before this date will be filtered out.

Units may be set to SI (metric) units only. The Units setting defines how wind speed data are scaled upon export or in charts and reports.

5.2.3 Data Import

The Import button allows you to select and import raw data files into the site database.

5.2.4 Location

The Location section of the Site Utilities screen describes the site’s location. The Description field holds up to 20 text characters (for example, “Springfield, Vermont”). The latitude and longitude are entered in decimal degrees with precision to 7 decimal places. Elevation of the site is entered in meters. The latitude, longitude, and elevation will update automatically according to the GPS coordinates from the *.RLD files. By checking the Lock Location check box, coordinates in the *.RLD files can be ignored and will lock the coordinates in the Latitude, Longitude and Elevation fields instead of automatically updating them.

The time zone of the location is entered relative to UTC with up to ¼ time zone resolution (for locations where the adjacent time zones are ½ and ¼ hour difference rather than 1 hour).
5.2.5 Data Encryption Password

The Data Encryption Password section of the Site Utilities screen controls the enabling and disabling of data encryption. The password is entered as a text string of up to 20 characters. The characters are displayed as ‘*’ when entered. The password stored in the SymphoniePRO Desktop Application must match the password stored in the logger in order to decrypt data.

5.3 Automation

The Automation screen is used to select actions to be automatically performed during the next remote MetLink connection. File handling processes such as retrieving all unsent files and importing all retrieved files can be automated rather than manually retrieving data files using the Logger screen or importing data files from the Site Utilities screen. Firmware upgrades to the logger and iPack can be performed automatically using settings on the Automation screen rather than manually using the Logger or iPack screens.

Automation functions will not be initiated with a USB MetLink connection, nor will automation functions be initiated if they are already in process as the result of an existing MetLink connection by another user. Logger or iPack firmware upgrades can also be automated from this screen rather than performed manually from the Logger or iPack screens. Once the chosen automated processes have been run, the MetLink connection can be set to terminate automatically.
When connecting to the site, the Connection Status will indicate progress of automated actions.

<table>
<thead>
<tr>
<th>Start</th>
<th>End</th>
<th>Voltage</th>
<th>Connection Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>12/27/2013</td>
<td>12/28/2013</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10/29/2014</td>
<td>03/30/2015</td>
<td>13.9 V</td>
<td></td>
</tr>
<tr>
<td>2015-03-31</td>
<td>14:59</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Once automated actions have been completed, putting the cursor over the Connection Status “Completed Automation Actions” will display a summary of the automation actions.

5.4 Timeline

The Timeline screen is used for viewing and editing all time based site metadata. Many different data sources are shown chronologically alongside each other in this view in order to provide a comprehensive picture of what has happened to the site over the course of its service life.
The top pane of the timeline screen provides a simple visual summary of available data and acts as the zoom and pan controls for the displayed date range. A solid bar indicates no gaps in data. Dates for which no data files have been imported are represented by blank spaces. The user can define a specific date range to view by dragging the blue date selection handles or by zooming in or out by scrolling. Large amounts of information can easily be viewed to find problem areas and quickly make adjustments to fix data export issues or diagnose strange sensor behavior.

Unused channels can be hidden using the Hide Empty Channels checkbox.

**Files**

When the Files row is selected, file information is displayed in the pane on the right side of the screen. Details can be viewed for “All Dates” or for “Current Selected Dates.” The file name, size of the data file, start and end dates, and number of associated data points, events, and communication logs are displayed. Double clicking an *.rld file box will open the file in a QuickView window (described in section 5.10). The *.rld file must be stored in the Raw Logger Data Files Path defined in Settings to be viewed this way.

**Events**

SymphoniePRO logs all types of events and records them in the data stream. A history of fault events and user actions is recorded for each site. When the Events row is selected, the full details for that item are listed in the pane on the right side of the screen. SymphoniePRO events are classified as faults, actions, or information. Further details like error codes provide supplemental information that can be helpful in troubleshooting. See Appendix B for more details.

**Comm.**

When the Comm. row is selected, communication information is displayed in the pane on the right side of the screen. Details can be viewed for “All Dates” or for “Current Selected Dates.” The operator (carrier), signal strength, connection duration, and bytes of information transmitted and received and the timestamp of the communication are shown and can be exported with the Export button at the bottom of the window.
**Note**
The Note field allows comments to be entered related to a particular date. For example, if a sensor is swapped out, or the SD card is pulled, a note can be entered for the date the action occurred.

**Channels**
When a sensor channel is selected, sensor history information is displayed on the right side of the screen. Details can be viewed for “All Dates” or for “Current Selected Dates.”

Right clicking on a sensor channel row will present the option to **Edit**, (through the **Edit Sensor History** screen), **Delete**, or **Create New Sensor History** (through the **Add Sensor History** screen). Double clicking a sensor channel row will open the **Edit Sensor History** screen.

**Edit Sensor History** allows the values to be modified and saved back to the site file. The effective date and time of the change can be entered, and the **Accept** button saves the changes into the site history. This is used when the sensor details were incorrectly programmed into the logger or saved in the site file.

**Add Sensor History** is used when a sensor on a particular channel is replaced or when its orientation on the tower has been changed. For example, if a sensor is changed and the new scale factor and offset are not entered in the logger, the correct scale factor and offset can be entered in the timeline with the date and time of the change so that the correct scaling is applied from that time forward.
5.5 REPORTS

The Reports screen has options for creating data reports.

To generate a Summary Report, select the desired date range for reporting in the Start Date and End Date fields in the top left corner of the screen. The dates are defaulted to the first and last day of the most recent complete month. Press the Load Report button to generate a report. The report will appear on screen.

After one report is generated, it can be changed by entering new start and end dates and pressing the Refresh button.

The report viewing window has vertical and horizontal scroll bars, as well as a zoom bar and zoom drop-down menu on the bottom right. If the report has multiple pages, use the arrows or the page number box at the top left to navigate through the report.
For each channel, the **Summary Report** contains the following information, based on how the channels were programmed and the data collected over the selected time range: sensor height, units of collected data, average value, minimum and maximum 10-minute average values and their times of occurrence, average 10-minute standard deviation values, maximum 1-second sample value and its time of occurrence. In addition, the report contains the average turbulence intensity (TI) for each wind speed channel, the prevailing (most frequent) wind direction sector for each wind direction channel, and total for any totalizer channel. Note that no maximum or minimum values are listed for wind directions, because these statistics are not meaningful in the context of direction.

If a channel configuration was changed during the reporting period and the units remained the same, then the summary statistics are derived from a dataset that includes data from before and after the change. The channel number will have an asterisk next to it to indicate that a configuration change occurred. If a channel configuration was changed during the reporting period and the units changed, then the report will contain separate rows for the channel before and after the unit change.
Reports can be exported to PDF or TIFF files by pressing Export Current, which opens the Export Report window. Select Monthly to export a single or multiple reports using data from complete months. If you select a range of months, a separate report will be generated for each month. To specify a different date range, select Date Range and enter the desired dates in the Start Date and End Date fields. By default, these dates will be the same as the start and end dates for the currently displayed report. Use the File Type drop-down to select either PDF or TIFF.

After pressing Save, the report(s) will be saved in the Reports Path specified in File->Settings. Links to the report file (for a single report) and the Reports folder will appear under the Export Current button.

5.6 LOGGER

All SymphoniePRO logger settings are configured through the software’s Logger screen via remote or USB MetLink connection. The configuration procedure and the Memory, Site, Location, Configuration, and Security sections of the Logger screen are described in detail in Chapter 3.

If the PC you are using is not currently connected to the logger, or if it has never connected to the logger either by remote or USB MetLink connection, then the Logger screen cannot be accessed.
If the PC is not currently connected to the logger but has previously connected (while running SymphoniePRO Desktop Application version 2.0 or newer), the logger settings from the most recent connection will appear in a read-only format on the Logger screen. The date and time when this information was saved is listed under Date Cached on the bottom of the left sidebar.

**Data Retrieval**

The Retrieve By Date Range button in the Data Retrieval section retrieves files via remote or direct (USB) MetLink connection from the internal memory and saves them to the Raw file folder. Dates of available data range are shown; leave dates blank to retrieve all available data files. If the end date is blank, the current day’s data file will be closed so that all data up to the last sample interval will be retrieved.

When retrieving data, there are options to not retrieve files that already exist in the raw data folder and to immediately import the retrieved files into the site file.

Note that if no SD card is present, data will be saved to the internal memory, and the Memory section of the Logger screen will indicate “Internal” instead of “SD Card”:

![Data Retrieval](image)

![Memory](image)
**Configuration**

The **Upgrade Logger Firmware** button in the **Configuration** section allows you to browse to wherever the latest firmware version is stored on your PC. Select the firmware version, and click **Start Upgrade** to begin the process.

---

**Configuration**

<table>
<thead>
<tr>
<th>Serial Number:</th>
<th>820600044</th>
</tr>
</thead>
<tbody>
<tr>
<td>Model:</td>
<td>SymphoniePRO (8206)</td>
</tr>
<tr>
<td>Ref Time:</td>
<td>2015-12-09 16:01:32</td>
</tr>
<tr>
<td>Logger Time:</td>
<td>2015-12-09 16:01:34</td>
</tr>
<tr>
<td>Firmware Version:</td>
<td>1.1.0</td>
</tr>
<tr>
<td>Hardware Version:</td>
<td>Rev A</td>
</tr>
<tr>
<td>Manufacture Date:</td>
<td>2014-01-21</td>
</tr>
</tbody>
</table>

---

**Upgrade Logger Firmware**

- **Current Version:** 0.70.0
- **New Version:** 0.70.0

**Upgrade Status**

- 15:11:01.336: Starting logger firmware upgrade to version 0.70.0
- 15:11:02.340: Clearing firmware filesystem
- 15:11:08.085: Transferring 8348_SymPRO-Logger_v0.70.0.fw
- 15:11:06.365: Sent 0% of firmware file
- 15:11:39.513: Sent 25% of firmware file

---

**5.7 CHANNELS**

The SymphoniePRO logger’s sensor channels are configured through the software’s **Channels** screen via remote or USB MetLink connection. The configuration procedure and functions related to the Channels screen are described in Chapter 3.
If the PC you are using is not currently connected to the logger, or if it has never connected to the logger either by remote or USB MetLink connection, then the **Channels** screen cannot be accessed.

If the PC is not currently connected to the logger but has previously connected (while running SymphoniePRO Desktop Application version 2.0 or newer), the channel settings from the most recent connection will appear in a read-only format on the **Channels** screen. The date and time when this information was saved is listed under **Date Cached** on the bottom of the left sidebar.

### 5.8 SCHEDULES

The connection schedules are configured through the software’s **Schedules** screen via remote or USB MetLink connection. The different connection types and configuration procedure related to the Schedules screen are described in [Chapter 3](#).

If the PC you are using is not currently connected to the logger, or if it has never connected to the logger either by remote or USB MetLink connection, then the **Schedules** screen cannot be accessed.

If the PC is not currently connected to the logger but has previously connected (while running SymphoniePRO Desktop Application version 2.0 or newer), the schedule settings from the most recent connection will appear in a read-only format on the **Schedules** screen. The date and time when this information was saved is listed under **Date Cached** on the bottom of the left sidebar.

### 5.9 IPACK

The iPack is configured through the software’s **iPack** screen via remote or USB MetLink connection. The configuration procedure and functions related to the iPack screen are described in [Chapter 3](#).

### 5.10 QUICKVIEW

Double-clicking a data file in the Raw file folder will open the QuickView window and display a snapshot of data for each sensor.
The table in the QuickView window has a row for each enabled channel’s data as well as the iPack battery voltage. Use the mouse or cursors to select a row of data to be displayed as a time series graph in the top half of the window. To select multiple rows of data to view at once, hold the left button of the mouse down while dragging over a series of rows, or use the Shift or Ctrl keys.

5.10.1 File

The **File** menu of the **QuickView** window contains options to open a different *.RLD* file, import the current file into the site database, and exit QuickView.

**Open**

Select **File>Open** to browse to the location of a different *.RLD* file to view in QuickView.

**Import File**

Select **File>Import File** to import the currently open *.RLD* file into the corresponding site file. If no site file exists yet for this site, you will be asked if you want to create one.

**Exit**

Select **File>Exit** to exit QuickView. If you have another SymphoniePRO Desktop Application window or QuickView window open, it will remain open if you exit the current QuickView window.
5.10.2 View

The View menu of the QuickView window contains several options for viewing additional details from the data file and the option to select which statistic (average, standard deviation, maximum, and minimum, turbulence intensity) to view.

Show Unused Channels

By default, QuickView will only display enabled channels. If you would like to see all 26 channels, even if some are disabled, select View>Show Unused Channels.

Show Additional Channel Details

Selecting View>Show Additional Channels will display two additional columns to the right of the channel descriptions in the data table with sensor height and boom bearing, as they were programmed in the logger.
**Precision**

Select **View>Precision** to select how many digits after the decimal are shown in the data table. The default is three decimal places.

**File Header**

Select **View>File Header** to display the header information saved in the *.RLD file, including the time the file was created, time zone offset, site location name, geographical coordinates, site number, logger serial number and firmware version, and the iPack type, serial number, and firmware version.
**Events**
Select **View>Events** to view a table of any events recorded by the logger during the time period of the open *.RLD file.

**Average, Standard Deviation, Maximum, Minimum, Turbulence Intensity**
By default, QuickView shows the interval averages for each channel. If you would like to view a different statistic, select that statistic type from the **View** menu. Note that the data table will only show channels for which the selected statistic is available. For example, if you select **Turbulence Intensity**, only wind speed channels will be shown.

![Image of QuickView interface with Turbulence Intensity selected]

**5.10.3 Help**

**About**
Select **Help>About** to view information about the SymphoniePRO Desktop Application version and find links to the End User License Agreement and the User’s Manual.
## APPENDIX A | GLOSSARY

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>alphanumeric</td>
<td>Any string of characters that contains letters and numbers in combination. The SymphoniePRO display is capable of alphanumeric strings.</td>
</tr>
<tr>
<td>analog channel</td>
<td>An input channel that accepts a voltage or current type sensor such as an NRG 200P Wind Direction Vane, NRG 110S Temperature Sensor, Relative Humidity Sensor, or Pyranometer.</td>
</tr>
<tr>
<td>anemometer</td>
<td>A sensing device that is used to measure wind velocity. The SymphoniePRO logger collects data from anemometers and other measurement sensors. The NRG Class 1 anemometer and NRG 40C anemometer are 3-cup anemometers.</td>
</tr>
<tr>
<td>ASCII file format</td>
<td>American Standard code for Computer Information Interchange. ASCII files are “common currency” in the computer world. The code contains characters including numbers, letters, and standard punctuation. SymphoniePRO converts raw binary data to ASCII format files.</td>
</tr>
<tr>
<td>averaging interval</td>
<td>The time period over which the logger collects data for averaging. The averaging interval for the SymphoniePRO logger can be set to 1, 2, 5, 10, 15, 30, or 60 minutes.</td>
</tr>
<tr>
<td>“B” carrier</td>
<td>A wireline or “regular” telephone company that also provides cellular service.</td>
</tr>
<tr>
<td>cellular carrier</td>
<td>A cellular phone company.</td>
</tr>
<tr>
<td>counter channel</td>
<td>An input channel that is designed to accept frequency or totalizer type sensors such as anemometers and rain gauges.</td>
</tr>
</tbody>
</table>
excitation Nominal voltage required for excitation of a circuit.

GSM cellular Global System for Mobile telecommunications. GSM is the digital cellular phone system widely deployed in Europe and elsewhere to replace the various analog systems that were in use before GSM was adopted.

GPS Global Positioning System

non-volatile Computer storage that is not affected by a loss of power. The SymphoniePRO logger uses non-volatile data storage and therefore does not require a battery to retain information in its memory.

offset Also known as intercept. The offset is the measured value for zero output from a sensor. SymphoniePRO includes an offset field that can be used for sensors that have non-zero offsets or to correct for wind direction sensors that are referenced to directions other than true north. The number that you enter in the offset field is added to the value that is recorded by SymphoniePRO. For example, the NRG 110S Temperature Sensor outputs 0 volts at -86.39 °C. The offset you would enter for the NRG 110S sensor is –86.39.

print precision Print precision is the number of decimal places you specify in scaled data numbers. For wind assessment studies, specifying two decimal places is appropriate. For example, print precision of (###.##) yields a number up to 999.99.

PV panel Photovoltaic panel. A 15 watt PV panel is an available option for the SymphoniePRO logger. The PV panel attaches to the tower with a mounting bracket and uses solar energy to charge the iPack’s batteries.

P-SCM Signal Conditioning Module. An optional plug-in module that provides the electronics to configure the input on channels 20 - 26 on the SymphoniePRO logger for a particular sensor. The P-SCM tells the logger whether the sensor is a vane or has a linear signal.
pyranometer A sensor that is used to measure total solar radiation. NRG’s #LI-200SZ Li-Cor Pyranometer is a dependable and low-cost pyranometer that can be used for energy studies, site evaluation, passive solar system analysis, or irrigation scheduling.

roaming Switching from your cellular carrier to another in order to transmit a call. An example of when roaming is necessary is when a car with a cellular phone travels beyond the area covered by the primary cellular carrier.

RS-232 serial port A standard interface that allows communication between a computer and other devices. On PC’s, the port is often referred to as a “Comm Port.” Serial ports typically use a 9-pin D shaped connector.

sampling interval The time period between samples of the input sensors. The SymphoniePRO logger samples data once every second. At the end of the averaging interval, the SymphoniePRO logger calculates and stores an average and standard deviation of these samples. One second samples are stored if raw data collection is enabled.

scale factor A number that is used as a multiplier to convert raw data from the SymphoniePRO logger to useful units of measure (such as °F, or m/s). The scale factor is often called the “slope” or “transfer function”. For example, the scale factor for the NRG 40C anemometer is 0.765 m/s per Hz.

shelter box The lockable enclosure that mounts to a tower or structure and protects a logger from weather and vandalism.

site The installation location of the SymphoniePRO logger, TallTower™, and sensors. A site is a unique and permanent location. SymphoniePRO loggers store a site number you assign to identify the site.
standard deviation A measure of the central tendency of a collection of data. A small standard deviation means the data do not vary widely. A large standard deviation means the data vary more widely. Standard deviation is calculated as the square root of the variance, where variance is the average of the squared deviations about the mean.

storage intervals The period of time that data are gathered before being stored to non-volatile memory.

SymphoniePRO Desktop Application Software supplied by NRG Systems used to produce versatile tab-delimited text files from raw data files collected by the SymphoniePRO logger. Text files can be used with a wide range of data processing software, including SQL databases, Microsoft Excel, Microsoft Access, and more. Supports international numeric formats.

TallTower™ NRG TallTowers™ are the original tilt-up tubular steel meteorological tower. TallTowers™ are delivered in complete kits, assembled on the ground and then tilted up and secured with guy wires.

text editor A simple utility program that can be used to view or edit text files.

text file A computer file containing only text in ASCII format.

timestamp The time and date that identifies when a record was recorded. All SymphoniePRO logger data files are timestamped with the beginning time of the interval.

turbulence intensity (TI) A measure of the irregularity of air flow over a site. TI is related to wind speed and terrain and is defined as the ratio of the standard deviation of the wind
speed to the mean of the wind speed. Average turbulence intensity is the
arithmetic mean of the valid TI values for the reporting period.

UTC

Coordinated Universal Time (UTC) is the international time standard. It is the
current term for what was commonly referred to as Greenwich Meridian Time
(GMT). Zero (0) hours UTC is midnight in Greenwich, England, which lies on
the zero longitudinal meridian. Universal time is based on a 24 hour clock.
Afternoon hours such as 5 pm UTC are expressed as 17:00 UTC (seventeen
hours, zero minutes).

wind direction

The compass direction, as compass points (NE, NNE, etc.) or degrees (0 to
360°) from which the wind is blowing.

wind shear

The stress that occurs when adjacent wind layers move at different speeds or
in different directions. Wind shear is measured as the change in wind speed
from a measured anemometer to a reference anemometer. The measured
anemometer is normally the anemometer at the top of the tower. The
reference anemometer is the lowest anemometer on the tower.
APPENDIX B | TROUBLESHOOTING GUIDE

The SymphoniePRO logger and SymphoniePRO Desktop Application software provide numerous tools including Recent Events, Logs, and Exports to assist in troubleshooting any issues with the logger or iPack or with interactions between the logger and SymphoniePRO Desktop Application software.

Logs

Application Log
The Application Log provides a detailed history of activities performed using the SymphoniePRO Desktop Application. This includes actions such as downloading files, importing files, connections, and firmware updates. The Application Log can be viewed in Notepad by selecting View Application Log from the File menu or by clicking the View Log File link after actions such as downloading files or importing data. A new log is created each time you start the SymphoniePRO Desktop Application. Logs are saved with the format SymPRO_Desktop_YYYY-MM-DD_HH.MM.log and are stored in the Logs Path location defined in Settings (File menu).

Communication Log
The Communication Log can be accessed by choosing Save Communication Log from the Help menu. The Communication Log contains a detailed history of the SymphoniePRO Desktop Application’s communications with loggers and iPacks. The file is in a compressed format that can be sent to NRG Systems for troubleshooting analysis. Logs are saved with the format SymPRO_Desktop_CommHist_YYYY-MM-DD_HH_MM_SS.log and are stored in the Logs Path location defined in Settings (File menu).
**iPack Log**

The iPack Log can be accessed by clicking the **Display iPack Status** button and then choosing **View Log File**. The **Test Email Settings** button and the MetLink **Test** buttons on the **Schedules** screen also provide a **View Log File** link. The iPack Log contains a detailed history of the iPack's MetLink and/or SMTP communications. Logs are saved with the format SymPRO_Desktop_iPack_YYYY-MM-DD_HH.MM.SS.log and are stored in the Logs Path location defined in **Settings** (File menu).

![iPack Log Example](image)

**Exports**

In addition to storing measurements, the SymphoniePRO records important information about logger activities, which can be categorized as “Diagnostic”, “Events”, and “Communication”. This rich information can be helpful in troubleshooting and is stored in each RLD file and is also imported into the site database, along with the measurement data. Each category of information can be separately exported (in text format) from the **Site Utilities** screen for a specific date range or for the entire measurement period. Exported files are saved in the Export Path location defined in **Settings** (File menu) with a filename containing the site number and project name.

**Measurements**

Measurements are the meteorological data recorded by the logger. A careful review of the measurement data can often provide clues related to storm activity, icing conditions, or other events or trends that can be helpful in diagnosing a problem.

The top part of the text file contains header information like site location, logger and iPack serial numbers and firmware versions, and sensor configuration information. The remainder of the file is timestamped and sorted into columns.
Diagnostic information includes the logger D-cell battery voltage (average, minimum, and maximum), iPack 12 V battery voltage (average, minimum, and maximum), internal circuit board temperature (average), 12 V excitation current (average, minimum, and maximum), and 5 V excitation current (average, minimum, and maximum).
Communication

The communication portion of the data stream provides complete communication history for the site. Information includes bytes sent and received, modem type, signal strength, connection time, cellular carrier, and connection mechanism used to send data.

Events

SymphoniePRO logs all types of events and records them in the data stream. A history of fault events and user actions is recorded for each site.
Event and Error Codes

SymphoniePRO events are classified as faults, actions, or information. Further details like error codes provide supplemental information that can be helpful in troubleshooting.

The error codes are useful tools in determining the source of a transmission problem. The error codes do not necessarily give a specific resolution to a particular issue. However, they will point you to the group of settings most likely causing the problem and give you an indication of the phase of the connection process during which the problem was encountered. If you receive an event or error code not listed below, please contact NRG Systems for assistance.

<table>
<thead>
<tr>
<th>Class</th>
<th>Event</th>
<th>Error (Hex)</th>
<th>Fault Details / Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault</td>
<td>101</td>
<td>0x9D0</td>
<td>Problem initializing the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>101</td>
<td>0x9D4</td>
<td>Problem communicating with the GPS - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>101</td>
<td>0x624B</td>
<td>Problem communicating with the GPS - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>101</td>
<td>0x61AC</td>
<td>Problem communicating with the GPS - if problem persists contact NRG systems</td>
</tr>
<tr>
<td>Fault</td>
<td>101</td>
<td>0x9C5</td>
<td>Problem communicating with the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x9D0</td>
<td>Problem retrieving data from the GPS - iPack powered down</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x624B</td>
<td>Problem retrieving data from the GPS - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x9D4</td>
<td>Problem retrieving data from the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x9C5</td>
<td>Problem retrieving data from the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x4EAF</td>
<td>Problem retrieving data from the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>103</td>
<td>0x2729</td>
<td>Problem retrieving data from the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x838</td>
<td>Problem updating time - an internal fault was encountered</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x9D4</td>
<td>Problem shutting down the GPS - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x624B</td>
<td>Problem shutting down the GPS - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x9D0</td>
<td>Problem shutting down the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x9C5</td>
<td>Problem shutting down the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x4EAF</td>
<td>Problem shutting down the GPS</td>
</tr>
<tr>
<td>Class</td>
<td>Event</td>
<td>Error (Hex)</td>
<td>Fault Details / Recommended Action</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Fault</td>
<td>107</td>
<td>0x271F</td>
<td>Problem shutting down the GPS</td>
</tr>
<tr>
<td>Fault</td>
<td>186</td>
<td>0x4F43</td>
<td>Problem reading time from the logger clock</td>
</tr>
<tr>
<td>Fault</td>
<td>186</td>
<td>0xC27</td>
<td>Problem reading time from the logger clock</td>
</tr>
<tr>
<td>Fault</td>
<td>253</td>
<td>0x5001</td>
<td>Logger was unable to enter low power state - after 23 hours a reset was performed (this can occur if you leave USB connected to logger)</td>
</tr>
<tr>
<td>Fault</td>
<td>254</td>
<td>0x5003</td>
<td>A recoverable fault event occurred</td>
</tr>
<tr>
<td>Fault</td>
<td>382</td>
<td>0x4EC2</td>
<td>SD card write protection error</td>
</tr>
<tr>
<td>Fault</td>
<td>382</td>
<td>0x8B9</td>
<td>Problem writing to the SD card - directory not found</td>
</tr>
<tr>
<td>Fault</td>
<td>383</td>
<td>0x4EC1</td>
<td>Problem writing to the SD card - SD card is not detected</td>
</tr>
<tr>
<td>Fault</td>
<td>383</td>
<td>0x4FDD</td>
<td>Problem writing to the SD card - SD card may not be present</td>
</tr>
<tr>
<td>Fault</td>
<td>383</td>
<td>0x4EC2</td>
<td>Problem writing to the SD card - SD card is write protected Please disable the write protection on the SD card</td>
</tr>
<tr>
<td>Fault</td>
<td>383</td>
<td>0xC09</td>
<td>Problem writing to the SD card – unable to initialize the SD card</td>
</tr>
<tr>
<td>Fault</td>
<td>383</td>
<td>0x8B9</td>
<td>Problem writing to the SD card - directory not found</td>
</tr>
<tr>
<td>Fault</td>
<td>481</td>
<td>0x8FF</td>
<td>Problem with USB communication</td>
</tr>
<tr>
<td>Fault</td>
<td>539</td>
<td>0x7D41</td>
<td>Wiring panel drawing too much current from 12 V battery, possible sensor wiring issue or sensor failure</td>
</tr>
<tr>
<td>Fault</td>
<td>541</td>
<td>0x7D2B</td>
<td>Problem with 5.3 V supply - possible low battery condition</td>
</tr>
<tr>
<td>Fault</td>
<td>541</td>
<td>0x7D2D</td>
<td>Problem with 5 V reference - possible low battery condition</td>
</tr>
<tr>
<td>Fault</td>
<td>541</td>
<td>0x7D2A</td>
<td>Problem with 3.3 V reference - possible low battery condition</td>
</tr>
<tr>
<td>Fault</td>
<td>541</td>
<td>0x7D2C</td>
<td>Problem with 3 V reference - possible low battery condition</td>
</tr>
<tr>
<td>Fault</td>
<td>541</td>
<td>0x7D2E</td>
<td>Problem with 2.5 V reference - possible low battery condition</td>
</tr>
<tr>
<td>Class</td>
<td>Event</td>
<td>Error (Hex)</td>
<td>Fault Details / Recommended Action</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x839</td>
<td>Problem connecting to the network - PPP connection could not be established</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x7D6B</td>
<td>Problem connecting to the network - old version of iPack detected</td>
</tr>
</tbody>
</table>
| Fault | 551   | 0x2749      | Problem connecting to the network - no SIM card installed  
Please make sure the SIM card is properly installed inside the iPack |
| Fault | 551   | 0x2780      | Problem connecting to the network - network connection issue detected |
| Fault | 551   | 0x273E      | Problem connecting to the network - modem not responding |
| Fault | 551   | 0x274B      | Problem connecting to the network - modem not registering with network  
Check with provider that account is active for CDMA and make certain iPack was provisioned in home area |
| Fault | 551   | 0x2740      | Problem connecting to the network - modem identification error |
| Fault | 551   | 0x273C      | Problem connecting to the network - modem error detected |
| Fault | 551   | 0x856       | Problem connecting to the network - issue with connection to the SMTP (email) server |
| Fault | 551   | 0x61AD      | Problem connecting to the network - issue communicating with the network |
| Fault | 551   | 0x2743      | Problem connecting to the network - issue communicating to the modem |
| Fault | 551   | 0x9D4       | Problem connecting to the network - iPack is busy |
| Fault | 551   | 0x6210      | Problem connecting to the network - iPack battery is below 10.5 V, iPackGPS will not attempt call under this condition |
| Fault | 551   | 0x61AC      | Problem connecting to the network - internal error  
Please contact NRG Systems |
<p>| Fault | 551   | 0x836       | Problem connecting to the network - DNS server not responding |
| Fault | 551   | 0x9D2       | Problem connecting to the network – iPack communication error |
| Fault | 551   | 0x45E       | Problem connecting to the network – iPack communication error |</p>
<table>
<thead>
<tr>
<th>Class</th>
<th>Event</th>
<th>Error (Hex)</th>
<th>Fault Details / Recommended Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x9C5</td>
<td>Problem connecting to the network</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x7D65</td>
<td>Problem connecting to the network</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x273A</td>
<td>Problem connecting to the network</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x9D0</td>
<td>Problem connecting to network - iPack not responding, battery may be low</td>
</tr>
<tr>
<td>Fault</td>
<td>551</td>
<td>0x9C7</td>
<td>Problem connecting the network</td>
</tr>
<tr>
<td>Fault</td>
<td>552</td>
<td>0x2780</td>
<td>Problem connecting to the Primary Host - unable to connect to network</td>
</tr>
<tr>
<td>Fault</td>
<td>552</td>
<td>0x7D65</td>
<td>Problem connecting to the Primary Host - iPack not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>552</td>
<td>0x836</td>
<td>Problem connecting to the Primary Host - DNS server not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>552</td>
<td>0x61AD</td>
<td>Primary Host unavailable or not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>553</td>
<td>0x61AD</td>
<td>Secondary Host unavailable or not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>553</td>
<td>0x9C5</td>
<td>Problem connecting to the Secondary Host - iPack not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>553</td>
<td>0x9D0</td>
<td>Problem connecting to the Secondary Host - iPack may be powered down</td>
</tr>
<tr>
<td>Fault</td>
<td>553</td>
<td>0x836</td>
<td>Problem connecting to the Secondary Host - DNS server not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>554</td>
<td>0x856</td>
<td>Problem connecting to the SMTP (email) server. Please verify SMTP server name, user name, and password. Make certain server is running.</td>
</tr>
<tr>
<td>Fault</td>
<td>554</td>
<td>0x7D65</td>
<td>Problem connecting to the SMTP (email) server.</td>
</tr>
<tr>
<td>Fault</td>
<td>554</td>
<td>0x854</td>
<td>Problem connecting to SMTP (email) server. Check server name and compatibility (servers which use SSL encryption such as Gmail or Yahoo Mail are not compatible)</td>
</tr>
<tr>
<td>Fault</td>
<td>554</td>
<td>0x9C5</td>
<td>Problem communicating with the SMTP (email) server</td>
</tr>
<tr>
<td>Fault</td>
<td>555</td>
<td>0x2780</td>
<td>Problem sending email - issue with network connection</td>
</tr>
<tr>
<td>Fault</td>
<td>555</td>
<td>0x84D</td>
<td>Problem sending email - issue communicating with SMTP (email) server</td>
</tr>
<tr>
<td>Fault</td>
<td>555</td>
<td>0x84C</td>
<td>Problem sending email - issue communicating with SMTP (email) server</td>
</tr>
<tr>
<td>Class</td>
<td>Event</td>
<td>Error (Hex)</td>
<td>Fault Details / Recommended Action</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>Fault</td>
<td>555</td>
<td>0xA</td>
<td>Problem sending email</td>
</tr>
<tr>
<td>Fault</td>
<td>555</td>
<td>0x9C5</td>
<td>Problem sending email</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x84C</td>
<td>Problem with the network connection - issue communicating with SMTP (email server)</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x854</td>
<td>Problem with the network connection - SMTP (email) server name or other settings may be incorrect</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x9D4</td>
<td>Problem disconnecting from the network - iPack is busy</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x836</td>
<td>Problem disconnecting from the network - DNS server not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x9C5</td>
<td>Problem disconnecting from the network</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x7D65</td>
<td>Problem disconnecting from the network</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x2780</td>
<td>Problem disconnecting from the network</td>
</tr>
<tr>
<td>Fault</td>
<td>558</td>
<td>0x61AD</td>
<td>Network disconnected unexpectedly</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x84D</td>
<td>Problem sending email (SMTP) and updating time (SNTP) – SNTP, SMTP server not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x854</td>
<td>Problem sending email and updating time (SNTP)</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x838</td>
<td>Problem retrieving time from SNTP (time) server</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x836</td>
<td>Problem connecting to SNTP (time) server - DNS server not responding</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x9C5</td>
<td>Problem connecting to SNTP (time) server</td>
</tr>
<tr>
<td>Fault</td>
<td>559</td>
<td>0x61AD</td>
<td>Problem connecting to SNTP (time) server - encountered socket error</td>
</tr>
<tr>
<td>Fault</td>
<td>581</td>
<td>0x9D4</td>
<td>Problem updating iPack firmware - iPack busy</td>
</tr>
<tr>
<td>Fault</td>
<td>581</td>
<td>0x624B</td>
<td>Problem updating iPack firmware - iPack busy</td>
</tr>
<tr>
<td>Fault</td>
<td>581</td>
<td>0x9CB</td>
<td>Problem updating iPack firmware - please try again</td>
</tr>
<tr>
<td>Fault</td>
<td>581</td>
<td>0x9C5</td>
<td>Problem updating iPack firmware - please try again</td>
</tr>
<tr>
<td>Fault</td>
<td>581</td>
<td>0x7D8E</td>
<td>Problem updating iPack firmware - corrupted or incorrect firmware detected</td>
</tr>
<tr>
<td>Class</td>
<td>Event</td>
<td>Error (Hex)</td>
<td>Fault Details / Recommended Action</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
<td>-------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>Fault</td>
<td>583</td>
<td>0x4F16</td>
<td>Problem updating the Logger or iPack firmware - please try again</td>
</tr>
<tr>
<td>Fault</td>
<td>583</td>
<td>0x7D8F</td>
<td>Problem updating iPack firmware - this version of iPack firmware is not supported</td>
</tr>
<tr>
<td>Fault</td>
<td>583</td>
<td>0x7D8E</td>
<td>Problem updating firmware in SymphoniePRO Logger - corrupted or incorrect firmware detected</td>
</tr>
</tbody>
</table>
C.1 Symphonie iPack Options

The SymphoniePRO Data Logger, iPackGPS or iPackACCESS, and SymphoniePRO Desktop Application act as a system which can transmit and receive information in a variety of ways. At its core, a Symphonie iPack contains a modem, antenna, GPS, 12 V DC battery, and a charging circuit. NRG Systems iPacks can be supplied as 2G GSM (GPRS), 3G GSM (HSPA), CDMA, DoCoMo, Ethernet (supports either Modbus or Inmarsat BGAN M2M Satellite), or even a “Power Only” version which does not contain a modem. The modularity of the iPacks has proven to be very convenient and straightforward for installation, site maintenance and troubleshooting. SymphoniePRO Desktop Application becomes a communication hub for the loggers and iPacks and will be explained in this section.

iPack Firmware Compatibility / Upgrade

Firmware updates are available on the NRG Systems webpage at no charge. With SymphoniePRO, the iPack has expanded functionality and requires new firmware.

The first thing a SymphoniePRO user should do is make certain the firmware loaded in the iPack is up to date for use with SymphoniePRO. Existing iPackGPS and iPackACCESS units already deployed with older Symphonie family loggers are hardware compatible with the SymphoniePRO system; however, an iPack needs to have installed a SymphoniePRO version of iPack firmware in order to be compatible with SymphoniePRO. While all iPackACCESS hardware units are compatible with SymphoniePRO for use in Modbus applications, iPackACCESS serial number 716900300 or higher is required for hardware compatibility with the BGAN M2M Satellite module. Power Only iPacks have no communication functions and therefore are fully compatible with SymphoniePRO regardless of age.

SymphoniePRO Desktop Application can establish communication between a PC and any iPackGPS revision 60 or higher; therefore the user can update iPackGPS firmware using SymphoniePRO Desktop Application if the iPackGPS firmware revision is 60 or higher. If the iPackGPS firmware revision is 59 or lower, the older Symphonie Data Retriever software (SDR) and serial cable must be used to update the iPackGPS for SymphoniePRO version iPack firmware. The iPackGPS for SymphoniePRO firmware version number will be in a format of N.NN.N.ifw. Once the iPackGPS has been updated to use the SymphoniePRO family of firmware, all future firmware updates to the iPack and SymphoniePRO can be applied by the SymphoniePRO Desktop Application (remotely or on site). Similarly, iPackACCESS firmware version 6 and higher can be updated using SymphoniePRO Desktop Application, while iPackACCESS firmware version 5 and lower requires an upgrade via SDR.
Note - Older iPacks (pre-iPackGPS) are NOT compatible with SymphoniePRO. The exception to this is Power Only iPacks which have no communication functions and therefore are compatible with SymphoniePRO.

**MetLink**
The SymphoniePRO system has a new feature set built around our bidirectional MetLink communication interface. MetLink allows a SymphoniePRO system to communicate with a PC over a variety of transports including 2G GSM (GPRS), 3G GSM (HSPA), CDMA, DoCoMo, Ethernet, RS-232 and USB. MetLink provides a way
to connect to a SymphoniePRO and change settings, apply firmware updates, or download meteorological and diagnostic data.

It is important that users familiarize themselves with MetLink and choose a communication scheme that best works with their business requirements. Although the options are presented as discrete scenarios, any combination of the communication options (C2 through C4) can be used concurrently. The rest of this Appendix describes these options.

C.2 Configuring SymphoniePRO - MetLink Logger Initiated

Logger Initiated Connection
MetLink allows SymphoniePRO loggers and the SymphoniePRO Desktop Application to talk to one another over TCP/IP and other types of connections. One communication scenario of a SymphoniePRO logger equipped with an iPackGPS is a MetLink Logger Initiated connection. The connection originates at the logger and terminates at an office PC running SymphoniePRO Desktop Application. In this scenario, the iPack “wakes up” on a user-defined schedule and establishes a direct communication link with a static IP at your place of business which routes to an office PC. The direct link can be established across cellular or Ethernet connection, and the office PC must be powered on with the SymphoniePRO Desktop Application running in order to receive logger initiated connections. It may make sense to configure one PC in your organization to handle all the incoming traffic.

Logger initiated connections have the advantage of optimizing power consumption by the logger, as the logger will spend the majority of its time with the modem turned off (the communications electronics are only powered on at the scheduled time). Once connected with the office PC, a user can retrieve data, apply firmware updates to the logger and iPack, change channel or communication settings, change site information settings, run automation actions, view live data and more. In fact, most operations that can be performed via USB on site can be performed remotely (off-site) as long as the connection is established.

Configuration of SymphoniePRO Logger
The SymphoniePRO logger will need to be configured with an active MetLink Logger Initiated schedule, including a “Host Name” (or static IP address – this is computer that the logger connects to) and TCP port specific to the user’s network. This configuration is initially loaded and saved to the logger using the SymphoniePRO Desktop Application and a USB cable, and configuration can also be modified remotely as the need arises. Note there is the ability to add a secondary host to use as a backup (in case the primary becomes unavailable, the logger will try the secondary).

The following example shows a logger which will attempt to connect each day at 9 AM to “host.mycompany.com” on port 30406. If that connection cannot be established, the logger will attempt to connect to the secondary.
The duration of the connection is set for one hour by default. If a longer connection is required, use the MetLink Listening duration box to choose a connection time greater than one hour.

**Configuration of User Network**

The user’s network will need to be configured to receive the inbound connections from SymphoniePRO loggers. This configuration may involve multiple firewalls and/or routers. Using the example above, when the connection comes into host.mycompany.com on port 30406, the connection needs to be forwarded to a specific PC running the SymphoniePRO Desktop application. Because even the most basic configuration will involve a router, it is important to understand how port forwarding works. The SymphoniePRO Desktop application running on the user’s PC always expects connections to appear on port 30406. So, in our example, when a connection to “host.mycompany” on port 30406 occurs, the router will “port forward” the connection to “User PC1” on port 30406. Note the port 30406 at “host.mycompany.com” was selected somewhat arbitrarily, and any free outward facing port can be used. For example, if the logger was configured to connect to “host.mycompany.com” on port 30408, the router port forwarding configuration would need to route incoming connections at “host.mycompany.com” on port 30408 to “User PC1” on port 30406.

*Note - It is important to engage your IT professionals early on so that the appropriate rules can be created for your particular network infrastructure and policies.*

**Configuration of Windows Firewall**

In addition to any corporate firewalls and firewalls associated with anti-virus software, a Windows PC has its own firewall, and a rule needs to be added so inbound connections can make it to the SymphoniePRO Desktop Application.

The rule will allow the PC to accept TCP connections on port 30406, and the SymphoniePRO Desktop Application will create the rule during the installation process as long as the user checks the box to add firewall rules during the software installation process. Another rule is created to allow connections out through port 30407.

Additionally, Microsoft has extensive information on Windows Firewall.

**SymphoniePRO Desktop Application is the Master**

Once a logger is connected to the SymphoniePRO Desktop Application through MetLink, the logger acts as a server and waits for commands from the client software (SymphoniePRO Desktop Application). Common MetLink actions (commands) include downloading of data and administering configuration changes on the logger, such as adjusting scale factors or applying new firmware. One important concept to recognize is that software function is independent of the connection transport, and a user who is remotely connected can perform most of the same actions a user can perform when connected locally through USB.
SymphoniePRO MetLink Communication
Logger initiated: SymphoniePRO to User PC
C.3 Configuring SymphoniePRO for MetLink Logger Listening

Logger with Public Static IP Listens for Connections
The second common communication scenario is a MetLink Logger Listening connection which can be thought of as originating at the office PC and terminating at the logger. In this scenario, the iPack “wakes up” the modem on a user-defined schedule and waits to be contacted. The direct link can be established across cellular or Ethernet connection, and the office PC must be ready to initiate a connection at the scheduled time.

In order for the PC to remotely connect to the SymphoniePRO through the internet, the SymphoniePRO needs a reachable IP address (public static IP address or local private IP address provided through a VPN service) is required on the logger. For GSM, be sure to order your SIM card configured with a public static IP address. For CDMA, please be sure to contact your service provider with the Electronic Serial Number (ESN) of your modem, so the provider can configure their systems appropriately. Note that the static IP address can only be provided by your wireless service provider.

MetLink Logger Listening connections are substantially transparent through corporate firewalls but are not as power efficient for the logger because they typically result in the modem spending a considerable amount of idle time. The user can connect to the logger “at will” as long as the time is within the logger listening schedule window. Remember, a user can only connect when the logger communications electronics are powered on, which can add complexity and cost for certain applications (requiring additional PV panels and batteries, for example). For 24/7 communication availability, additional power is required at the site to keep the modem powered continuously.

Configuration of SymphoniePRO Logger Provisioned with Public Static IP Address
The SymphoniePRO logger will need to be configured with a communication schedule, and the SIM should be provisioned with a public static IP address as described above. This configuration is initially performed using the SymphoniePRO Desktop Application and a USB cable and can be updated remotely as needed. Note the user does not actually enter the public static IP address into the logger. The public static IP of the logger must be entered into the SymphoniePRO Desktop Application software and may be stored in the site file. Wikipedia is a good resource for general information on networking and IP addresses. You can verify the correct IP address has been assigned by the ISP by using the Network Status display on the logger [Home][2][2][2][Right].

The following example shows a logger which will listen for connections each day starting at 2 PM for one hour. The static IP address of the logger is stored in the Remote Connection Settings box in the software.

![Remote Connection Settings](image)

The static IP address of the logger is stored in the Remote Connection Settings box in the software.
**Private Static IP Addresses**

Some users have the ability to obtain private static IP addresses through a wireless service provider. In this case, a provider is able to subnet all the user’s devices with IP addresses assigned and controlled by the provider. For this scenario, the user needs to connect their PC running the SymphoniePRO Desktop software via a software VPN to the provider’s router. Once connected to the provider’s network, the private addresses act the same as public addresses. There is also possibility for more advanced configurations with multiple computer users tied together on a hardware VPN; be sure to discuss with your provider. One such provider is Wireless Innovation, and for more information please contact them directly (www.windlinx.com).

**Configuration of User Network**

The SymphoniePRO logger listens on port 30407 and therefore the user’s computer network firewall needs to allow connections out port 30407. In many cases, this is a default state for such networks, and no additional configuration is required. However, it is strongly recommended that you work closely with your IT professionals when first setting up the system to make certain your company firewall is properly configured.
SymphoniePRO MetLink Communication
Logger listening: User PC to SymphoniePRO
C.4 Logger Initiated Email Connections

Previous Symphonie loggers’ core communication abilities were to transfer data via email. SymphoniePRO is also capable of sending data via email on a user defined schedule, and for this configuration, mail settings will need to be configured in the logger.

**Configuration of SymphoniePRO Logger**

The following example shows a logger which will attempt to email data each day at 9 AM by connecting to the SMTP server “mail.myssmtp.com” on port 587. The SMTP server requires a username and password and will relay the email from the logger to the recipient `SymPROdata@mydomain.com`.

Note that Sender’s information and subject line are often strategically formed by the user in order to make sorting of incoming email easier.

![Email Schedule](image)

**Configuration of User Email Server**

This configuration process for SymphoniePRO systems is substantially the same as for previous versions of the Symphonie logger. An SMTP server is required to relay emails from the logger to the end user. Additionally, the user needs access to incoming emails so that the *.RLD data files can be extracted from the email attachments and placed into a folder on the user network. Once the *.RLD files are on the user network, they can be imported into the SymphoniePRO Desktop Application and processed further.
SymphoniePRO SMTP (Email) Communication
Logger initiated email: SymphoniePRO to User PC
Compatibility
When used with SymphoniePRO, the iPackGPS has expanded functionality and requires new firmware. The first thing a SymphoniePRO user should do is make certain the firmware loaded in the iPackGPS is up to date for SymphoniePRO. Existing iPackGPS units already deployed with older Symphonie family loggers are hardware compatible with the SymphoniePRO system; however, a firmware update [using Symphonie Data Retriever software (SDR)] to version 60 or later is required for compatibility with the SymphoniePRO Desktop Application. Once the iPack has been updated to version 60 or later, the SymphoniePRO Desktop Application can be used to apply a SymphoniePRO iPack firmware update to make it compatible with the SymphoniePRO logger. The SymphoniePRO Desktop Application can then be used to apply all future firmware updates to the iPack and logger.

Firmware updates are available on the NRG Systems Technical Support webpage at no charge:
http://www.nrgsystems.com/technical-support/software

Note - Older iPacks (non-iPackGPS) are NOT compatible with SymphoniePRO. The exception to this is Power Only iPacks which have no communication functions and therefore are compatible with SymphoniePRO.

Opening and Closing the iPackGPS

Note - Be sure to touch the metal shell of the DB25 connector on the iPackGPS before opening the enclosure in order to safely discharge any static electricity.

The iPackGPS enclosure consists of two halves secured together by four recessed screws, two from each side of the enclosure. A gasket in between the two halves and 8 o-rings provide an environmental seal for the iPackGPS protecting the internal electronics from the elements.

Remove the four recessed screws, and the iPackGPS will separate into two halves.

To close the iPackGPS:

Insert the (4) 2-½ inch mounting screws up through the half of the enclosure that contains the iPackGPS electronics.

Set the gasket into the groove of the shell.

Slide the cover over screws being careful not to pinch the battery cable.

Make sure the gasket is not pinched, and then install the screws. It is a good idea to make sure the screws fall back into the existing threads in the iPackGPS enclosure. An easy way to do this is to gently turn the screw counterclockwise one turn – it will fall into the existing threads in the iPackGPS enclosure.

iPackGPS GSM

Installing a SIM Card into an iPackGPS GSM

WindLinx subscribers do not need to open the iPackGPS as the WindLinx SIM is already installed. However, other GSM users will need to open the iPackGPS and install a SIM card into the GSM data modem.
The GSM transceiver is located to the left of the battery.

*Note - Try not to lose any of the o-rings, and be careful not to rip or tear the gasket if it should come loose.*

Once the iPackGPS cover is off, find the GSM transceiver. Install the SIM in the GSM Data Modem by gently sliding it in. Be sure to install the SIM so that the gold contacts are facing down and the SIM card’s notched corner is aligned to the top right, as seen in the picture above.

**PIN Number**

Setup parameters for GSM phones are stored on the user-installed SIM card. Some SIM cards, however, require an un-locking PIN number to be entered every time the phone is used. The iPackGPS uses this PIN number to initiate a call. The PIN should be a 4 to 8 character string and must be entered during iPackGPS programming (from iPack screen in the SymphoniePRO Desktop Application).
APPENDIX E | USING THE BGAN M2M SATELLITE TERMINAL WITH SYMPHONIEPRO

Introduction
This appendix describes the steps required to use the Hughes 9502 BGAN M2M satellite terminal with a SymphoniePRO logger and iPackACCESS (iPackACCESS Serial Number 716900300 or higher required). The updated version of the iPackACCESS released in May 2016 includes smart-switched 12 V power out terminals for the BGAN M2M module, as well as double the battery capacity. The iPackACCESS with BGAN M2M terminal can be run from the standard NRG 15 W PV panel for typical resource assessment applications.

Account Setup and Confirmation
The BGAN M2M satellite terminal includes an M2M SIM card and activation form for Wireless Innovation Windlinx service. Upon receipt of your BGAN system, use the details found on the included activation sheet to activate BGAN M2M service through the web portal at www.windlinx.net. If you are new to Wireless Innovation and WindLinx, please visit and review the information at www.windlinx.com.

It is strongly advised to activate the account several days before your field installation.

Once you have activated your account, Wireless Innovation will send you an “infopack” that contains the settings required for using the Packet-Mail SMTP server. Additionally, a public static IP address will be sent to you via confirmation email. You will need this information in order to set up your BGAN M2M terminal and enable met tower communications.

Other Pre-Installation Considerations
Inmarsat’s satellite constellation consists of geostationary satellites, which require the BGAN antenna to be installed (i.e., pointed) toward the appropriate satellite. It is advantageous to obtain the coordinates of the site ahead of the installation date, so that a Satellite Pointing Application or the Location Spreadsheet on the Hughes BGAN support page (http://www.bgan.hughes.com) can be referenced to determine the approximate azimuth (compass heading) and elevation (vertical angle) for pointing the BGAN Antenna. In complex terrain, or in installations near structures be sure to establish a clean line of sight between the antenna and satellite. Determining the optimal antenna mounting location prior to installation will save time for the field crew when on site to point the antenna.

Be certain to have the latest version of SymphoniePRO Desktop Application and the latest firmware on your SymphoniePRO and iPackACCESS prior to installation. Additionally, you may want to reference the Hughes 9502 user manual. These items are freely available at the NRG Support web page (http://www.nrgsystems.com/services-support/documentation-and-downloads/).

Tools
- PC / laptop with SymphoniePRO Desktop Application and web browser
- SymphoniePRO manual
- Hughes 9502 manual
- Wireless Innovation Infopack
- Wireless Innovation confirmation email (contains static IP details)
- WindLinx SIM card
- USB cable to connect SymphoniePRO to PC
- Ethernet cable to connect BGAN terminal to PC (and subsequently to iPackACCESS)
- Adjustable wrench (for antenna mounting)
- iPack Charger to charge iPack (can alternatively be used to power BGAN M2M independently)
- BGAN Pointer Application for iPhone (optional)
- Headphones or speaker for BGAN antenna pointing tool (optional)
- Small flat blade screwdriver for securing BGAN power leads
- Philips screwdriver for securing power leads to iPackACCESS

Install SIM card
The provided WindLinx SIM card must be inserted in the BGAN M2M terminal to be able to establish satellite communications. Open the SIM Door on the terminal to insert the SIM card. The SIM card should be installed prior to the field installation.

iPack Configuration
The iPackACCESS needs to be configured for use with the BGAN M2M system using SymphoniePRO Desktop Application. iPack configuration is described in Section 3.4 of the SymphoniePRO manual. It is recommended to program the iPack settings prior to field installation.

In the iPack tab of SymphoniePRO Desktop Application, follow the configuration guidelines below.

- In the Network section, the “BGAN M2M Satellite Module Connected” box should be checked
- “Enable DHCP” box should NOT be checked

Complete the network fields as follows:
- iPack Static IP Address = 192.168.128.200
- Subnet Mask = 255.255.255.0
- Gateway = 192.168.128.100
- Primary DNS Server = 8.8.8.8
- Secondary DNS Server = 8.8.4.4
In the Schedules tab, configure the email settings using the details provided in the Packet-Mail Infopack. Refer to Section 3.3 of the SymphoniePRO manual for more information about configuring the communication schedules.

**Mount Logger, iPack and BGAN M2M Terminal inside the Shelter Box**

1. Mount the shelter box to the tower and install the logger and iPackACCESS into the shelter box using the mounting plate.
2. Mount the BGAN M2M terminal inside the shelter box using the provided bracket.
3. Connect the small magnetic GPS antenna to the iPackACCESS antenna connector and attach the antenna to the adhesive magnetic disk provided on top of the shelter box pointing up.
**BGAN Antenna Mounting**

The BGAN uses a directional plate antenna, which requires accurate pointing toward a BGAN Satellite.

The correct azimuth (heading) and elevation (vertical angle) of the BGAN antenna depend on location and can be looked up using the BGAN Pointer iPhone application or the Hughes BGAN support webpage. A hole and bolt arrangement in the bracket system allows the elevation to be adjusted in 2 degree increments, while the azimuth is continuously variable by moving the antenna bracket around the tower using the hose clamps. The inner portion of the bracket which affixes to the tower includes 5 holes A-E, with hole A closest to the tower.
The outer bracket which pivots about the center contains 14 holes 1-14, with hole 1 located closest to the antenna plate.

For example, the elevation will be 0º in position E1, 46º in C8, and 90º in E10.

<table>
<thead>
<tr>
<th>tower / antenna</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>2</td>
<td>12</td>
<td>22</td>
<td>32</td>
<td>42</td>
<td>52</td>
<td>62</td>
<td>72</td>
<td>82</td>
</tr>
<tr>
<td>B</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>4</td>
<td>14</td>
<td>24</td>
<td>34</td>
<td>44</td>
<td>54</td>
<td>64</td>
<td>74</td>
<td>84</td>
<td>-</td>
</tr>
<tr>
<td>C</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>6</td>
<td>16</td>
<td>26</td>
<td>36</td>
<td>46</td>
<td>56</td>
<td>66</td>
<td>76</td>
<td>86</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>D</td>
<td>-</td>
<td>-</td>
<td>8</td>
<td>18</td>
<td>28</td>
<td>38</td>
<td>48</td>
<td>58</td>
<td>68</td>
<td>78</td>
<td>88</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>E</td>
<td>0</td>
<td>10</td>
<td>20</td>
<td>30</td>
<td>40</td>
<td>50</td>
<td>60</td>
<td>70</td>
<td>80</td>
<td>90</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Assemble the BGAN antenna bracket and mount it to the tower using the supplied hose clamps.

Final elevation can be set after the BGAN has achieved a GPS lock. For expediency, GPS acquisition prefers the antenna to be mounted flat, pointing straight up, which can be achieved either by placing the antenna on the ground, or by mounting on the bracket and adjusting the elevation to 90º.

**Power and Antenna Connections**

Connect the antenna to the BGAN M2M terminal using the supplied cable, and connect the power and ground cables between the iPackACCESS and the BGAN M2M terminal. Put the iPackACCESS in iPack Setup Mode by pressing [Home][2][3] on the SymphoniePRO keypad. This mode will lock on the 12 V power to the BGAN M2M terminal and block any scheduled actions (MetLink, email) for 30 minutes or until disabled (whichever is shorter), while configuring the BGAN M2M terminal. Lay the antenna flat on the ground (facing up) so that it can achieve a GPS lock. When the modem is powered, it will automatically attempt to obtain a GPS lock, which can take up to 20 minutes. During this time, you can configure other settings.
**Configuration of the BGAN M2M Terminal**

The BGAN M2M terminal must be configured through the Hughes BGAN web user interface (WebUI). To access the configuration details, the terminal must be connected to a PC with a web browser (e.g. Internet Explorer, Firefox). *Take extra care during the configuration process, and only change settings as noted.*

Connect the BGAN M2M terminal to your laptop using the RJ45 Ethernet cable. The network adapter settings in the PC need to be on the same subnet as the iPack; use the static address 192.168.128.199 for your PC.

To change your computer IP address, enter the “Network and Sharing” control panel, select change adapter settings, right-click on the Local Area Network connection, and select Properties. In the Local Area Network Properties window, select Internet Protocol Version 4, and click Properties.
Select the radio button for “Use the following IP address:”. Complete the fields below as follows:

- IP address = 192.168.128.199
- Subnet mask = 255.255.255.0
- Default gateway = 192.168.128.100
**Connect to BGAN**

Once you click OK and close the window, the PC can communicate with the BGAN M2M terminal. In a web browser, enter the address 192.168.128.100. You should see the Hughes BGAN WebUI, served by the BGAN M2M terminal. Navigate the following webpages, and apply the settings as shown.

**Home Page**

The home page contains ID information for the BGAN including the IMEM, IMSI and APN. Note the APN “WILTD.BGAN.INMARSAT.COM” will only appear if the SIM card has been inserted.
**Settings Page**

Configure the Ethernet Settings as follows:

- Wake On LAN = On
- Triggered after Idle timeout of 1 minute
- Triggered at Time Of Day = 0000
**M2M Page**

Configure the M2M Setup as follows:

**Ping Configuration**

- Context Watchdog = Off
- Primary Ping IP Address = 8.8.8.8
- Secondary Ping IP Address = 8.8.4.4
- Tertiary Ping IP Address = 0.0.0.0
- Ping Required = No

**Always ON Context**

- Always On Context = On
- Static ACA IP Address = 192.168.128.200
- Qos = Standard
- APN Config = WILTD.BGAN.INMARSAT.COM
**Check for GPS Lock**

Once the above configuration is complete, go back to the Home screen and see if the GPS section is showing a 3D GPS Fix. Note that the Location coordinates may not yet be populated.

**Point the Antenna**

At this point, the BGAN antenna should be mounted to the bracket and properly oriented to point at the BGAN satellite. Use the direction and angle found in the “Pointing Info” box (see lower orange box above). In the example above, the boom would be pointed 213.5° from True North and 33.2° from vertical.

The BGAN M2M module can be placed into a “pointing mode” where the user can plug headphones or a speaker into the audio port and follow the interval and pitch of the beeps to point the antenna. As the signal strength increases, the pitch will go higher and sound more frequently.

*Note - it is not recommended to put the headphones in your ears, because the beeps can be very loud.*

To enter pointing mode, remove power from the BGAN, wait a few moments and then apply power. The BGAN enters a self-test for about 15 seconds and then the LED will start flashing for another 15 seconds. Within 15 seconds when the LED is blinking, press the function button on the BGAN M2M twice (short presses). When the BGAN terminal first enters pointing mode, all three LEDs will flash. The LEDs will be solid after establishing a GPS fix.

The signal strength needs to be over 60% in order to send data files and establish MetLink connections.
APPENDIX F | USING IPACKACCESS WITH MODBUS PROTOCOL

Theory of Operation
iPackACCESS is paired with the SymphoniePRO Data Logger for SCADA connectivity and data transmission through the Modbus TCP protocol. SymphoniePRO collects 1-second sample data from each of its enabled channels and computes statistical data on a user-defined interval for each channel. The real-time and statistical data are made available through the Modbus TCP protocol, which can link to the SCADA system to help project stakeholders analyze the performance of assets within a renewable energy project relative to the available resource. Stored statistical data are available for wind or solar resource assessment (WRA or SRA) via email and/or MetLink over the network’s internet connection or by manually pulling the SD card from the data logger.

iPackACCESS was developed to provide the following data stream options from the SymphoniePRO Data Logger:

- **Real-time data** provides one-second samples that are available to the SCADA system through the Modbus TCP protocol. These scaled data are pulled from the iPackACCESS to help project operators analyze the performance of assets within a project.

- **Statistical data** provide average, standard deviation, minimum, and maximum values at a user-specified interval (1, 2, 5, 10, 15, 30, or 60 minutes) through the Modbus TCP protocol. These data may be pulled from the iPackACCESS for analysis by project operators and forecasting service providers to predict the future energy production of an energy facility through the use of a meteorological forecast model.

- **Wind or solar resource assessment data** are statistical data collected during a measurement campaign prior to the development of the project. These data are available via email delivery and/or MetLink (remote connection to the SymphoniePRO) over the SCADA network’s internet connection or by manually pulling the SD card from the data logger to validate the wind resource after a wind farm becomes operational.
1. Sensor signals are received by the logger through its wiring panel.

2. The raw sample (1 second) data are scaled using the conversion factors in the logger. The scaled real-time data are passed to the iPackACCESS and formatted into Modbus registers (detailed in the Modbus Protocol section).

3. At the end of each statistical interval, statistical values are computed from the sample data in the logger, and the statistical data are passed to the iPackACCESS and formatted into Modbus registers.

4. When the Modbus server is enabled, the iPackACCESS makes the scaled statistical and real time data available on their designated registers.

5. The scaled real-time and statistical data can be polled through an Ethernet network by a Modbus client.

6. A Modbus client can poll the iPackACCESS registers for data once a second. The statistical data registers are updated at the end of each statistical interval.
Examples of Network Configurations

Direct connection with static IP addresses

This example shows the most basic network setup with an iPack directly connected to a computer running a Modbus client. DHCP is disabled, and a fixed IP address (programmed in the iPackACCESS) is used to connect to the Modbus client. No email is enabled, and the DNS servers are left open.

<table>
<thead>
<tr>
<th>Network Configuration</th>
<th>iPackACCESS</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DHCP:</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>192.168.1.100</td>
<td>192.168.1.40</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>255.255.255.0</td>
<td>255.255.255.0</td>
</tr>
<tr>
<td>Gateway</td>
<td>0.0.0.0</td>
<td>Not used</td>
</tr>
<tr>
<td>Primary DNS Server</td>
<td>0.0.0.0</td>
<td>Not used</td>
</tr>
<tr>
<td>Secondary DNS Server</td>
<td>0.0.0.0</td>
<td>Not used</td>
</tr>
</tbody>
</table>
This example shows a common network setup with a DHCP server assigning IP addresses to all devices. DHCP is enabled and responsible for giving the iPackACCESS and computer their IP addresses. In the iPackACCESS settings, DHCP is turned “ON” and Static IP address is not used. No email is enabled, and no DNS servers are specified; data are available over the local network.

### Network Configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>iPackACCESS</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DHCP:</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>Assigned by DHCP (N/A)</td>
<td>Assigned by DHCP</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>Assigned by DHCP (N/A)</td>
<td>Assigned by DHCP</td>
</tr>
<tr>
<td>Gateway</td>
<td>N/A</td>
<td>Not used</td>
</tr>
<tr>
<td>DNS1</td>
<td>0.0.0.0</td>
<td>Not used</td>
</tr>
<tr>
<td>DNS2</td>
<td>0.0.0.0</td>
<td>Not used</td>
</tr>
</tbody>
</table>
Router with DHCP and Internet email

This example shows a network with email enabled and the DHCP server assigning an IP address only to the computer, not the iPackACCESS. The iPackACCESS has DHCP off, which means it has a fixed IP address. The iPackACCESS must have the same Subnet as the computer and router. The computer has DHCP enabled, so the router provides the computer with an IP address. This example has both the DNS servers enabled and the SMTP server information (set in the Schedules tab in the SymphoniePRO Desktop Application, described in section 3.3).
## Network Configuration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>iPackACCESS</th>
<th>Computer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable DHCP:</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Static IP Address</td>
<td>192.168.3.100</td>
<td>Assigned by DHCP</td>
</tr>
<tr>
<td>Subnet Mask</td>
<td>255.255.255.0</td>
<td>Assigned by DHCP</td>
</tr>
<tr>
<td>Gateway</td>
<td>192.168.3.1</td>
<td>Not used</td>
</tr>
<tr>
<td>DNS1</td>
<td>203.64.21.245</td>
<td>Not used</td>
</tr>
<tr>
<td>DNS2</td>
<td>203.64.22.123</td>
<td>Not used</td>
</tr>
</tbody>
</table>

### Networking Considerations

- Modbus default port is 502 but iPackACCESS can be configured to use any port number.
- iPackACCESS supports DHCP for automatic configuration of network address.
- If DHCP is disabled on either the iPackACCESS or the PC, you will need to manually edit the Static IP Address, Subnet Mask, and Gateway IP Address on that device. Your IT administrator may be able to assist you with assigning the appropriate addresses.
- As a security feature, the iPackACCESS can be configured to limit the allowed connections.
- iPackACCESS implements a standard 10baseT Ethernet interface that can auto-negotiate full or half duplex and adjust for crossover.
- iPackACCESS allows up to 4 simultaneous client connections.
- iPackACCESS allows configuration of SMTP port to accommodate different firewall settings.

### Connect to Network

Connect and secure the cable assembly to the iPackACCESS’s Ethernet port, and connect the other end to your network or to a computer running the NRG Modbus Demo Client utility.

### Verifying Network Connection

SymphoniePRO’s [Connection Status](#) screen shows Ethernet status, Network status, email status, and MetLink status. Use the right arrow to toggle between the different status screens.

The Ethernet status screen will tell you if the iPack is connected via Ethernet, as well as the type of connection (Half Duplex or Full Duplex). If no network connection is detected, the screen will display “No Link Detected”.

The Network status screen shows the IP address assigned to the iPackACCESS (either through direct assignment or DHCP) and the DNS server being used.

The Modbus status screen shows the Modbus server state and the number of clients connected.
To verify network communication, open a Command Prompt window on a computer connected to the same network as the iPackACCESS. At the command prompt, type “ping” followed by the iPackACCESS’s IP Address, and hit Enter. The display should show successful communication with no packet loss.

Once successful connection and communication have been verified, start your Modbus client and make sure that it communicates successfully.

**NRG Modbus Demo Client**

The NRG Modbus Demo Client communicates with the iPackACCESS via Modbus and can be used to poll the Modbus registers of the iPackACCESS. The purpose of this demo application is to provide a simple way to verify network connectivity and test data streams from each attached sensor.

The NRG Modbus Demo Client is included in the installation of SymphoniePRO Desktop Application and can be found in Document\Renewable NRG Systems\Utilities after the first time SymphoniePRO Desktop Application is run. The Modbus Demo Client can also be downloaded from the NRG website: [http://www.nrgsystems.com/services-support/documentation-and-downloads/software-downloads](http://www.nrgsystems.com/services-support/documentation-and-downloads/software-downloads).
This application can be run directly from the executable file, with no installation required. It can be run directly from a USB drive or from a network file server, making it easy to test from any location on the network without the need for Administrator rights and program installations.

**Checking iPack status**

The iPack status can be verified through the iPack ([Home][2][2]) menu on the SymphoniePRO logger’s LCD screen. Refer to Section 3.5. of the SymphoniePRO manual for more details about the menu options.

**Using the Modbus Demo Client**

Start the application by double-clicking the NRGModbusDemoClient.exe file. Make sure SymphoniePRO + iPackACCESS is selected from the Modbus Server Type dropdown.

Enter the active IP Address of the iPackACCESS (the iPackACCESS’s IP address can be found by pressing [Home][2][2][2] on the logger’s keypad and pressing the right arrow to get to the Network status screen). Change the Port number, if you are using a port other than 502.

By default, the Modbus Demo Client will display all Modbus registers. You can choose to only look at a certain set of registers by selecting a different Register Block from the dropdown.

Press the Start Modbus Client to begin polling the iPackACCESS registers.

Since the iPackACCESS can support multiple Modbus clients, this application can be used simultaneously with other Modbus clients, which may be helpful in debugging the setup of Modbus tag information in the end user application.

**Modbus Protocol**

The iPackACCESS follows Modbus Application Protocol Specification V1.1b. The standard exception codes in the table below are supported.

<table>
<thead>
<tr>
<th>Code</th>
<th>Name</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>ILLEGAL FUNCTION</td>
<td>The function code is not supported by the iPackACCESS or is not in the correct state to be able to perform the function.</td>
</tr>
<tr>
<td>02</td>
<td>ILLEGAL DATA ADDRESS</td>
<td>An address in the requested data range is not an allowable address.</td>
</tr>
<tr>
<td>03</td>
<td>ILLEGAL DATA VALUE</td>
<td>The value in the data field is not allowable by the iPackACCESS.</td>
</tr>
<tr>
<td>04</td>
<td>SLAVE DEVICE FAILURE</td>
<td>An unrecoverable error occurred when the iPackACCESS was performing the request.</td>
</tr>
</tbody>
</table>
**Input Register Data and Addressing**

The iPackACCESS only supports the “Input Register” and “Holding Register” primary tables. Therefore, only Modbus function 3 and 4 will be supported. These functions are read-only. The client will request that the input register or holding register table be read by sending function 3 or 4, the start address, and the number of registers that it would like to read.

The Modbus registers are organized into contiguous address blocks, so that the client can easily query an entire block of one particular type of data. The blocks and their starting addresses are listed below, and a more complete list of registers is provided in the tables in the following section.

Configuration Information: Address 0

Real-time (one-second) scaled data: Address 1500

Statistical scaled data: Address 2500

Diagnostic data: Address 3000

Each Modbus register holds 16 bits of data. For data that is larger than 16 bits, it will be split among multiple registers in big endian format. For example, all sensor data are represented in 32-bit floating point format. Each of these values is contained in two Modbus registers, where the first register contains the most significant half of the word and the second register contains the least significant half. A list of register addresses is provided below.

A timestamp is provided for each block of data. The real-time data timestamp is the latest timestamp sent from the logger. The statistical data timestamp is the time at the beginning of the last calculated interval. Each timestamp has the year, month, day, hour, minute, and seconds stored in a different register in this sequence.

In the statistical data block, each channel contains a pair of registers for each type of statistic: average or total, standard deviation, maximum, minimum, and maximum gust (anemometer channels only), in that order. Channel 1’s first register starts after the last timestamp register.

### Modbus Registers

<table>
<thead>
<tr>
<th>Modbus Register Address</th>
<th>Number of Registers</th>
<th>Description of Data</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>2</td>
<td>32 bit Floating point representation of the number 12345678</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description</td>
<td>Data Type</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------</td>
</tr>
<tr>
<td>2</td>
<td>2</td>
<td>Unsigned 32 bit representation of the number 123456789.</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Unsigned 16 bit representation of the number 12345</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>Site Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>7</td>
<td>2</td>
<td>Logger Serial Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>9</td>
<td>1</td>
<td>Logger Model Number</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>10</td>
<td>2</td>
<td>Logger Model Version Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>12</td>
<td>2</td>
<td>Logger Firmware Version Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>14</td>
<td>2</td>
<td>iPack Serial Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>16</td>
<td>1</td>
<td>iPack Model Number</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>17</td>
<td>2</td>
<td>iPack Model Version Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>19</td>
<td>2</td>
<td>iPack Firmware Version Number</td>
<td>Unsigned 32 bit Integer</td>
</tr>
</tbody>
</table>

**Scaled Real-Time (1 Second) Data for Physical Channels**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1500</td>
<td>1</td>
<td>Real Time Year</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1501</td>
<td>1</td>
<td>Real Time Month</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1502</td>
<td>1</td>
<td>Real Time Day</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1503</td>
<td>1</td>
<td>Real Time Hour</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1504</td>
<td>1</td>
<td>Real Time Minute</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1505</td>
<td>1</td>
<td>Real Time Second</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>1506</td>
<td>52</td>
<td>Array of scaled one second data for all 26 physical channels.</td>
<td>Array of 32 bit Floating Point numbers</td>
</tr>
</tbody>
</table>
### Scaled Statistical Data for Physical Channels

<table>
<thead>
<tr>
<th>Code</th>
<th>Count</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>2500</td>
<td>1</td>
<td>Statistical Interval Year</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2501</td>
<td>1</td>
<td>Statistical Interval Month</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2502</td>
<td>1</td>
<td>Statistical Interval Day</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2503</td>
<td>1</td>
<td>Statistical Interval Hour</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2504</td>
<td>1</td>
<td>Statistical Interval Minute</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2505</td>
<td>1</td>
<td>Statistical Interval Second</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>2506</td>
<td>2</td>
<td>Counter Channel 1 Average or Total</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2508</td>
<td>2</td>
<td>Counter Channel 1 Standard Deviation</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2510</td>
<td>2</td>
<td>Counter Channel 1 Maximum</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2512</td>
<td>2</td>
<td>Counter Channel 1 Minimum</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2514</td>
<td>2</td>
<td>Counter Channel 1 Maximum Gust</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Repeat for 11 more Counter Channels</strong></td>
<td></td>
</tr>
<tr>
<td>2626</td>
<td>2</td>
<td>Analog Channel 1 Average</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2628</td>
<td>2</td>
<td>Analog Channel 1 Standard Deviation</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2630</td>
<td>2</td>
<td>Analog Channel 1 Maximum</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>2632</td>
<td>2</td>
<td>Analog Channel 1 Minimum</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Repeat for 13 more Analog Channels</strong></td>
<td></td>
</tr>
</tbody>
</table>

### Diagnostic Data

<table>
<thead>
<tr>
<th>Code</th>
<th>Count</th>
<th>Description</th>
<th>Data Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>3000</td>
<td>1</td>
<td>Real Time Year</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Description</td>
<td>Format</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>--------------------------------------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>3001</td>
<td>1</td>
<td>Real Time Month</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3002</td>
<td>1</td>
<td>Real Time Day</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3003</td>
<td>1</td>
<td>Real Time Hour</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3004</td>
<td>1</td>
<td>Real Time Minute</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3005</td>
<td>1</td>
<td>Real Time Second</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3006</td>
<td>2</td>
<td>Temperature (Celcius)</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>3008</td>
<td>2</td>
<td>12V Nominal Battery Voltage (Volts)</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>3010</td>
<td>2</td>
<td>12V Nominal Battery Current to Sensors (mA)</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>3012</td>
<td>2</td>
<td>2V Nominal DCell or iPack Voltage (V)</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>3014</td>
<td>2</td>
<td>5V Current to Sensors (mA)</td>
<td>32 bit Floating Point</td>
</tr>
<tr>
<td>3016</td>
<td>1</td>
<td>Is an SD card loaded in the logger (1)True/(0)False</td>
<td>Unsigned 16 bit Integer</td>
</tr>
<tr>
<td>3017</td>
<td>2</td>
<td>Free Memory in the SD Card in KB</td>
<td>Unsigned 32 bit Integer</td>
</tr>
<tr>
<td>3019</td>
<td>2</td>
<td>Used Memory in the SD Card in KB</td>
<td>Unsigned 32 bit Integer</td>
</tr>
</tbody>
</table>
APPENDIX G | GROUNDING & LIGHTNING PROTECTION

Meteorological sensors, loggers, and towers accumulate static electrical charge unless they are properly grounded. High winds, low humidity, and the height of the tower above ground increase the rate of charge accumulation. Charge continues to accumulate until the developed voltage difference, sometimes thousands of volts relative to ground, causes dielectric breakdown and an electrostatic discharge (ESD). ESD will damage any scientific instrument or sensor, including NRG loggers, NRG 40C anemometers, or NRG 200P wind vanes. By attaching an NRG logger or other instrument to a properly grounded TallTower™, and sensors to the logger, the logger and sensors will also be electrically grounded.

**Note - Properly grounding your system helps protect your sensors, your wind measurement instruments, and your wind data! It is your responsibility to provide proper earth grounding for the tower, logger, and sensors. All warranties on NRG instruments and sensors are voided if your system is not properly grounded.**

For many sites, the NRG grounding kit provides all the needed parts to earth ground your TallTower™ and instrumentation. The grounding kit includes a copper-clad lightning spike, copper ground wire, and two copper clad ground rods. Determine the soil type and classify its resistivity. The lower the resistivity, the better the earth ground.

<table>
<thead>
<tr>
<th>Soil Type</th>
<th>Average Soil Resistivity per cm (Ohms-cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Ashes, cinders, brine, waste</td>
<td>2370</td>
</tr>
<tr>
<td>2. Clay, shale, gumbo, loam</td>
<td>4060</td>
</tr>
<tr>
<td>3. Same, with varying proportions of sand and gravel</td>
<td>15800</td>
</tr>
<tr>
<td>4. Gravel, sand, stones with little clay or loam</td>
<td>94000</td>
</tr>
</tbody>
</table>

The grounding kit will perform adequately in type 1 and 2 soils. For other soil types, or for sites with a high incidence of lightning, you will need to augment the earth grounding system. Consult NRG for more information.

**Installation**

The grounding kit is usually installed before the sensors and sensor cabling in a new installation, but may also be retro-fitted to an existing tower installation. Refer to the drawing on the next page. To install the grounding kit:

1. Drive the two ground rods through the holes provided in the TallTower™ baseplate when laying out the tower. Leave enough of each rods above the baseplate to attach the ground wires.

2. Raise the TallTower™ slightly off the ground. Attach the top end of the copper ground wire to the lightning spike using one of the supplied ground clamps. Mount the lightning spike to the tower using the two supplied stainless steel band clamps.

3. Unwind the ground wire to the base of the tower, wrapping the wire around the tower in a downward spiral, turn every 6 meters (20 feet) as shown in the figure. Tape the wire securely to the tower every 1 to 2 meters (3 to 6 feet) to prevent the wire being damaged by wind motion or icing.
4. For best protection, mount all sensors below a 45° cone from the lightning spike, as shown in the drawing below. Sensors on top-mount or Z booms may be at the top of the tower. For sensors on side mount booms, keep the boom at least 0.6 m (2 feet) below the top of the tower.

5. Attach the bottom end of the ground wire to BOTH ground rods using the supplied clamps. This is easiest if the first clamp is threaded over the end of the ground wire before leading the wire to the second clamp.
6. Ground your NRG logger. Connect the logger grounding cable supplied with the logger from the wiring panel’s grounding post to one of the ground rods, using the same ground clamp as for the tower ground. Cut the ground wire to the required length; do not roll or coil any excess length of ground wire. Ground the logger immediately after mounting it to the TallTower™ and prior to connecting the sensors to the wiring panel.
NRG Systems prides itself on our 30 year history of producing very low-power consumption data loggers that can be left to run autonomously for years with just a small PV attached to the iPack. The SymphoniePRO logger has many new features, including additional channel capacity. SymphoniePRO therefore uses more power than a SymphoniePLUS3 and requires a higher output PV panel (sold separately). If using the SymphoniePRO like a SymphoniePLUS3 (daily logger initiated calls), there will not be an appreciable performance difference, and the standard iPack and PV panel will provide autonomous power for latitudes below 45 degrees.

Because the SymphoniePRO supports remote connections where a user can remotely monitor and update a logger, the logger system may spend more time with the modem on than previous Symphonie models (depending on the frequency of such activity). This communication preference, along with sensor preferences, are the two main drivers of overall power consumption for the fielded system.

**Sensor Power - Anemometers**
Anemometers provided by NRG Systems such as the NRG Class 1, NRG 40C, and Windsensor P2546C-OPR sensors do not consume any power. This is because these sensors utilize a robust and simple coil and magnet pickup system, which generates its own power. Optical scanning anemometers will consume power, and this consumption can add up when using several such sensors. For example, Thies First Class and Vector anemometers will consume about 15.6 mW each.

**Sensor Power – Analog Sensors**
Analog sensors provided by NRG Systems are designed with power consumption in mind. For example, the NRG 110S temperature sensor draws under 200 micro-amperes of current, and because the sensor can be turned off between one-second readings, it only consumes 0.05 mW. The NRG BP20 barometric pressure sensor consumes 2.9 mW, and the NRG RH5X relative humidity sensor consumes 31.2 mW of power. The NRG 200P vane effectively draws no appreciable power.

**System Example**
For some perspective, let’s consider a meteorological tower outfitted with 4 NRG Class 1, 3 Thies FCA, 3 NRG 200P vanes, 2 NRG 110S temperature sensors, 1 NRG BP20 and 1 NRG RH5X. If this system were to come on once per day, transmit data to the office and then stay online in “listening mode” for the remainder of 10 minutes, the SymphoniePRO system would consume about 20% more power than a SymphoniePLUS3 equipped tower. Note the SymphoniePLUS3 would call in and download the data without any listening mode available, and if the SymphoniePRO listening time were decreased, the power consumption would also decrease. Because the standard NRG PV panel power output has been increased by over 100% for the SymphoniePRO system, this situation presents no issues. Testing reveals that for latitudes below 45 degrees, a SymphoniePRO could be configured to make 12 such calls per day, even with an extra NRG RH5X and NRG BP20 connected and maintain autonomy.

Because iPackGPS has extra terminals to add PV and battery, the SymphoniePRO system is flexible enough for use in higher latitudes by adding external battery power. The PV inputs only charge the internal battery, so
even if an external battery is connected, a PV larger than 20 Watts connected to the logger does not increase available power. The external battery terminals should be utilized for locations that experience long periods of darkness. Again, the usage will follow closely the solutions already in place for the SymphoniePLUS3.
APPENDIX I | WARRANTY

NRG Systems (NRG) warrants its products for a period of two years from date of original purchase solely for the benefit of the original consumer purchaser. If this product is determined to be defective in materials or workmanship, NRG will, at NRG’s option, repair or replace this product without charge. This warranty does not cover damage due to improper installation or use, accident or misuse, damages due to any unauthorized service or lightning. This warranty also will not apply if any seal on any instrument or sensor is broken, if any cable has been severed, or the equipment was not adequately grounded.

To return a defective product, request an RMA (return merchandise authorization) number by calling us at the number below or by emailing support@nrgsystems.com, or by submitting a request through our website’s Technical Services area.

Please provide the serial number of the item as well as date of purchase. No products will be accepted for warranty work without an RMA number. The product must be returned, postage prepaid, to NRG with a brief description of the problem, RMA number and a return address with phone number.

The foregoing limited warranty is given in lieu of all other warranties, express or implied. NRG specifically disclaims all implied warranties including, but not limited to, any implied warranties of merchantability and fitness for a particular purpose.

The above limited warranty expressly excludes, and NRG shall not be liable for, any incidental or consequential damages caused by or related to the selection, use of, inability to use or malfunction of this product.

NRG will make a good faith effort to repair or replace promptly any product which proves to be defective within the warranty period. First, contact NRG or the representative from whom the product was purchased and ask for an RMA number. Inspect your shipments for damage to packages or missing packages immediately upon receipt. Record any such exceptions on the freight receipt of the delivery agent. If any contents are damaged or missing, report this in writing to the freight carrier and send NRG a copy of the damage report. If you insured the shipment yourself, report any damages to your insurance carrier.

Sending Items for Repair

*International Customers*

Contact NRG Systems by phone, email, or through our website to obtain an RMA number (Return Material Authorization). Write the RMA number clearly on all shipping cartons.

Tel: 802-482-2255
Fax: 802-482-2272

Email: support@nrgsystems.com
Website: https://www.nrgsystems.com/technical-support

Before sending the repair item to NRG Systems, check with your local customs authorities about provisions in your country for exporting and re-importing repair items. Some countries treat repair shipments like new...
shipments and charge import duties and taxes again upon re-importation. Other countries have specific steps to follow or specific forms to complete which help reduce the import duties upon re-import of the item.

Send your item to NRG Systems "Delivery Duty Paid" (see address below) using a door-to-door courier service such as UPS, FedEx, or DHL. If the repair is not urgent, please send your package by Airmail. (Courier services deliver the package directly to us, customs cleared.)

**NRG Systems will not accept packages shipped Freight Collect or with Collect charges.**

If NRG Systems refuses the shipment, the courier service will charge your account return freight charges.

**DO NOT send return items by direct or consolidated air freight service with an airline.**

The cost for air freight may seem lower than the courier service, but air freight costs do not include customs clearance, airport handling, break bulk fees, and inland delivery to NRG Systems.

Attach a **Commercial Invoice** to the carton. The Commercial Invoice should include the following information:

- Name and address of the shipper.
- NRG Systems' complete address and telephone number as the consignee.
- Description of the items being returned.
- Quantity of each item being returned.
- Value for customs / insurance (purchase price or replacement cost).
- Number of cartons with respective weights and dimensions.

Please include the following statement to avoid paying US import duties:

"These items are being returned to their U.S. manufacturer. Country of manufacture and origin is USA, HTS CODE 9801.00.1012."

Pack your repair item in a sturdy packing carton. Tag each item with a brief description of the problem.

Insure your shipment against damage or loss in transit. Be sure to check the appropriate box and enter a "Value for Carriage" (insurance) on your air waybill. The value is the purchase price of the equipment or what it would cost to replace the equipment if the shipment were lost. Keep a record of the tracking number.

Once your item arrives, we will assess the item and notify you of the repair cost. Any repair charges and freight costs, if applicable, are payable before NRG Systems will return the repaired item to you via door-to-door courier service. NRG Systems will send you a shipment advisement when the repaired item is shipped.

**US Customers**

Please see items 1, 4, and 5 above. Send your item(s) to NRG Systems “Freight Prepaid and Insured.” **Shipments sent freight collect will not be accepted by NRG Systems.**
## APPENDIX J | TECHNICAL SPECIFICATIONS

<table>
<thead>
<tr>
<th>SymphoniePRO Data Logger</th>
<th>SymphoniePRO Data Logger</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>26-Channel (#8547)</strong></td>
<td><strong>16-Channel (#11270)</strong></td>
</tr>
</tbody>
</table>

### DESCRIPTION

<table>
<thead>
<tr>
<th>Instrument type</th>
<th>26 channel internet-enabled micropower data logger for the renewable energy industry</th>
<th>16 channel internet-enabled micropower data logger for the renewable energy industry</th>
</tr>
</thead>
<tbody>
<tr>
<td>Applications</td>
<td>Wind and solar resource assessment, power performance monitoring, and forecasting</td>
<td>Wind and solar resource assessment, power performance monitoring, and forecasting</td>
</tr>
<tr>
<td>Instrument compatibility</td>
<td>Symphonie iPack Communication + Power Modules:</td>
<td>Symphonie iPack Communication + Power Modules:</td>
</tr>
<tr>
<td></td>
<td>iPackGPS</td>
<td>GSM/GPRS</td>
</tr>
<tr>
<td></td>
<td>iPackGPS</td>
<td>3G GSM</td>
</tr>
<tr>
<td></td>
<td>iPackGPS</td>
<td>CDMA</td>
</tr>
<tr>
<td></td>
<td>iPackACCESS</td>
<td>BGAN M2M Satellite</td>
</tr>
<tr>
<td></td>
<td>iPackACCESS</td>
<td>Modbus TCP</td>
</tr>
</tbody>
</table>

### DATA COLLECTION

<table>
<thead>
<tr>
<th>Sampling interval</th>
<th>1 Hz (IEC 61400-12-1 compliant)</th>
<th>1 Hz (IEC 61400-12-1 compliant)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Averaging interval</td>
<td>10-minute by default; user-selectable alternatives (1, 2, 5, 10, 15, 30, and 60 minutes)</td>
<td>10-minute by default; user-selectable alternatives (1, 2, 5, 10, 15, 30, and 60 minutes)</td>
</tr>
<tr>
<td></td>
<td>SymphoniePRO Data Logger</td>
<td>SymphoniePRO Data Logger</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>--------------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td></td>
<td>26-Channel (#8547)</td>
<td>16-Channel (#11270)</td>
</tr>
<tr>
<td>Real time clock</td>
<td>Internal battery-backed with GPS or internet time synchronization (with iPack)</td>
<td>Internal battery-backed with GPS or internet time synchronization (with iPack)</td>
</tr>
<tr>
<td>Storage medium</td>
<td>User-selectable storage of statistical data with optional storage of raw (1 Hz) sample data</td>
<td>User-selectable storage of statistical data with optional storage of raw (1 Hz) sample data</td>
</tr>
<tr>
<td></td>
<td>8 MB internal flash memory</td>
<td>8 MB internal flash memory</td>
</tr>
<tr>
<td></td>
<td>Options for either 512 MB or 2 GB SD card</td>
<td>Options for either 512 MB or 2 GB SD card</td>
</tr>
<tr>
<td>Channel Capacity</td>
<td>12 counter channels</td>
<td>Eight (8) counter channels</td>
</tr>
<tr>
<td></td>
<td>14 analog channels: 7 built-in, 7 configurable with signal conditioning modules (P-SCMs)</td>
<td>Eight (8) analog channels: Five (5) built-in, Three (3) configurable with signal conditioning modules (P-SCMs)</td>
</tr>
<tr>
<td>Counter Channels Sensor Compatibility</td>
<td>Compatible with a wide array of industry-standard anemometers including: NRG 40C, Class 1, or compatible sine wave anemometers Opto anemometers Reed switch anemometers Other frequency signals up to 2,500 Hz, 12 V excitation is provided by logger Includes totalizer mode for Tipping Bucket Rain Gauge and other accumulator sensors</td>
<td>Compatible with a wide array of industry-standard anemometers including: NRG 40C, Class 1, or compatible sine wave anemometers Opto anemometers Reed switch anemometers Other frequency signals up to 2,500 Hz, 12 V excitation is provided by logger Includes totalizer mode for Tipping Bucket Rain Gauge and other accumulator sensors</td>
</tr>
<tr>
<td>Analog Channels Sensor Compatibility</td>
<td>SymphoniePRO Data Logger</td>
<td>26-Channel (#8547)</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------</td>
<td>--------------------</td>
</tr>
<tr>
<td></td>
<td>Compatible with a wide array of sensors including:</td>
<td>Compatible with a wide array of sensors including:</td>
</tr>
<tr>
<td></td>
<td>NRG standard analog sensors (200P Wind Direction Vane, 110S Temperature, BP20 Barometric Pressure, RH5X Relative Humidity, etc.)</td>
<td>NRG standard analog sensors (200P Wind Direction Vane, 110S Temperature, BP20 Barometric Pressure, RH5X Relative Humidity, etc.)</td>
</tr>
<tr>
<td></td>
<td>Industry-standard pyranometers (Li-Cor LI-200SZ, Hukseflux LP02, SR11, SR12, SR20, Kipp &amp; Zonen CMP3, CMP11, CMP21)</td>
<td>Industry-standard pyranometers (Li-Cor LI-200SZ, Hukseflux LP02, SR11, SR12, SR20, Kipp &amp; Zonen CMP3, CMP11, CMP21)</td>
</tr>
<tr>
<td></td>
<td>Wide range of other compatible sensors, individually verified upon request</td>
<td>Wide range of other compatible sensors, individually verified upon request</td>
</tr>
<tr>
<td>Built-in channels 13-15: 0 to 5 V Analog; 2.5 or 5 V excitation; no P-SCMs required</td>
<td>Three (3) Built-in channels: 0 to 5 V Analog; 2.5 or 5 V excitation; no P-SCMs required</td>
<td></td>
</tr>
<tr>
<td>Built-in channels 16-19: 0 to 5 V Analog; 5 or 12 V excitation; no P-SCMs required</td>
<td>Two (2) Built-in channels: 0 to 5 V Analog; 5 or 12 V excitation; no P-SCMs required</td>
<td></td>
</tr>
<tr>
<td>P-SCM Channels 20-26 (signal range dependent on individual P-SCM card)</td>
<td>Three (3) P-SCM Channels: signal range dependent on individual P-SCM card</td>
<td></td>
</tr>
<tr>
<td>Analog Measurement Accuracy</td>
<td>0.04% of full scale</td>
<td>0.04% of full scale</td>
</tr>
<tr>
<td>RS-485 Channels Sensor Compatibility</td>
<td>Not currently available</td>
<td>n/a</td>
</tr>
<tr>
<td>Parameters recorded for each channel</td>
<td>SymphoniePRO Data Logger</td>
<td>26-Channel (#8547)</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>--------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Average</td>
<td>Average</td>
<td>Average</td>
</tr>
<tr>
<td>Standard Deviation</td>
<td>Standard Deviation</td>
<td>Standard Deviation</td>
</tr>
<tr>
<td>Minimum / Maximum 1-sec sample</td>
<td>Minimum / Maximum 1-sec sample</td>
<td>Minimum / Maximum 1-sec sample</td>
</tr>
<tr>
<td>Maximum 3-sec gust with direction</td>
<td>Maximum 3-sec gust with direction</td>
<td>Maximum 3-sec gust with direction</td>
</tr>
<tr>
<td>Sum for totalizer inputs</td>
<td>Sum for totalizer inputs</td>
<td>Sum for totalizer inputs</td>
</tr>
<tr>
<td><em>Note - Statistics reported on each channel dependent on measurement type</em></td>
<td><em>Note - Statistics reported on each channel dependent on measurement type</em></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Data delivery</th>
<th>Automated delivery via iPack</th>
<th>Automated delivery via iPack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Direct live connection through iPack</td>
<td>Direct live connection through iPack</td>
<td></td>
</tr>
<tr>
<td>USB connection</td>
<td>USB connection</td>
<td></td>
</tr>
<tr>
<td>Read from SD card</td>
<td>Read from SD card</td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Security</th>
<th>Logger access PIN with 2-day lockout after 8 failed attempts</th>
<th>Logger access PIN with 2-day lockout after 8 failed attempts</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>128-bit data file encryption with user-specified password</td>
<td>128-bit data file encryption with user-specified password</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>RESOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog measurement resolution</td>
</tr>
</tbody>
</table>

SOFTWARE
<table>
<thead>
<tr>
<th>SymphoniePRO Data Logger</th>
<th>SymphoniePRO Data Logger</th>
</tr>
</thead>
<tbody>
<tr>
<td>26-Channel (#8547)</td>
<td>16-Channel (#11270)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Type</th>
<th>Windows (7 or later) compatible application</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capabilities</td>
<td>Import data files</td>
</tr>
<tr>
<td></td>
<td>Output tabular text files</td>
</tr>
<tr>
<td></td>
<td>Configure SymphoniePRO data loggers and Symphonie iPacks</td>
</tr>
<tr>
<td></td>
<td>Store configuration files for repeat programming</td>
</tr>
<tr>
<td></td>
<td>View live data including diagnostics via remote connections</td>
</tr>
<tr>
<td></td>
<td>Manage automated connections</td>
</tr>
<tr>
<td></td>
<td>Administer firmware updates to SymphoniePRO data loggers and Symphonie iPacks</td>
</tr>
<tr>
<td></td>
<td>Integrate with enterprise-level programs via command line mode</td>
</tr>
<tr>
<td></td>
<td>Includes integrated map and exports KML files</td>
</tr>
</tbody>
</table>

**CONFIGURATION**

<table>
<thead>
<tr>
<th>User interface</th>
<th>SymphoniePRO Desktop Application</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>LCD with 16 button keypad with audible feedback</td>
</tr>
<tr>
<td></td>
<td>SymphoniePRO Desktop Application</td>
</tr>
<tr>
<td></td>
<td>LCD with 16 button keypad with audible feedback</td>
</tr>
<tr>
<td>**SymphoniePRO Data Logger</td>
<td>** 26-Channel (#8547)</td>
</tr>
<tr>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td><strong>Configurable parameters</strong></td>
<td>All parameters configured with PC using SymphoniePRO Desktop Application through MetLink connection (USB or TCP/IP)</td>
</tr>
<tr>
<td><strong>CONNECTIONS</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Sensor wiring</strong></td>
<td>Sensors connected to wiring panel</td>
</tr>
<tr>
<td></td>
<td>Field wiring panel mounted in shelter box connected to logger via interconnect cable</td>
</tr>
<tr>
<td></td>
<td>Ground stud connects to earth ground with included ground cable</td>
</tr>
<tr>
<td><strong>Expansion slots</strong></td>
<td>Seven (7) signal conditioning module slots accept analog P-SCMs</td>
</tr>
<tr>
<td><strong>Communication ports</strong></td>
<td>Dedicated USB-B port on logger faceplate for configuration</td>
</tr>
<tr>
<td></td>
<td>Dedicated male DB25 interfaces to one optional iPack communications module</td>
</tr>
<tr>
<td></td>
<td>Two (2) RS-485 serial communication ports on wiring panel</td>
</tr>
<tr>
<td>Batteries</td>
<td>SymphoniePRO Data Logger</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------------------</td>
</tr>
<tr>
<td></td>
<td>Two (2) 1.5 volt D-Cell batteries (included with logger)</td>
</tr>
<tr>
<td>External power input</td>
<td>Provided by iPack</td>
</tr>
<tr>
<td>External solar input</td>
<td>Provided by iPack</td>
</tr>
<tr>
<td>External power output</td>
<td>Provided by iPack (iPackACCESS only)</td>
</tr>
</tbody>
</table>

**INSTALLATION**

<table>
<thead>
<tr>
<th>Mounting</th>
<th>SymphoniePRO Data Logger</th>
<th>26-Channel (#8547)</th>
<th>SymphoniePRO Data Logger</th>
<th>16-Channel (#11270)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Logger and iPack attach to logger mounting bracket; Keyed slots allow for easy installation/removal in shelter box</td>
<td>Wiring panel mounts separately to shelter box back plate with four (4) Phillips 10-32 x 0.5 in. screws</td>
<td>Logger and iPack attach to logger mounting bracket; Keyed slots allow for easy installation/removal in shelter box</td>
<td>Wiring panel mounts directly to Logger with two screws</td>
</tr>
<tr>
<td>Tools required</td>
<td>Screwdriver for wiring input terminals (included)</td>
<td></td>
<td>Screwdriver for wiring input terminals (included)</td>
<td></td>
</tr>
</tbody>
</table>
### SymphoniePRO Data Logger | 26-Channel (#8547)

- 8 mm (5/16 in.) wrench or nut driver for mounting screws and logger ground lug

### SymphoniePRO Data Logger | 16-Channel (#11270)

- 8 mm (5/16 in.) wrench or nut driver for mounting screws and logger ground lug

#### ENVIRONMENTAL

<table>
<thead>
<tr>
<th></th>
<th>SymphoniePRO Data Logger</th>
<th>SymphoniePRO Data Logger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature range</td>
<td>-40 °C to 65 °C (-40 °F to 149 °F)</td>
<td>-40 °C to 65 °C (-40 °F to 149 °F)</td>
</tr>
<tr>
<td>Operating humidity range</td>
<td>0 to 100% relative humidity non-condensing</td>
<td>0 to 100% relative humidity non-condensing</td>
</tr>
</tbody>
</table>

#### PHYSICAL

<table>
<thead>
<tr>
<th></th>
<th>SymphoniePRO Data Logger</th>
<th>SymphoniePRO Data Logger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weight</td>
<td>1.3 Kg (2.6 lbs) including batteries</td>
<td>1.3 Kg (2.6 lbs) including batteries</td>
</tr>
<tr>
<td>Dimensions</td>
<td>Logger = 22.2 cm x 18.7 cm x 7.4 cm (8.7 in. x 7.4 in. x 2.9 in.)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Wiring panel = 30 cm x 12 cm x 5 cm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>40.6 cm (16 in.) interconnect cable</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Logger (including wiring panel): 22.2 cm x 20.1 cm x 7.6 cm (8.7 in. x 7.9 in. x 3.0 in.)</td>
<td></td>
</tr>
</tbody>
</table>

#### MATERIALS

<table>
<thead>
<tr>
<th></th>
<th>SymphoniePRO Data Logger</th>
<th>SymphoniePRO Data Logger</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wiring panel</td>
<td>Formed aluminum enclosure, zinc-plated screws and terminals</td>
<td>Black ABS enclosure</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Zinc-plated screws and terminals</td>
</tr>
<tr>
<td>Enclosure</td>
<td>Weatherproof polycarbonate</td>
<td>Weatherproof polycarbonate</td>
</tr>
</tbody>
</table>
APPENDIX K | REFERENCES

Some of our products incorporate software that is available in the open source community, including www.freertos.org (version 6.00) and www.savannah.nongnu.org. The information that follows is provided to comply with the terms of use.

www.freertos.org

FreeRTOS is a real time operating system available in the open source community and utilized in SymphoniePRO firmware. Source code is available from NRG upon request.

www.savannah.nongnu.org

The lwIP lightweight TCP/IP stack in the SymphoniePRO Logger.

(Copyright (c) 2001-2004 Swedish Institute of Computer Science. All rights reserved.)

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the following disclaimer in the documentation and/or other materials provided with the distribution.

The name of the author may not be used to endorse or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE AUTHOR "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Radio compliance

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation.
If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures: Re-orient or relocate the receiving antenna, increase the separation between the equipment and receiver, connect equipment and receiver to outlets on different circuits, or consult the dealer or an experienced radio/TV technician for help.
APPENDIX L | DECLARATION OF CONFORMITY

NRG Systems Declaration of Conformity

Declaration of Conformity
(in accordance with ISO/IEC 17050-1:2004)

NRG Systems Document Number: 11606, Rev B
Supplier: NRG Systems, Inc.
Supplier Address: 110 Riggs Road, Hinesburg, VT 05461, USA
Telephone: 802 482 2255, Fax: 802 482 2272
Email: sales@nrgsystems.com

Declares that the Product: SymphoniePRO Logger System, including:

<table>
<thead>
<tr>
<th>Logger-SymphoniePRO, with accessories</th>
<th>Item 8206</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-SCM Cards</td>
<td>Items 9128, 9129, 9130, 9131, 9132, 9133, 9134, 9135, 9136, 9137, 9138</td>
</tr>
<tr>
<td>Symphonie IPacks</td>
<td>Items 4620, 4621, 4622, 4623, 7189, 7984, 3146</td>
</tr>
<tr>
<td>SymphoniePRO Wiring Panels</td>
<td>Item 8150 (26 channel), 11176 (16 channel)</td>
</tr>
<tr>
<td>SymphoniePRO Interconnect Cable</td>
<td>Item 8385</td>
</tr>
<tr>
<td>Symphonie IPack Charger</td>
<td>Item 3614</td>
</tr>
<tr>
<td>DB9 Cables</td>
<td>Items 3333, 3178</td>
</tr>
<tr>
<td>Antenna, Yagi</td>
<td>Item 3124</td>
</tr>
</tbody>
</table>

is in conformity with the requirements of the following documents:

EN61326-1 Class A “Electrical Equipment for Measurement, Control, and Laboratory Use—EMC Requirements”, in accordance with: EN 55011; EN 61000-4-2; EN 61000-4-3; EN 61000-4-4; EN 61000-4-6; EN 61000-4-8;

IEC 61010-1 “Safety requirements for electrical equipment for measurement, control, and laboratory use”

DIRECTIVE 2011/65/EU on the restriction of the use of certain hazardous substances in electrical and electronic equipment

Additional Information:
This product complies with the requirements of the applicable directives 2004/108/EC, 2011/65/EU, and standard EN 61010-1 and therefore, the product is CE marked in accordance with 93/68/EEC.

FCC compliance is demonstrated with compliant CISPR data.

The design documentation, test reports, and assessment laboratory accreditation are under document control in Renewable NRG Systems Engineering.

 Issued at Hinesburg, VT, USA
 28 June 2017

Wallace E. Lafferty / VP of Engineering
APPENDIX M | SYMPHONIEPRO TEXT FILE FORMATS

Text File Export Types
This section describes the format of the text file exports. There are four types of export available:

- Measurements
- Diagnostic
- Events
- Communication

Export Conventions
This section describes the conventions used in this document to describe the export format.

Words enclosed in {curly braces} indicate fields that are always included.

Words enclosed in [square brackets] indicate optional content, which is driven by the configuration of the site or channel.

Words enclosed in (parentheses) indicate non-printing characters. In cases where the line is too long to fit on the page, the line is wrapped and a two-character indent is used.

All dates are specified in YYYY-MM-DD [HH:MM:SS] format, in local time.

Field Descriptions
The following table describes the fields used in the exports, which are described in the following sections. Header names have been repeated across page breaks for convenience.

<table>
<thead>
<tr>
<th>Field Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export Generation Timestamp</td>
<td>The date and time the export was generated.</td>
<td>2012-12-04 13:43:29</td>
</tr>
<tr>
<td>Software Version</td>
<td>The version of the utility running when the export was generated.</td>
<td>1.0.0.197 (build 17354, 2013-12-04)</td>
</tr>
<tr>
<td>Site Number</td>
<td>The number of the site.</td>
<td>000023</td>
</tr>
<tr>
<td>Site Description</td>
<td>The description of the site.</td>
<td>Windy Knoll</td>
</tr>
<tr>
<td>Project</td>
<td>The project description of the site.</td>
<td>New Development 23</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Location Description</td>
<td>The location description of the site.</td>
<td>Mt. Mansfield, north ridge</td>
</tr>
<tr>
<td>Tower</td>
<td>The tower description of the site</td>
<td>NRG 60m XHD</td>
</tr>
<tr>
<td>Site Units</td>
<td>The units setting of the site</td>
<td>Imperial</td>
</tr>
<tr>
<td>Data Type</td>
<td>The type of data contained in the export: Measurements, Measurements (Turkish), Diagnostic, Events, and Communication.</td>
<td>Measurements</td>
</tr>
<tr>
<td>Start Date</td>
<td>The start timestamp specified in the query. If time is omitted, 00:00:00 is assumed. If no date is specified when creating the export (full range), then this will be blank.</td>
<td>2012-12-01</td>
</tr>
<tr>
<td>End Date</td>
<td>The end timestamp specified in the query. If time is omitted, 00:00:00 is assumed. If no date is specified when creating the export (full range), then this will be blank.</td>
<td>2012-12-04</td>
</tr>
<tr>
<td>Export Mode</td>
<td>The mode used for the export: Scaled, Sensor, P-SCM, Unscaled, Normal, Include Parameters. This field is hidden unless the mode does not match the default for the given export type.</td>
<td>Scaled</td>
</tr>
<tr>
<td>Coordinate System</td>
<td>The coordinate system used by NRG equipment</td>
<td>Always WGS84</td>
</tr>
<tr>
<td>Site Latitude</td>
<td>Latitude of site in signed degrees format.</td>
<td>34.2036866</td>
</tr>
<tr>
<td>Site Longitude</td>
<td>Longitude of site in signed degrees format.</td>
<td>-96.387250</td>
</tr>
<tr>
<td>Site Elevation</td>
<td>Elevation of site in meters or feet.</td>
<td>1102</td>
</tr>
<tr>
<td>Time Zone</td>
<td>Site time zone. All data is stored in UTC time, but displayed in plots and exported in local time as indicated by the selected time zone.</td>
<td>UTC-4:00</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Logger Start Date</td>
<td>The timestamp that the logger with this serial number was detected in the datastream</td>
<td>2014-01-01 12:34:56</td>
</tr>
<tr>
<td>Logger Model</td>
<td>The textual model of the logger</td>
<td>SymphoniePRO</td>
</tr>
<tr>
<td>Logger S/N</td>
<td>The logger’s serial number</td>
<td>8206000001</td>
</tr>
<tr>
<td>iPack Start Date</td>
<td>The timestamp that the iPack with this serial number was detected in the datastream</td>
<td>2014-01-01 12:34:56</td>
</tr>
<tr>
<td>iPack Model</td>
<td>The textual model of the iPack</td>
<td>iPackGPS GSM</td>
</tr>
<tr>
<td>iPack S/N</td>
<td>The iPack’s serial number</td>
<td>4622000001</td>
</tr>
<tr>
<td>Channel Number</td>
<td>The logger channel number</td>
<td>1</td>
</tr>
<tr>
<td>Channel Type</td>
<td>The type of data recorded by a channel. Possible types include Anemometer, Vane, Totalizer, Analog, Analog Simple, Diagnostic, and Input.</td>
<td>Anemometer</td>
</tr>
<tr>
<td>Effective Date</td>
<td>The effective start date for a sensor history item.</td>
<td>2014-01-31 23:23:21</td>
</tr>
<tr>
<td>Height</td>
<td>Height above ground level of the sensor in meters or feet.</td>
<td>1.00</td>
</tr>
<tr>
<td>Bearing</td>
<td>Direction or bearing of the boom or device in degrees relative to true north.</td>
<td>225.11</td>
</tr>
<tr>
<td>Bearing Name</td>
<td>Direction or bearing of the boom or device in abbreviated cardinal directions.</td>
<td>NE</td>
</tr>
<tr>
<td>Scale Factor</td>
<td>Scale factor applied to the sensor data</td>
<td>0.638</td>
</tr>
<tr>
<td>Offset</td>
<td>Offset applied to the sensor data</td>
<td>0.35</td>
</tr>
<tr>
<td>Units</td>
<td>Units describing the sensor data</td>
<td>m/s</td>
</tr>
<tr>
<td>P-SCM Type</td>
<td>Type of P-SCM card configured for the channel. This is only applicable to analog P-SCM channels.</td>
<td>P-SCM #9130, (0 to 5) V, SE Input, Pulsed 5V EXC</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>VaneMountingAngle</td>
<td>Vane mounting angle</td>
<td>180.00</td>
</tr>
<tr>
<td>Serial Number</td>
<td>The serial number sensor for a given channel</td>
<td>3000010</td>
</tr>
<tr>
<td>Channel Description</td>
<td>The description of the sensor.</td>
<td>NRG 40C</td>
</tr>
<tr>
<td>Column N Name</td>
<td>The name of the nth column, which is built automatically from the configuration data for the channel.</td>
<td>Ch49_Anem_39.6m_E_Avg_m/s</td>
</tr>
<tr>
<td>Column N Data</td>
<td>The value of the nth column of data. If no data is available for a column at a particular timestamp, the value is left blank.</td>
<td>8.662</td>
</tr>
<tr>
<td>Timestamp</td>
<td>The date and time of the row of data.</td>
<td>2012-12-01 14:20:00</td>
</tr>
<tr>
<td>Diagnostic Type</td>
<td>The type of the diagnostic data shown in a column: LoggerBatt, iPackBatt, BoardTemp, 12VExcCurr, 5VExcCurr</td>
<td>LoggerBatt</td>
</tr>
<tr>
<td>Class</td>
<td>The class of event: Fault, Action, or Info</td>
<td>Info</td>
</tr>
<tr>
<td>Event Code</td>
<td>Numeric code of event.</td>
<td>201</td>
</tr>
<tr>
<td>Event</td>
<td>Shorthand text description of event</td>
<td>IID_SVCOM_CONNECT_START</td>
</tr>
<tr>
<td>Error</td>
<td>Short description of error if the event is a Fault</td>
<td>DNS server not responding.</td>
</tr>
<tr>
<td>Description</td>
<td>Detailed description of the event</td>
<td>This means that the main outbound logger connection can not be completed due to a socket error.</td>
</tr>
<tr>
<td>Comm Duration</td>
<td>The length of time for the communication session in HH:MM:SS format.</td>
<td>00:00:21</td>
</tr>
<tr>
<td>Field Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Comm Reason MetLink Listen</td>
<td>Set if communication included a MetLink Listen schedule</td>
<td>True</td>
</tr>
<tr>
<td>Comm Reason MetLink Connect</td>
<td>Set if communication included a MetLink Connect schedule</td>
<td>False</td>
</tr>
<tr>
<td>Comm Reason SMTP</td>
<td>Set if communication included a SMTP schedule</td>
<td>True</td>
</tr>
<tr>
<td>Comm Reason FTP</td>
<td>Set if communication included a FTP schedule</td>
<td>False</td>
</tr>
<tr>
<td>Comm Reason Diagnostic</td>
<td>Set if communication included a MetLink Diagnostic check in</td>
<td>True</td>
</tr>
<tr>
<td>Comm Reason User Initiated</td>
<td>Set if communication was initiated by a user at the logger</td>
<td>False</td>
</tr>
<tr>
<td>Comm Reason Retry</td>
<td>Set if communication was initiated for a retry operation</td>
<td>False</td>
</tr>
<tr>
<td>Comm Reason Scheduled</td>
<td>Set if communication was initiated for a scheduled operation</td>
<td>True</td>
</tr>
<tr>
<td>Bytes Tx</td>
<td>Number of bytes transmitted by the logger during the session.</td>
<td>21696</td>
</tr>
<tr>
<td>Bytes Rx</td>
<td>Number of bytes received by the logger during the session.</td>
<td>23445</td>
</tr>
<tr>
<td>Signal</td>
<td>The strength of the cellular signal when the session was ended.</td>
<td>64</td>
</tr>
<tr>
<td>Result</td>
<td>The final result of the session. This is either Success or an error code.</td>
<td>Success</td>
</tr>
<tr>
<td>Comm Message</td>
<td>Message identifying connection to desktop application</td>
<td>NRGsystems\rhm</td>
</tr>
</tbody>
</table>

**Column Types**

The following table describes all of the columns types that appear in the measured data exports.
### Column Type
<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avg</td>
</tr>
<tr>
<td>SD</td>
</tr>
<tr>
<td>Min</td>
</tr>
<tr>
<td>Max</td>
</tr>
<tr>
<td>Gust</td>
</tr>
<tr>
<td>GustDir</td>
</tr>
<tr>
<td>Total</td>
</tr>
<tr>
<td>Sample</td>
</tr>
</tbody>
</table>

### Column Modes
The following table describes all of the columns modes that appear in the measured data exports.

<table>
<thead>
<tr>
<th>Column Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anem</td>
<td>The channel is reporting anemometer speed information</td>
</tr>
<tr>
<td>Vane</td>
<td>The channel is reporting wind direction information</td>
</tr>
<tr>
<td>Analog</td>
<td>The channel is reporting generic or simple analog information</td>
</tr>
<tr>
<td>Sum</td>
<td>The channel is reporting totalizer information</td>
</tr>
</tbody>
</table>
**Column Names**

Column names are described without spaces in order to improve readability in a basic text editor to avoid confusion with the tab column separators. The following describes how a column name is generated in an export:

Measurements Export:

\[ \text{Ch(Channel Number)}_{\text{(Channel Mode)}}_{\text{(Height)}}_{\text{(Bearing Name)}}_{\text{(Column Type)}}_{\text{(Units)}} \]

Diagnostic Export:

\[ \{\text{Diagnostic Type}\}_{\text{(Column Type)}}_{\text{(Units)}} \]

**Export Rules**

The exports must be able to present data from multiple datapoint types for a given channel as that channel may change in its configuration over time. Also, channels may be disabled and enabled independently across time.

The following rules govern how the exports handle these cases:

The columns generated for a channel represent the superset of all column types reported by that channel over the history covered by the given export. For example, if digital channel 3 changed from anemometer to totalizer, then channel 3 would have the following columns: Avg, Min, Max, SD, Gust, & Total. The data for the first five columns would be mutually exclusive in the export as the channel may not report both types at the same time.

Columns that do not have any data in them are not exported. If channels 7-12 are disabled, then the export does not have any columns representing those channels (there are no blank “(tab)(tab)” columns).

Rows that do not have any data in them are not exported. If there is no data for a time that would otherwise typically have data (10 minute boundary, for example), there is no row generated for that time.

These rules allow the export file to work in a manner that is similar to how the underlying datastream is structured. This is desirable because it allows future datapoints to be created without the repercussions of fitting the fields into a more rigidly structured export format. Also, it reduces file size which is important when considering exports of sample data.

**Export Header Format**

The beginning of the header information is identical across all export types. This is referenced in the proceeding export formats as \{Export Header\} and is defined as follows:

\[
\begin{align*}
\text{NRG Systems SymphoniePRO Desktop Application} \\
\text{Software Version:(tab)}\{\text{Software Version}\} \\
\text{Export version:(tab)}1 \\
\text{Generated:(tab)}\{\text{Export Generation Timestamp}\}
\end{align*}
\]
User:

Export Parameters
Site Number:(tab){Site Number}
Data Type:(tab){Data Type}
Start Date:(tab){Start Date}
End Date:(tab){End Date}
Filters Applied:(tab){True | False}
[Mode:(tab){Export Mode}]

Site Properties
Site Description:(tab){Site Description}
Project:(tab){Project}
Tower:(tab){Tower}
Location:(tab){Location Description}

Coordinate System:(tab){WGS84}
Latitude:(tab){Site Latitude}
Longitude:(tab){Site Longitude}
Elevation:(tab){Site Elevation}
Time Zone:(tab){Time Zone}
Site Units:(tab){Site Units}

Logger History
Date:(tab){Logger Start Date}
Model:(tab){Logger Model}
Serial Number:(tab){Logger S/N}

[Date: ...]

iPack History
Date:(tab){iPack Start Date}
Model:(tab){iPack Model}
Serial Number:(tab){iPack S/N}

[Date: ...]

Measurement Data Export Format
The measurements export format is generally the same across all modes, but the column units may change.
Sensor History
Channel:(tab){Channel Number}
Effective Date:(tab){Effective Date}
Type:(tab){Channel Type}
Description:(tab){Channel Description}
Serial Number:(tab){Serial Number}
Height:(tab){Height}
Bearing:(tab){Bearing}
[Scale Factor:(tab){Scale Factor}]
[Offset:(tab){Offset}]
[Vane Mounting Angle:(tab){Vane Mounting Angle}]
Units:(tab){Units}
[P-SCM Type:(tab){P-SCM Type}]

Data
Timestamp(tab){Column 1 Name}(tab){Column 2 Name}...
(Timestamp)(tab){Column 1 Data}(tab){Column 2 Data}...
...

Diagnostic Data Export Format
The format for the diagnostic data export is the same as for the measurement data export in this version, except that the sensor history information is omitted.

Event Data Export Format (Normal)
The event export in normal mode includes the basic user friendly information.

Event Data Export Format (Full)
The full mode adds the event parameters to each row to enable a more complete debug of the data.
**Communication Data Export Format (Normal)**

The normal mode of the communication data export includes the basic communication information that typically changes on each communication attempt and is of interest to the user.

**Communication Data Export Format (Full)**

The full mode of the communication data export includes all of the data from the communication database table (datapoint).
Instrument Configuration
The text file format is similar in design to that of a Windows .INI file. See the following article for background on this file format: [http://en.wikipedia.org/wiki/INI_file](http://en.wikipedia.org/wiki/INI_file).

The instrument data is organized by sections in the configuration file, providing logical grouping of like-parameters as well as isolating the namespace thereby simplifying the naming convention. Each section is described in the table below with the permissible setting names (keys).

; NRG Systems SymphoniePRO & iPack Configuration File
; Software Version: {Software Version}
; Generated: {File Generation Timestamp}

[FileHeader]
FormatVersion=1

[LoggerLocation]
Location=My Location
Latitude=44.340000
Longitude=-73.110000
Elevation=800
TimeZone=UTC-4:00
**Logger Location Section**

The section “LoggerLocation” contains the settings for the location block on the logger tab in the UI.

<table>
<thead>
<tr>
<th>Key Name</th>
<th>Type</th>
<th>Permissible Values</th>
<th>Precision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Location</td>
<td>String</td>
<td>0 - 20 printable characters</td>
<td>N/A</td>
<td>Location description.</td>
</tr>
<tr>
<td>Latitude</td>
<td>Double</td>
<td>-90.000000000 – 90.000000000</td>
<td>7 decimal</td>
<td>Decimal latitude of logger location</td>
</tr>
<tr>
<td>Longitude</td>
<td>Double</td>
<td>-180.0000000 – 180.0000000</td>
<td>7 decimal</td>
<td>Decimal latitude of logger location</td>
</tr>
<tr>
<td>Elevation</td>
<td>Integer</td>
<td>-1300 – 9000</td>
<td>No decimal</td>
<td>Elevation of logger location, in meters.</td>
</tr>
<tr>
<td>Time Zone</td>
<td>List</td>
<td>UTC-12:00</td>
<td>N/A</td>
<td>Time zone of logger</td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-11:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-10:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-9:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-9:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-8:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-7:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-6:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-5:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-4:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-4:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-3:30</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-3:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>UTC-2:00</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Time Zone</td>
<td>Offset</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-----------</td>
<td>--------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC-1:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+0:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+1:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+2:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+3:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+3:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+4:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+4:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+5:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+5:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+5:45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+6:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+6:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+7:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+8:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+8:45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+9:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+9:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+10:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+10:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+11:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+11:30</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+12:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+12:45</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+13:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UTC+14:00</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Logger Site Section**
The section “LoggerSite” contains the settings for the site block on the logger tab in the UI.

<table>
<thead>
<tr>
<th>Key Name</th>
<th>Type</th>
<th>Permissible Values</th>
<th>Precision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number</td>
<td>Integer</td>
<td>1 – 999999 (6-digits)</td>
<td>No decimal places</td>
<td>Site number</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>0 - 20 printable characters</td>
<td>N/A</td>
<td>Description of the site</td>
</tr>
<tr>
<td>Project</td>
<td>String</td>
<td>0 - 20 printable characters</td>
<td>N/A</td>
<td>Description of the project</td>
</tr>
<tr>
<td>Unit</td>
<td>List</td>
<td>17. SI (m/s, m)</td>
<td>N/A</td>
<td>Display units</td>
</tr>
<tr>
<td></td>
<td></td>
<td>18. Imperial (mph, ft)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Channel Configuration Section**
The section “Channel<n>” contains the settings for the channel number denoted in <n> on the Channel configuration tab in the UI. For example the section “Channel13” contains settings specific to the analog channel 13. Note that not all settings are applicable to all channels.

<table>
<thead>
<tr>
<th>Key Name</th>
<th>Type</th>
<th>Permissible Values</th>
<th>Precision</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>List</td>
<td>Off, Statistical, Stats &amp; Samples</td>
<td>N/A</td>
<td>Mode of the channel</td>
</tr>
<tr>
<td>Type</td>
<td>List</td>
<td>Anemometer, Totalizer, Wind Vane, Analog, Analog Simple</td>
<td>N/A</td>
<td>Type of data recorded by the channel</td>
</tr>
<tr>
<td>Description</td>
<td>String</td>
<td>0 - 20 printable characters</td>
<td>N/A</td>
<td>Description of the sensor</td>
</tr>
<tr>
<td>SerialNumber</td>
<td>String</td>
<td>0 - 20 printable characters</td>
<td>N/A</td>
<td>Serial number of the sensor</td>
</tr>
<tr>
<td>Parameter</td>
<td>Type</td>
<td>Description</td>
<td>ScaleFactor</td>
<td>Offset</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------</td>
<td>--------</td>
</tr>
<tr>
<td>Height</td>
<td>Fixed</td>
<td>100, meters</td>
<td>0 – 500</td>
<td>2</td>
</tr>
<tr>
<td>BoomBearing</td>
<td>Fixed</td>
<td>100, degrees</td>
<td>0 – 359.9</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ScaleFactor</td>
<td>Single</td>
<td>Full range of single point precision.</td>
<td>6 places</td>
<td>6</td>
</tr>
<tr>
<td>Offset</td>
<td>Single</td>
<td>Full range of single point precision.</td>
<td>6 places</td>
<td>6</td>
</tr>
<tr>
<td>AnemSignalType</td>
<td>List</td>
<td>Coil, Pulsed</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>AnemPullup</td>
<td>List</td>
<td>Enabled, Disabled</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>AnemHighSpeed</td>
<td>List</td>
<td>Enabled, Disabled</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Units</td>
<td>String</td>
<td>0 - 10 printable characters</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>P-SCM</td>
<td>List</td>
<td>P-SCM #9128, (-6 to 58) mV, Diff Input, No EXC</td>
<td>N/A</td>
<td></td>
</tr>
<tr>
<td>Parameter</td>
<td>Value</td>
<td>Units</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------</td>
<td>-------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>VaneMountingAngle</td>
<td>Fixed point 100</td>
<td>0 – 359.9</td>
<td>1 decimal place</td>
<td>Vane mounting angle</td>
</tr>
<tr>
<td></td>
<td>degrees</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VaneDeadBandNE</td>
<td>Fixed point 100</td>
<td>0 – 25.5</td>
<td>1 decimal place</td>
<td>Vane dead band north east</td>
</tr>
<tr>
<td></td>
<td>degrees</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VaneDeadBandNW</td>
<td>Fixed point 100</td>
<td>0 – 25.5</td>
<td>1 decimal place</td>
<td>Vane dead band north west</td>
</tr>
<tr>
<td></td>
<td>degrees</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ExcitationMode</td>
<td>List</td>
<td>Off, Constant On, Pulsed On</td>
<td>N/A</td>
<td>Mode for the excitation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ExcitationVoltage</td>
<td>String</td>
<td>5V, 12V, 2.500V</td>
<td>N/A</td>
<td>Voltage level for the excitation</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Application Log**

The name of the log file follows the following convention:
SymPRO YYYY-MM-DD HH.MM.SS.log

19. Y,M,D: Date of file creation
20. H,M,S: Time of file creation
The contents of the log file are as follows:

Renewable NRG Systems SymphoniePRO Desktop Application
Software Version:(tab){Software Version}
Log version:(tab)1
Generated (local):(tab){Log Creation Timestamp Local Time}
Generated (UTC):(tab){Log Creation Timestamp UTC Time}

User:(tab){Machine User Name}
Machine:(tab){Machine Name}
Windows:(tab){Windows Version}

Operating System: (tab){32 or 64 bit}
.NET:(tab){.NET Version}
System Culture:(tab){System Culture Setting}
Decimal Separator:(tab){System Decimal Separator}

Data
Timestamp(tab)Site_Number(tab)Mode(tab)Type
{timestamp}(tab){site}(tab){mode}(tab){type}:(tab){message}
Running SymphoniePRO Desktop from the Command Line

In order to facilitate the automation of data processing, SymphoniePRO Desktop application has command line functions (such as those found previously in SDR) to convert and import data. The command line functions are typically evoked through the use of scripts.

Scripts

A script is a file that contains a series of commands. Running the file runs all the commands it contains. A common script type found on all Windows machines is a .BAT (batch) file. Other script types include Perl or Python scripts, but these require additional software to run. The SymphoniePRO Desktop Application can be executed from within a script to perform data convert and import operations. Command line switches tell SymphoniePRO Desktop which functions to perform.

Command Line Switches

SymphoniePRO Desktop has several command line switches that are useful in creating scripts for automation of data processing: help, defaultfolder, import, and convert. A summary of these commands is provided, along with some examples.

<table>
<thead>
<tr>
<th>Command</th>
<th>Parameters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>help</td>
<td></td>
<td>Opens a window containing a list of the supported commands and a brief description of each, software version information, and a hyperlink to the SymphoniePRO user’s manual on the NRG website.</td>
</tr>
<tr>
<td>defaultfolder</td>
<td>/site /export /log /raw /firmware</td>
<td>Prints the path of the folder specified. If no parameter is specified, the default is /raw.</td>
</tr>
<tr>
<td>import</td>
<td>/file &lt;filename&gt;</td>
<td>Imports a Raw Logger Data file into the site file. This requires the corresponding site file to exist, and contain a decryption key if needed.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
<td></td>
</tr>
<tr>
<td>/file &lt;filename&gt;</td>
<td>Specify the file to be imported</td>
<td></td>
</tr>
<tr>
<td>/mode &lt;export mode&gt;</td>
<td>Specifies the export mode (scaled, sensor, p-scm, unscaled, normal or full). Leave blank for default mode (Scaled).</td>
<td></td>
</tr>
<tr>
<td>/type &lt;export type&gt;</td>
<td>Type of export (meas, diag, comm, events, sample). Default to meas if unspecified.</td>
<td></td>
</tr>
<tr>
<td>/pass &lt;encryptionpassword&gt;</td>
<td>Decrypt the file using the specified password</td>
<td></td>
</tr>
<tr>
<td>/key &lt;encryptionkey&gt;</td>
<td>Decrypt the file using the specified hex key</td>
<td></td>
</tr>
<tr>
<td>/skipheader &lt;mode&gt;</td>
<td>mode (skipcolumnnames) Default will skip file description header if [skipcolumnnames] is used then in addition to file description header column names will also be skipped</td>
<td></td>
</tr>
<tr>
<td>/outputdir &lt;dir&gt;</td>
<td>Directory to save result file</td>
<td></td>
</tr>
<tr>
<td>/outputsubdir &lt;subdirname&gt;</td>
<td>Save to result file to a sub folder of the input file [subdirname] or if left blank ‘done’</td>
<td></td>
</tr>
<tr>
<td>/site &lt;sitefilename&gt;</td>
<td>Use scaling information from site file.</td>
<td></td>
</tr>
</tbody>
</table>

**Command Line Examples**

Commands should be run from within the directory which contains SymPRODesktop.exe (e.g. C:\Program Files (x86)\Renewable NRG Systems\SymPRO Desktop), and it is good practice to use the Windows `start` and `wait` command. These commands will help prevent errors under heavy processing load: `start` will start the process in a new command prompt window, and `wait` will execute the command and wait for it to end.

The `help` switch opens a window that displays information about the version of SymphoniePRO desktop and the available commands and can be run using:

> start /wait SymPRODesktop.exe /cmd help
Running the help command will return:

![SymPRODesktop Command-line](image)

The **defaultfolder** switch prints the path of the folder specified in the parameter, as defined in the **Settings** of SymphoniePRO Desktop.

> start /wait SymPRODesktop.exe /cmd defaultfolder /site

The **import** switch imports an .RLD file into an existing SymphoniePRO Desktop site file.

> start /wait SymPRODesktop.exe /cmd import /file "c:\Users\user\Documents\Renewable NRG Systems\Raw\000110_2015-04-05_00.00_000727.rld"

> start /wait SymPRODesktop.exe /cmd import /file "c:\Users\user\Documents\Renewable NRG Systems\Raw\00002_2015-09-07_00.00_000482.rld"

Re-imported 000002_2015-09-07_00.00_000482.rld
Success
If no site file exists for the file that is being imported, then the file cannot be imported.

The `convert` switch converts the binary .RLD file to a tab delimited text file (*.txt) and prints the name and path of the output file.

```text
> start /wait SymPRODesktop.exe /cmd convert /file "c:\Users\ndb\Documents\Renewable NRG Systems\Raw\000110_2015-04-05_00.00_000727.rld"
```

By default, the converted file is written to the **Exports** path defined in the **Settings** of SymphoniePRO Desktop. Also by default, the exported file contains measured data that is scaled using the channel configuration information programmed into the logger (rather than a site file).

Various other exporting options are available by passing parameters along with the `convert` command. The parameters are listed in the table shown earlier in this appendix.

For example, the following command line could be entered to convert a file with an encryption password of “windy”, without the description header, using scaling information from the site file, and to be saved in a specified location.

```text
> start /wait SymPRODesktop.exe /cmd convert /file “c:\Users\user\Documents\Renewable NRG Systems\Raw\000110_2015-04-05_00.00_000727.rld” /pass windy /skipheader /site /outputdir “c:\Users\user\Documents\000110_Measured”
```

The following command line could be entered to convert a file and export the event log into a subdirectory of the default raw data folder called \event_logs.

```text
> start /wait SymPRODesktop.exe /cmd convert /file “c:\Users\user\Documents\Renewable NRG Systems\Raw\000110_2015-04-05_00.00_000727.rld” /type events /outputsubdir event_logs
```

If you have any questions about integrating the SymphoniePRO Desktop software into your data processing workflow, please do not hesitate to contact NRG for assistance.
APPENDIX O | SYMPHONIEPRO DESKTOP UTILITIES

In order to facilitate data processing and logger configuration, the SymphoniePRO Desktop installation includes a few utility applications, which by default are installed in the user directory:

C:\Users\~user\Documents\Renewable NRG Systems\Utilities

The following sections will describe each utility in greater detail.

PopAuto

The POPAuto utility can be used to extract NRG logger data file attachments (RWD and RLD) from emails contained on a POP3 mail server. The utility will find “data emails” and download them. Once downloaded, data files are extracted and stored on a user accessible drive (the files can be sorted by site). Further, there are options to convert the files to TXT using either the settings contained inside site database file or the RLD file. Additionally, downloaded files can be imported into the site database for the Desktop Application. The application can be run either manually or from within a script via command line.
**POPAuto Command Line**

POPAuto can be run from the command line, making it possible to integrate the utility into your automated data flow process.

To see a list of commands:

- POPAuto.exe /?

To run POPAuto using the settings configured in the POPAuto GUI, use:

- POPAuto.exe /silent

Additional commands can be used as an “overlay” to the GUI commands. Note that all command modes must start with /silent.

- /server "{fserver}"
- /mailbox_name "{name}"
- /mailbox_password "{password}"
- /delete
- /sort

**Example 1:**

The command line POPAuto.exe /silent /delete /sort will run the POPAuto application using the settings found in the GUI panel. In this example, if the GUI panel does not have the delete and sort boxes checked, the command line will execute those functions as if they were checked.
Example 2:
The command line POPAuto.exe /silent will run the POPAuto application using the settings found in the GUI panel. In this example, the GUI panel has the delete and sort boxes checked, so the command line will execute those functions as found in the settings.

OutAuto
The OutAuto 2.0 utility can extract RLD files contained as email attachments found in a Microsoft Outlook folder. There are three main selections the user needs to make:

- Choose the Outlook Folder to Extract From
- Extract RWD files
  - Follow default folder settings or specify a path
- Extract RLD files
  - Follow default folder settings or specify a path

By default the Outlook inbox is selected as the “Extract from folder” location and “Extract RWD files” is enabled. Also by default, OutAuto will follow the folder settings that are configured in SDR for storing the extracted RWD files.

Similarly, for SymphoniePRO the user can enable the “Extract RLD files” setting, and by default OutAuto will follow the folder settings that are configured in SymphoniePRO Desktop for storing the extracted RLD files.
Alternatively, the user can specify individual folders to store extracted RWD and RLD files. Please be sure that
the path is valid and that the directory is write enabled.

To run OutAuto, simply double-click on the “Extract files” button.

![Extract Outlook Attachments]

**OutAuto Command Line**

OutAuto can be run from the command line, making it possible to integrate the utility into your automated data
flow process.

**OutAuto.exe /**

- This will return a list of available commands.

**OutAuto.exe /silent**

- This will act the same as starting the app and clicking ‘Extract Files’. The extract folder is sticky so it will
process using the outlook folder that was selected the last time ran.

**OutAuto.exe /folder “my emails”**
• Process the specified email folder. *The selected folder in the GUI is not affected. It’s sticky but command line will not overwrite it.

/rwd_mode “follow” | ”path”

• Sets which destination path is used for rwd files extracted

/rwd_path {”path”}

• Used in conjunction with rwd_mode when ‘path’ is selected to specify custom path to use

/rld_extract

• Like checking the checkbox for extracting rld files.

/rld_mode “follow” | ”path”

• Just like when running the app which button is clicked.*

/rld_path {”path”}

  o Used in conjunction with rld_mode this one specifies the path if “path” is specified otherwise it will be ignored. *
  * Will be ignored if rld_extract is not included

Modbus Demo Client

The Modbus demo client facilitates installations where configuration of the iPackACCESS modbus server is required. The client allows the user to read real time values from the iPackACCESS registers and is covered in detail in Appendix F.
NRG Export Configuration (NEC)

NRG Export Configuration (NEC) adds flexibility to the data export format from SymphoniePRO Desktop and is based on template files built using xml (with a *.nec extension). This feature will be further developed as needed. Please contact NRG with any questions regarding custom export formats as we can work with you to create the necessary functionality and NEC file.

Custom export format options include the following:

- Header options: standard, column headers only, or no header
- Channel order: re-order or omit certain channels from the header
- Timetsamp time zone: UTC or logger local time
- Channel statistics: re-order or omit certain statistic types, depending on the channel type

To use a custom export format, create an NEC file and save it in the NEC directory (C:\Users\~\Documents\Renewable NRG Systems\NEC). The NEC directory contains a file called ExampleExportConfiguration.nec. Modify this template file to create your own custom template.

A simple example is shown below.

**Example: Suppress wind speed gust and re-arrange the wind speed columns as AVG, SD, Max, Min**

The NEC file “SuppressGust.nec” can be used to make the SymphoniePRO wind speed export more like the SymphoniePLUS3 export. In this case, the NEC will remove the 3-second gust from the export and also re-arrange the Avg, SD, Max and Min by placing them in order.

The contents of the SuppressGust.nec file are as follows:
This file is saved to the NEC directory.

When *.nec files are saved in the NEC directory, they become a “save as” drop-down option in the measurements export.
121, 122, 130, 132, 140, 169, 186, 191, 193, 194
iPack firmware, 29, 54, 140
iPack screen, 26, 50, 110
iPack, checking status, 159, 161
ISP Password, 53
ISP Username, 53
latitude, 13, 32, 55, 59, 60, 71, 80, 84, 100, 195
Latitude, 32, 55, 185, 191, 194, 195
lightning, 12, 65, 166, 167, 171
Listen Now button, 47
listening duration, 45, 47
Live Data, 37, 38
Load Instrument Configuration File (*.LGR), 97
Logger Access PIN, 15, 35, 36
Logger Configuration, 33, 61
Logger screen, 26, 30, 34, 86, 87, 101, 107, 108
Logger settings, 29
Longitude, 32, 55, 60, 80, 84, 100
Map Pane, 84
Mark Files, 98
maximum gust, 39
Measurements menu, 57, 80
Memory, 30, 108
MetLink, 9, 11, 24, 26, 30, 36, 37, 45, 47, 48, 60, 63, 80, 86, 87, 92, 101, 108, 121, 131, 132, 133, 135, 188, 193, 194
MetLink Diagnostics, 80
MetLink Initiate, 93
MetLink Logger Listening, 47, 92, 135
MetLink Monitor, 87
Modbus Status, 80
modem, 12, 50, 51, 52, 53, 55, 58, 63, 123, 130, 132, 135, 169
network registration, 52
network requirements, 27
ports, 117
Power, 12, 169
PRO Signal Conditioning Modules (P-SCMs), 19
Process Raw Sample Data, 81, 95
Product support, 8
Provision CDMA, 80
P-SCM, 11, 16, 19, 20, 21, 22, 39, 40, 42, 116, 185, 186, 192, 198
PV panel, 8, 13, 69, 70, 71, 72, 116, 169
pyranometers, 19
Quick Start, 7
QuickView, 8, 31, 64, 81, 110
Raw file folder, 31, 108, 110
Recent Events screen, 60, 81
Recipient’s Email, 49
Refresh Site List, 93
Registration, 52
Repair Services, 171
reset button, 16
Retrieve By Date Range button, 31, 108
retrieving and importing data, 31
Save All, 97
Save All button, 27, 37
Save Communication Log, 94
Save Instrument Configuration File (*.LGR), 97
Save to iPack button, 43, 50
Schedules screen, 26, 43, 60, 63, 110, 121
SD card, 9, 11, 16, 30, 31, 39, 56, 57, 58, 62, 80, 82, 83, 98, 108
security, 26, 34, 35, 36
Sender’s Email, 49
Set button, 52
Set Clock button, 33
Settings, 90
shelter box, 8, 18, 19, 65, 66, 67, 68, 69, 72, 73, 79, 117
Signal Strength, 52
Signal Type, 20, 41
SIM Card, 140
site list, 30, 84, 86
Site Number, 32, 87, 184, 191
Site Utilities, 26
Site Utilities screen, 26, 30, 34, 63, 86, 95, 97, 99, 100, 101, 121
Site Visit Checklist, 83
SMTP, 48, 49, 121, 138, 188, 193, 194
SNTP, 47, 83
Software installation, 24
Standard deviation, 118
Start button, 55
Start Upgrade, 109
Start Upgrade button, 33, 54
Static IP Address, 135
Statistical Reporting Period, 38
Status, iPack, 159, 161
SymphoniePRO Desktop Application, 7, 8, 10, 11, 15, 22, 24, 29, 33, 34, 35, 37, 46, 47, 52, 54, 61, 62, 63, 86, 87, 88, 91, 92, 93, 97, 100, 101, 118, 120, 130, 132, 133, 135, 138, 140, 190, 200
SymphoniePRO Signal Conditioning Modules, 19 TCP/IP, 11, 132, 181
Test button, 46
Test Email Settings button, 49, 121
Text file, 118
time zone, 33, 97, 100, 185
Timeline, 11, 26, 95, 97, 102, 105
Tools, 65, 82
Troubleshooting, 120
units of measure, 32, 39, 117
Upgrade Firmware button, 33
Upgrade Logger Firmware button, 33, 109
USB port, 15, 24
View Application Log, 91
Wind shear, 119
wireless, 31, 52, 53, 55, 135, 136
Wiring, 73
Wiring Panel, 15, 16, 63, 79